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PREFACE
Every effort has been made to ensure that the information in this document is complete, accurate, and 
up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its control. The 
manufacturer also cannot guarantee that changes in software and equipment made by other 
manufacturers and referred to in this manual will not affect the applicability of the information in it. 
Mention of software products manufactured by other companies does not necessarily constitute 
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as possible, 
we make no warranty of any kind, expressed or implied, as to the accuracy or completeness of the 
information contained herein.

All rights are reserved by Oki Data Corporation. Unauthorized copying, transferring, translating, or 
related actions are prohibited. You must obtain written permission from Oki Data Corporation before 
doing any of the above.
© 2011 Oki Data Corporation

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft 
Corporation.

Apple, Macintosh, Rosetta, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their proprietors.

As an Energy Star Program Participant, the manufacturer has determined that this product 
meets the Energy Star guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2004/108/EC (EMC), 
2006/95/EC (LVD),1999/5/EC (R&TTE), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as 
amended where applicable, on the approximation of the laws of the member states relating 
to Electromagnetic Compatibility, Low Voltage, Radio & Telecommunications Terminal 
Equipment, Energy related Products and Restriction on the use of certain Hazardous 
Substances in electrical and electronic equipment.

The following cables were used to evaluate this product to achieve EMC directive 
2004/108/EC compliance and configurations other than this may affect that compliance.

CABLE TYPE LENGTH 
(METRE)

CORE SHIELD

Power 1.8  

USB 5.0  

LAN 15.0  

Telephone 3.0  
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EMERGENCY FIRST AID
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO NOT 
attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes 
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of staining 
skin or clothing.

MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

For all sales, support and general enquiries contact your local distributor.

IMPORTER TO THE EU/AUTHORISED REPRESENTATIVE
OKI Europe Limited (trading as OKI Printing Solutions)

Blays House
Wick Road
Egham
Surrey, TW20 0HJ
United Kingdom

For all sales, support and general enquiries contact your local distributor.

ENVIRONMENTAL INFORMATION

http://www.okiprintingsolutions.com
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 For Your Safety
Read the User's Manual (this manual) for your safety before using the product.

Cautions related to safety

General cautions

Indicates additional information which, if ignored or not followed, may result in personal injury 
or death.

Indicates additional information which, if ignored, may result in personal injury.

WARNING
Do not touch the safety 
switch inside the machine. 
Doing so may cause electric 
shock when high voltage 
occurs. In addition, the gears 
can rotate, which may result 
in personal injury.

Do not use an inflammable 
spray near the machine. 
Doing so may cause fire since 
there is an area heating up 
within the machine.

Pull the power plug out of the 
socket and contact with a 
customer service centre when 
the cover is unusually hot, 
smoking, giving off 
questionable odour, or 
making a strange noise. 
Failure to do so may cause 
fire.

Pull the power plug out of the 
socket and contact with a 
customer service centre when 
a liquid such as water enters 
in the internal parts of the 
machine. 
Failure to do so may cause 
fire.

Pull the power plug out of the 
socket and remove foreign 
materials such as clips when 
they fall inside the machine. 
Failure to do so may cause 
electric shock and/or fire 
leading to personal injury.

Do not operate and/or 
disassemble the machine 
other than that directed in 
User's Manual. 
Doing so may cause electric 
shock and/or fire leading to 
personal injury.

Unplug the power cord and 
contact with a customer 
service center if the machine 
is dropped or the cover is 
damaged.
Failure to do so may cause 
electric shock and/or fire 
leading to personal injury.

Unplug the power cord 
periodically to clean plug 
blades and root section 
between the blades.
If the power plug remains 
inserted for a long time, the 
root section will get dusty, 
and the plug may be shorted 
out, which may cause fire.

Do not clean spilled toner 
with a vacuum cleaner.
Cleaning spilled toner with a 
vacuum cleaner may cause 
fire due to the sparks from 
electric contact.
Toner spilled on the floor 
should be wiped off with a 
wet cloth.

Do not insert materials in the 
vent hole.
Doing so may cause electric 
shock and/or fire leading to 
personal injury.

Do not put cups with liquids 
such as water on the 
machine.
Doing so may cause electric 
shock and/or fire leading to 
personal injury.

Do not touch the fuser and 
other parts when opening the 
cover of the machine.
Doing so may cause burns.

Do not throw toner cartridges 
and image drum cartridges 
into fire. Doing so may cause 
dust explosion leading to 
burns.

Do not use power cords, 
cables, or ground wires other 
than those that are indicated 
in User's Manual.
Doing so may cause fire.

Operation using UPS 
(uninterruptible power 
source) or inverters is not 
guaranteed. Do not use 
uninterruptible power source 
or inverters.
Doing so may cause fire.

WARNING

CAUTION
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This product contains software developed by the Heimdal Project.

Copyright (c) 1995 - 2008 Kungliga Tekniska Högskolan 

(Royal Institute of Technology, Stockholm, Sweden). 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

3. Neither the name of the Institute nor the names of its contributors may be used to endorse 
or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE INSTITUTE OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

CAUTION
Do not come closer to the paper's exit area when 
the power is turned on while printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquid-
crystal display gets into the eyes or mouth, flush 
with large amount of water. Seek medical 
attention if necessary.
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Manual Composition
The following manual is attached to this product.

 Quick Start Guide
The Quick Start guide describes the initial setup for each function. The basic operation of each 
function is also described.

 User's Manual (Basic) ---- This document 
In order to understand this machine, the basic operation is described. The initial setup, 
Troubleshooting and maintenance procedures are also described.

 User's Manual (Advanced)
The Advanced guide describes the advanced operations of each function. The utility and network 
setting information is included.

About This Manual

Terms in this document
The following terms are used in this manual:

Note

 Indicates important information on operations. Please ensure you read these.

Memo

 Indicates important information on operations. Please ensure you read these.

Reference

 Indicates where to look when you want to know more detailed or related information.

Symbols in this document
The following symbols are used in this manual:

WARNING
 Indicates additional information which, if ignored or not followed, may result in personal injury or death.

CAUTION
 Indicates additional information which, if ignored, may result in personal injury.

Symbols Description

[  ]  Indicates menu names on the display screen.
 Indicates menu, window, dialog names on the computer.

"  "  Indicates file names on the computer.
 Indicates reference titles.

<  > key Indicates a hardware key on the operator panel or a key on 
the keyboard of the computer.

> Indicates how to get to the menu you want on the menu of 
the machine or the computer.
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Legends used in this manual
This document contains the following legends.

 PostScript3 Emulation PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION

 Microsoft® Windows® 8 64-bit Edition operating system Windows 8 (64bit version) 

 Microsoft® Windows Server® 2012 64-bit Edition operating system Windows Server 2012

 Microsoft® Windows® 7 64-bit Edition operating system Windows 7 (64bit version) 

 Microsoft® Windows Vista® 64-bit Edition operating system Windows Vista (64bit version) 

 Microsoft® Windows Server® 2008 R2 64-bit Edition operating system Windows Server 2008 

 Microsoft® Windows Server® 2008 64-bit Edition operating system Windows Server 2008(64bit version) 

 Microsoft® Windows® XP x64 Edition operating system Windows XP (x64 version) 

 Microsoft® Windows Server® 2003 x64 Edition operating system Windows Server 2003 (x64 version) 

 Microsoft® Windows® 8 operating system Windows 8 

 Microsoft® Windows® 7 operating system Windows 7 

 Microsoft® Windows Vista® operating system Windows Vista 

 Microsoft® Windows Server® 2008 operating system Windows Server 2008 

 Microsoft® Windows® XP operating system Windows XP 

 Microsoft® Windows Server® 2003 operating system Windows Server 2003 

 Generic name for Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows Server 2008, Windows 
XP, and Windows Server 2003 Windows

 Web Services on Devices WSD

Unless otherwise noted, 64bit version is included in Windows 8, Windows 7, Windows Vista, Windows 
Server 2008, Windows XP, and Windows Server 2003. (64bit version and Windows Server 2008 R2 is 
included in Windows Server 2008.)

If there is no special description, Windows 7 is used as Windows, Mac OS X 10.7 is used as Mac OS X, 
and MB491 is used as the machine for examples in this document.

Depending on your OS or model, the description on this document may be different.
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1. Setup
In this chapter, the basic setup and operations of this machine are described.

Overview of Machine
This section describes the overview of the machine.

Contents of the Package
Check that you have everything shown below.

Reference

 For details on how to open the package, refer to 
"Unpacking Your Machine" P. 17.

 Machine

 Image drum cartridge

 Starter toner cartridge

Note

 The starter toner cartridges are installed in the image 
drum which is installed in the machine before 
shipment.

 Software DVD-ROM

 AC cord

 Telephone connector cover 
The Telephone Connector Cover is installed on the 
Telephone Connector of the main unit.

 Telephone cable 
In some countries the cables are not supplied.

Note

 An Ethernet cable and USB cable are not supplied with 
your machine. Procure them separately.

 Packaging and cushioning material is required at the time 
of shipping the machine. Please keep it as you will need it 
should you wish to transport the machine at some point in 
the future.
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Available Options
The following options are available for your 
machine:

 Second tray unit (tray 2)

Reference

 For details on how to install the options, refer to "Installing 
Options" P. 22.

Installation Requirements

Installation Environment

Your machine must be installed in the following 
environment:

Note

 Be careful of condensation. It may cause a malfunction.

 If installing your machine where the humidity of the 
surrounding air is less than 30% RH, use a humidifier or 
antistatic mat.

Temperature: 10°C~32°C

Humidity: 20%~80% RH(relative 
humidity)

Maximum wet 
bulb temperature: 25°C

 Do not install near high temperature or the fire.
 Please do not install in a place from which 

chemical reactions take place (laboratory etc.).
 Do not install near inflammable solutions, such as 

alcohol and thinner.
 Do not install in places easily accessible to small 

child.
 Do not install in an unstable place (the shaky 

stand, leaning place, etc.).
 Do not install in a place exposed to high humidity, 

dust or direct sunlight.
 Do not install in an environment exposed to briny 

air or corrosive gas.
 Do not install in a place with much vibration.
 Do not install in a place where the ventilation hole 

of the machine is blocked.

 Do not place directly on a rug or carpet with long 
strands.

 Do not install in a closed room with poor 
ventilation and circulation.

 If you use the machine in a small room for a long 
time, please make sure that you ventilate the 
room.

 Install away from strong magnetic fields and 
sources of noise.

 Install away from monitors or TVs.

 When moving the machine, hold it on both sides, 
and move it by slightly letting the back of it fall.

WARNING

CAUTION
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Installation Space

Install your machine on a flat surface that is wide 
enough to accommodate the machine.

Allow for enough room around your machine 
according to the images below.

 Top view

* MB461+LP/MB491+LP/MPS4700mb: 89cm
Other: 83cm

 Side view

 Side view (tray 2 installed)

Names of Components

20cm
(193cm)

20cm

50cm 100cm

*

50cm

(96cm)

50cm

(110cm)

No. Name

1 Auto document feeder (ADF) cover

2 Document tray

3 Scanner unit

4 Document glass cover

5 Operator panel

6 USB port

7 Air vents

8 Tray 1

9 Manual Feeder (for MB441/MB461/MB461+LP/
ES4161 MFP only)
Multipurpose (MP) tray (for MB451/MB451w/
MB471/MB471w/MB491/MB491+/MB491+LP/
ES4191 MFP/MPS4200mb/MPS4700mb only)

10 Top cover open button

11 Top cover

No. Name

12 Document glass

11

10

9

8

7

3
4
5

6

2

1

12



Overview of Machine

- 16 -

 Internal part of the connector cover

No. Name

13 Fuser unit

14 Starter toner cartridge

15 Image drum

16 LED head 

17 Power Switch

No. Name

18 Faceup stacker

19 AC power socket

20 Air vents

21 LINE connection (for MB451/MB451w/MB471/
MB471w/MB491/MB491+/MB491+LP/ES4191 
MFP/MPS4200mb/MPS4700mb only)

22 TEL connection (for MB451/MB451w/MB471/
MB471w/MB491/MB491+/MB491+LP/ES4191 
MFP/MPS4200mb/MPS4700mb only)

16

13

15

17

14

LINE TEL

22

21

18

1920

No. Name

23 USB interface connection

24 SD memory card slot (for MB491/MB491+/
MB491+LP/ES4191 MFP/MPS4200mb/
MPS4700mb only)

25 Network interface connection

25

23

24
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 Installing Your Machine
This section explains how to unpack your machine and how to turn it on and off.

Unpacking Your Machine

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

 Packaging and cushioning material is required at the time 
of shipping the machine. Please keep it as you will need it 
should you wish to transport the machine at some point in 
the future.

1 Remove your machine from the box and 
remove cushioning materials and the 
plastic bag from your machine.
The accessories are packed within the cushioning 
material (1).

2 Lift your machine and place it where it is 
to be installed.

Note

 Do not open the scanner unit till procedure no.9 is 
completed.

3 Remove the protection tapes (2) at the 
top and sides of your machine to take 
out cushioning materials (3).

4 Remove the protection tapes (4) to open 
the MP tray.

5 Remove the protection tape (5) to pull 
the paper up.

6 Close the MP tray.

1

2

3

4

5
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7 Open the document glass cover.

8 Remove the protection tapes (6).
Open the ADF and remove packing tapes. 

9 Close the document glass cover.
Now, you can open or close the scanner.

10  Open the scanner unit.

11 Remove the protection tapes, and 
remove desiccants and films.

12 Press the top cover open button (8) and 
open the top cover.

13  Lift the image drum from printer.

Note

 Do not expose image drum to light for more than 
5 minutes

 Do not touch shiny green surface at bottom of image 
drum.

14 Remove the silica gel pack before 
installation.

6

8
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15 Reinstall the image drum in the 

printer:lower it into place in the printer 
locating the pegs (1) at each end into 
their slots in the sides of the printer 
cavity (2).

16 Turn the lever in the direction shown.

 The arrow on the lever should align with the arrow on 
the image drum.

 When the toner cartridge is not fully fixed , a decline in 
print quality may occur.

17 Close the top cover.

18 Close the scanner unit.
Reference

 Please refer to "Loading Paper" P. 32 for information on 
how to load paper into the machine.

Turning On and Off Your Machine

Power Supply Conditions

The power supply must meet the following 
conditions:

Note

 If the power supply is unstable, use a voltage regulator.

 The maximum power consumption of this machine is 
950W. Ensure that the power supply is sufficient to operate 
this machine.

 We do not guarantee the operation where an uninterruptible 
power system (UPS) or inverter is used. Do not use an 
uninterruptible power system (UPS) or inverter.

Current: 110 - 127VAC 
(Range 99 - 140 VAC)
220 - 240VAC 
(Range 198 - 264VAC)

Frequency: 50/60 Hz ± 2%

1

1

2

2

There is a risk of getting 
an electric shock and/or 

causing fire.

Be sure to cut off the power supply when attaching 
or removing the power supply plug or the earth 
wire.

Be sure to connect an earth wire to the grounding 
terminal of exclusive use.

 Please do not connect with the ground of a water 
pipe, a gas pipe, and a telephone wire, or lightning 
rod without fail.

Make sure to connect with the ground terminal 
before connecting the power cord to the power 
supply plug.

Be sure to perform extraction and insertion of the 
power cord with a power supply plug.

 Insert the power supply plug into the wall socket 
securely.

Do not touch the power cord, or machine, if your 
hands are wet.

 Install the power cord in a location where it will not 
be stepped on, and do not place objects on the 
power cord.

Do not twist, bind, or knot the power cord.
 Please do not use a damaged power cord.
Do not carry out foot wiring.
Do not connect this machine and other electric 

products to the same wall socket. If connected 
simultaneously with an air-conditioner, a copy 
machine, shredder, etc., electric noise may 
interfere with operation. When the connection with 
the same wall socket is unavoidable, please use a 
commercial noise filter or a commercial noise cut 
transformer. 

Use the attached power cord and insert it directory 
with the ground terminal. Do not use power cords 
intended for other products with this machine.

Do not use an extension cord. When use is 
unavoidable, use a cord rated higher than 15A.

Use of an extended cord may cause AC voltage 
decrease and interfere with normal operation.

During printing, do not shut off the power supply 
or pull out the power supply plug.

When not in use for consecutive holidays or long-
term travel, pull out the power cord.

Do not use the attached power cord for other 
products.

WARNING
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Turning On Your Machine

1 Plug the AC cable into the AC power 
socket of your machine.

2 Plug the AC cable into the electric socket.

3 Check that no documents are on the document 
glass or ADF, and the ADF cover is closed.

4 Hold down the power switch for about a 
second to turn on the power.

The copy standby screen is displayed after 
your machine enters ready status.

Note

 Turn the power off, and when turning the power back on 
again, push the power switch after waiting for a few seconds.

Turning Off Your Machine

Be sure to follow the procedure below every time 
you turn off the machine.

1 Hold down the power switch for about a 
second.

The message [Shutdown in progress. 
Please wait. The machine turns off 
automatically.] appears in the operator 
panel, and power switch indicator blinks 
every 1 second. Then the machine turns 
off automatically and power switch 
indicator goes out.

Note

 Turn the power off, and when turning the power back on 
again, push the power switch after waiting for a few seconds.

When the machine is not used for 
long time

When the machine is not used for long time due 
to holidays or trips, pull the power cord from the 
socket.

Memo

 The machine does not have functional failures if removing 
the power plug for long time (more than 4 weeks).

Power Save Mode and Sleep Mode

The two-phase power saving mode enables you 
to reduce machine power consumption.

Power Save Mode
When your machine is not used for a certain 
period of time, it automatically enters a power 
saving mode to reduce power consumption.

You can enter the power saving mode manually 
by pressing the <POWER SAVE> key on the 
operator panel.
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The <POWER SAVE> key lights up while in the mode.

Memo

 By factory default, the time interval to enter the power 
saving mode is set to 1 minute. You can change the time 
interval by pressing the <SETTING> key on the operator 
panel and selecting [Admin Setup] > [Management] > 
[Power Save] > [Power Save Time].

Sleep Mode
Your machine goes from the power saving mode 
into the sleep mode after a set period of time. In 
the sleep mode, the status of your machine is 
almost the same as when it is turned off. 

The <POWER SAVE> key blinks while in the 
sleep mode.

Note

 The machine does not enter the sleep mode if an error 
occurs.

 If time-set transmission is scheduled, the machine will not 
go into sleep mode.

 If the fax transmission is waiting for a redial, the machine 
cannot enter sleep mode.

 When the network connection is switched from wired to 
wireless, sleep mode is disabled. To enable sleep mode for 
devices connected using wireless LAN, enable sleep mode 
from the sleep mode setting menu. (MB451w and MB471w 
only)

 When a device using the wireless LAN connection goes into 
sleep mode, the wireless LAN connection is broken. To 
reconnect to the wireless LAN, press the power save key 
on the device to recover from sleep mode. (MB451w and 
MB471w only)

 After the device connected to the wireless LAN has 
recovered from sleep mode, it automatically connects to 
the wireless access point using the same settings as before 
it went into sleep mode. However, it may take up to 1 
minute to connect. (MB451w and MB471w only)

 When the network connection is switched from wireless 
LAN to wired LAN, sleep mode is enabled. (MB451w and 
MB471w only)

Memo

 By factory default, the time interval to enter the sleep 
mode is set to 30 minutes. You can change the time 
interval by pressing the <SETTING> key on the operator 
panel and then selecting [Admin Setup] > 
[Management] > [Power Save] > [Sleep Time].

Returning to the Standby Mode
To return the machine to the standby mode from 
the power saving or sleep modes, press the 
<POWER SAVE> key on the operator panel.

Memo

 When your machine receives a print job from a computer 
or other devices, it automatically returns to the standby 
mode.

Auto Power Off

When your machine is not used for a certain 
period of time, the power turns off automatically. 
Once the machine turns off, you need to turn on 
to use it.

The machine has three settings to select the 
machine's behavior on Auto Power Off.

Enable

Auto Config

Disable

Enable 

When your machine is not used for a certain 
period of time, it turns off the power 
automatically.

Auto Config

The machine will not turn off automatically under 
the conditions listed below.

 - An Ethernet cable is attached to network 
interface connection

 - A telephone cable is attached to LINE 
connection 

Disable

The Auto Power Off function is disabled. The 
machine will not turn off automatically.

Note

 In the following cases, the Auto Power Off function is also 
disabled. 

- When an error occurs

- When time-set transmission is scheduled

- When the fax transmission is waiting for a redial

- When [Auto Power Off] is [Auto Config.] and 
Ethernet cable is attached

- When [Auto Power Off] is [Auto Config.] and 
telephone cable is attached

Memo

 By factory default, the time interval to turn off the power 
is set to 4 hours. You can change the time interval by 
pressing the <SETTING> key on the operator panel and 
then selecting [Admin Setup] > [Management] > 
[Power Save] > [Auto Power Off Time].

 By factory default, [Auto Power Off] is set to [Auto 
Config] or [Disable]. You can change the setting by 
pressing the <SETTING> key on the operator panel and 
then selecting [Admin Setup] > [User Install] > 
[Power Save] > [Auto Power Off]
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 Installing Options
This section explains how to install options on your machine. The following options are available:

 Second tray unit (MB461, MB461+LP, MB471, MB471w, MB491, MB491+, MB491+LP, ES4161 MFP, ES4191 MFP, 
MPS4200mb, MPS4700mb only)

Note

 Be sure to hold down the power switch for about a second to turn off the power and unplug the AC cable and Ethernet or USB 
cable before installing options. Installing options while your machine is turned on may damage your machine and options.

Reference

 For details on the location of each component of the machine, refer to "Names of Components" P. 15.

Installing a Second Tray Unit (MB461, MB461+LP, 
MB471, MB471w, MB491, MB491+, MB491+LP, ES4161 
MFP, ES4191 MFP, MPS4200mb, MPS4700mb only)

Install an optional second tray unit (tray 2) when 
you want to increase the paper capacity of your 
machine. After installation, you need to configure 
the printer driver settings.

Reference

 For the specification of the second tray unit (Tray2), refer 
to "Loading Paper" P. 32.

Installation

1 Hold down the power switch for about a 
second to turn off the power, and then 
unplug the AC cable and the Ethernet or 
USB cable.

Reference

 "Turning Off Your Machine" P. 20

2 Lift your machine and align the three 
pins of the second tray unit with the 
holes at the bottom of your machine.

3 Place your machine on the second tray 
unit gently.

4 Attach the lock parts.

5 Plug the AC cable and Ethernet or USB 
cable into your machine, and then push 
the power switch.

Model Number : N22204A
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Printer Driver Configuration

Note

 You must be logged in as an administrator to complete this 
procedure.

 If the following conditions are met for Mac OS X, it is not 
necessary to configure the printer driver, as the configured 
option information is automatically taken from the 
machine.

- USB connection

- When options have been configured on the machine 
prior to installing the driver, where there is a connection 
to a network using EtherTalk

 Windows PCL XPS printer driver is not available for 
Windows Vista, Windows Server 2008, Windows Server 
2003, and Windows XP.

Reference

 The printer driver needs to be installed on the computer 
before doing this procedure. For details on how to install the 
printer driver, refer to "Connecting to a Computer" P. 46.

 For Windows PCL/PCL XPS Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the OKI MB491 icon and 
select [Printer properties]. (If you 
have installed multiple printer drivers, 
select [Printer properties] >[OKI 
MB491(PCL)] or [OKI MB491(PCL 
XPS)]).

3 Select the [Device Options] tab.

4 For the network connection, select [Get 
Printer Settings]. 
For the USB connection, check [Lower Cassette].

5 Click [OK].

 For Windows PS Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the [OKI MB491(PS)] icon 
and then select [Printer properties]. 
(If you have installed multiple printer 
drivers, select [Printer properties] >
[OKI MB491(PS)].)

3 Select the [Device Settings] tab.

4 For the network connection, select [Get 
installed options automatically] 
under [Installable Options], and then 
click [Setup].
For the USB connection, select [Installed] for 
[Second tray] under [Installable Options].

5 Click [OK].

 For Mac OS X PCL/PS Driver
(Mac OS X 10.5 to 10.8)

1 Select [System Preferences] from the 
Apple menu.

2 Click [Print & Scan] (For Mac OS X 10.5 
and 10.6:[Print & Fax]).

3 Select the name of your machine and 
then click [Options & Supplies].

4 Select the [Driver] tab.
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5 If the optional tray is already mounted, 
click [Second Tray], and then click [OK].

 For Mac OS X PCL/PS Driver
(Mac OS X 10.4.0 to 10.4.11)
Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

1 From [Go], select [Utilities] and then 
double-click [Printer Setup Utility].

2 Select the name of your machine and 
then click [Show Info].

3 Select [Installable Options].

4 If the optional tray is already mounted, 
click [Second Tray], and then click 
[Apply Changes].

5 Close [Printer Info].
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Operator Panel
This section explains the names and functions of components on the operator panel and how to enter 
text.

No. Name Function

1 Display screen Displays operating instructions and the status of the machine.

2 Main function keys Switches functions. The selected key lights up in blue.

<COPY> key Switches to the copy start screen.

<SCAN> key Switches to the scanner menu screen.

<PRINT> key Switches to the print menu screen.

<FAX/HOOK> key
(for MB451/MB451w/MB471/
MB471w/MB491/MB491+/
MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb)

Switches to the fax/Internet fax menu. On the Fax Menu, hooks 
the phone line.

3 <START (MONO)> key Starts copying, scanning, faxing, or printing from USB memory in 
black and white.

4 <START (COLOR)> key Starts scanning in color.

5 <STOP> key Cancels the current job immediately.

6 <STATUS> key Displays the status menu screen. 
Flashes/turns on if there is a status item to be displayed.

7 <SETTING> key Displays the equipment setting menu screen.

8 <REDIAL/?HELP> key 
(for MB451/MB451w/MB471/
MB471w/MB491/MB491+/
MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb) 
<?HELP> key 
(for MB441/MB461/MB461+LP/
ES4161 MFP)

Displays the help screen. When closing, press the <REDIAL/
?HELP> key, <Return> key, or <RESET/LOG OUT> key. On 
certain screens,dial the phone number which is dialed the last time.

9 <RESET/LOG OUT> key  In the top screen of each function, logs out.
 In the start screen of each function, returns to the top screen.

*In the copy function, the top screen is the same as the start 
screen.

 In the setting screen, resets a setting value and returns to the 
start screen.

10 Ten-key pad  Enters numbers.
 Enters alphanumeric characters and symbols.

2

19

1

22

20

185431712 1413

1116

15

6 7 89 10 21
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Default Screen
Turn the power on, and when the machine is 
ready for use, the Copy Start screen will be 
displayed as the default mode.

You can switch to other functions by using the 
main function keys.

Reference

 You can change the default screen by pressing the 
<SETTING> key on the operator panel and then selecting 
[Admin Setup] > [Management] > [Default Mode].
For details, refer to the User's Manual Advanced.

11 <UP> key Shifts the highlighted selection up while an item is selected or 
characters are entered.

12 <DOWN> key Shifts the highlighted selection down while an item is selected or 
characters are entered.

13 <LEFT> key Returns to the previous screen.
Shifts the highlighted selection to the left while an item is 

selected or characters are entered.

14 <RIGHT> key  Proceeds to the next screen.
Shifts the highlighted selection to the right while an item is 

selected or characters are entered.

15 <OK> key Confirms the highlighted item.
Selects an item to be checked.

16 <BACK> key Returns to the previous screen.

17 <CLEAR> key Executes the following action
Minimizes a setting value.
 Enters zero for a setting value.
Clears what is entered.
Cancels a selected item.

18 <POWER SAVE> key  Enters or exits the power saving mode.
 Exits the sleep mode.
Lights up in green while in the modes.

19 <DATA IN MEMORY> indicator
(for MB451/MB451w/MB471/
MB471w/MB491/MB491+/
MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb)

Lights up when data is in memory.
* Sleep mode does not light up even if there is data in the memory.

20 One-Touch key pad Accesses a registered e-mail address or fax number.
8 keys x 2 groups which is 16 entries in total (Press the <SHIFT> 
key to switch the groups)

21 <JOB MACRO> key 
(for MB471/MB471w/MB491/
MB491+/MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb)

Switches to the job macro screen.

22 Qwerty keyboard 
(for MB471/MB471w/MB491/
MB491+/MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb)

Enters text.
It is under the one-touch key pad.

No. Name Function
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Entering Text Using the 
Operator Panel

When you need to enter text while setting an 
item, the entry screen shown below appears.

You can enter upper and lower case letters, 
numbers and symbols with the screen keyboard.

Memo

 When you need to enter only numbers, the screen 
keyboard may not appear. In this case, enter numbers 
using the ten-key pad.

Entering Text

1 Press , , ,  to select the character 
you want, and then press .

The selected character is entered in the text field.

2 Repeat step 1 until all the characters 
required are entered.

3 Press the  and  to select [Enter] and 
press  to complete the entry process.

Using the Ten-key Pad
You can also use the ten-key pad to enter 
alphanumeric characters and symbols in the 
entry screen.

You can enter the numbers labeled on each key, 
as well as the other characters by pressing the 
keys repeatedly.

1 Press a key on the ten-key pad until the 
character you want appears in the text 
file.

2 Repeat step 1 until all the characters 
required are entered.
If you continuously press the same key, you can 

press the  button to move the cursor.

3 Check that [Enter] is selected and press 
 to complete the entry process.

Memo

 You can enter the following characters by pressing the 
keys on the ten-key pad.

OK

OK

Ten-key Characters

1 1

2 abc2ABC

3 def3DEF

4 ghi4GHI

5 jkl5JKL

6 mno6MNO

7 pqrs7PQRS

8 tuv8TUV

9 wxyz9WXYZ

0 (Space) 0

* @*

# ._-(Space)+!"$%&'(),/
:;<=>?[\]^#

OK
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Using the QWERTY Keyboard
(MB471, MB471w, MB491, 
MB491+, MB491+LP, ES4191 MFP, 
MPS4200mb, MPS4700mb)

You can also use the QWERTY keyboard to enter 
alphanumeric characters and symbols in the 
entry screen.

The keyboard enables you to switch the entry 
mode to the standard mode, CAPS mode, or 
CTRL mode. The changed mode is reflected to 
the screen keyboard display.

 Standard mode

It enables you to enter small alphabetical letters.

The following screen keyboard is displayed.

 CAPS mode

Pressing the <CAPS> key enables you to enter 
capital alphabetical letters.

The following screen keyboard is displayed.

 CTRL mode

Pressing the <CTRL> key enables you to enter 
symbols.

The following screen keyboard is displayed.

Note

 When the QWERTY keyboard cover is open, the numerical 
keypad can only be used for entering numbers.

Deleting the Entered Text

You can delete text in the text field in the 
following ways.

Pressing the <CLEAR> key
Press the <CLEAR> key to delete the last 
character entered.

Hold the <CLEAR> key to delete all the 
characters you have entered.

Selecting [BS] on the Screen Key-
board

Press the  and  and to highlight [BS] and 

then press  to delete the last character 
entered.

Pressing the Backspace Key on the 
Qwerty Keyboard (for MB471, 
MB471w, MB491, MB491+, 
MB491+LP, ES4191 MFP, 
MPS4200mb, MPS4700mb)

Press the backspace key to delete the last 
character entered.

OK
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 Loading Paper and Documents
This section explains the specifications for paper and documents, and how to load them.

Paper

Supported Paper Types

For high-quality printing and to avoid printing problems, be sure to use the supported paper types. 
Please use digital photo print paper.

Please check the print quality and the movement of the paper thoroughly beforehand to make sure that 
there are no problems. Your machine supports the below-listed types of paper.

Using paper other than the recommended print paper may result in unstable paper output depending on 
how the front/back of the paper is loaded. In this case, check beforehand by inserting the paper in the 
reverse orientation etc, and confirm that the paper is output correctly before use.

*1 Tray 1 can contain paper 100 to 216 mm (3.94 to 8.5 inches) wide and 148 to 355.6 mm (5.83 to 14 
inches) long.

*2 Tray 2 can contain paper 148 to 216 mm (5.83 to 8.5 inches) wide and 210 to 355.6 mm (8.27 to 14 
inches) long.

*3 The MP Tray (MB451/MB451w/MB471/MB471w/MB491/MB491+/MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb) or Manual Feeder (MB441/MB461/MB461+LP/ES4161 MFP) can contain 
paper 86 to 216 mm (3.4 to 8.5 inches) wide and 140 to 1320.8 mm (5.5 to 52 inches) long.

Paper Type Paper Size mm (inch) Paper Weight

Standard paper A4 210 x 297 60 to 163 g/m2 (16 to 43lb)
For duplex print, 60 to 163 g/m2 (16 to 
43lb)

Note

 If the paper size is set at A6, A5, or with a 
paper width narrower than 148 mm (A5 
width), the printing will be slower.

A5 148 x 210

A6 105 x 148

B5 182 x 257

Letter 215.9 x 279.4
(8.5 x 11)

Legal (13 inch) 215.9 x 330.2
(8.5 x 13)

Legal (13.5 inch) 215.9 x 342.9
(8.5 x 13.5)

Legal (14 inch) 215.9 x 355.6
(8.5 x 14)

Executive 184.2 x 266.7
(7.25 x 10.5)

Statement 139.7 x 215.9 
(5.5 x 8.5)

16K
(184 x 260 mm)

184 x 260

16K
(195 x 270 mm)

195 x 270

16K
(197 x 273 mm)

197 x 273

Custom *1*2*3 Width:
64~216
Length:
148~1321

60 to 163 g/m2 (16 to 43lb)
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Paper Type Paper Size mm (inch) Paper Weight

Envelope Monarch 98.4 x 190.5
(3.875 x 7.5)

Envelopes should be 88 g/m2(24lb) 
paper, and flap parts of envelopes should 
be foldedCom-9 98.4 x 225.4

(3.875 x 8.875)

Com-10 104.8 x 241.3
(4.125 x 9.5)

DL 110 x 220
(4.33 x 8.66)

C5 162 x 229
(6.4 x 9)

Index card Index card 76.2 x 127.0
(3 x 5)

Label A4 210 x 297 0.1~0.2 mm

Letter 215.9 x 279.4
(8.5 x 11)

Partly-printing 
paper

Subject to the standard paper 64 to 163 g/m2 (18 to 43lb)

Color paper Subject to the standard paper 64 to 163 g/m2 (18 to 43lb)
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Paper Recommendations

Your MFP will handle a variety of print media, 
including a range of paper weights and sizes.

This section provides general advice on choice of 
media, and explains how to use each type.

The best performance will be obtained when 
using standard 75~90g/m2 paper designed for 
use in copiers and laser printers.

Use of heavily embossed or very rough textured 
paper is not recommended.

Pre-printed stationery can be used, but the 
ink must not offset when exposed to the high 
fuser temperatures used in the printing process.

Envelopes
Envelopes should be free from twists, curls or 
other deformations.

They should also be of the rectangular flap type, 
with glue that remains intact when subjected to 
hot roll pressure fusing used in this type of 
printer. Window envelopes are not suitable.

 Labels
Labels should also be of the type recommended 
for use in copiers and laser printers, in which the 
base carrier page is entirely covered by labels. 
Other types of label stock may damage the 
printer due to the labels peeling off during the 
printing process.

Storing Paper

Store paper under the following conditions to 
maintain quality:

 Inside a cabinet or other dry and dark place

 On a flat surface

 Temperature: 20°C

 Humidity: 50% RH (relative humidity)

Avoid placing:

 Directly on the floor

 In the direct sunlight

 Near the inside of an exterior wall

 On an uneven surface

 Where static electricity may be generated

 Where temperature rapidly changes

 Near a printer, air conditioner, heater, or duct

Note

 Do not unwrap the paper until you are ready to use the 
paper.

 Do not leave paper unwrapped for a long period. Doing so 
may result in paper handling and print quality issues.
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Loading Paper

Your machine has two built-in trays (tray 1 and the MP tray) (MB441, MB461, MB461+LP and ES4161 
MFP is Manual Feeder) and an optional tray (tray 2). The Optional tray (Tray2) is only available on 
MB461, MB461+LP, MB471, MB471w, MB491, MB491+, MB491+LP, ES4161 MFP, ES4191 MFP, 
MPS4200mb, and MPS4700mb. Refer to the list below to check the supported paper and capacities of 
each tray.

Note

 Duplex printing cannot be performed on paper indicated by an "*".

Tray Supported paper 
size Paper capacity Paper weight

Tray1 A4
A5*
B5
A6*
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive
Statement*
 16K (184 x 260 mm)
 16K (195 x 270 mm)
 16K (197 x 273 mm)
Custom

250 sheets
(when paper weight is 80 
g/m2)

 Light
60 to 63 g/m2 (16 to 17 lb)

Medium Light
64 to 74 g/m2 (18 to 19 lb)

Medium
75 to 87 g/m2 (20 to 23 lb)

Medium Heavy
88 to 104 g/m2 (24 to 27 lb)

Heavy
105 to 122 g/m2 (28 to 32 lb)

Tray2 
(optional) 
(MB461, 
MB461+LP, 
MB471, 
MB471w, 
MB491, 
MB491+, 
MB491+LP, 
ES4161 MFP, 
ES4191 MFP, 
MPS4200mb, 
MPS4700mb 
only)

A4
A5*
B5
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive
 16K (184 x 260 mm)
 16K (195 x 270 mm)
 16K (197 x 273 mm)
Custom

530 sheets
(when paper weight is 80 
g/m2)

 Light
60 to 63 g/m2 (16 to 17 lb)

Medium Light
64 to 74 g/m2 (18 to 19 lb)

Medium
75 to 87 g/m2 (20 to 23 lb)

Medium Heavy
88 to 104 g/m2 (24 to 27 lb)

Heavy
105 to 122 g/m2 (28 to 32 lb)
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 Loading Paper in Tray 1 and Tray 2
The following procedure explains how to load 
paper in tray 1 or tray 2 (optional).

Memo

 The following procedure uses tray 1 as an example but the 
same is applied to tray 2.

1 Pull out the paper tray.

Note

 The paper size selection screen will be displayed when 
you pull out the Tray. Register the loaded paper on 
your machine. Proceed to "Configuring the Tray 
Settings" P. 36.

2 Slide the paper guide (1) to the width of 
paper to be loaded.

3 Slide the paper stopper (2) to the length 
of paper to be loaded.

MP Tray
(MB451/
MB451w/
MB471/
MB471w/
MB491/
MB491+/
MB491+LP/ 
ES4191 MFP/
MPS4200mb/

A4
A5
B5
A6*
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive
Statement*
 16K (184 x 260 mm)
 16K (195 x 270 mm)
 16K (197 x 273 mm)
Custom
Com-9 Envelope*
Com-10 Envelope*
Monarch Envelope*
DL Envelope*
C5 Envelope*
C6 Envelope* 

 100 sheets
(when paper weight is 
80 g/m2)

 10 envelopes

 Light
60 to 63 g/m2 (16 to 17 lb)

Medium Light
64 to 74 g/m2 (18 to 19 lb)

Medium
75 to 87 g/m2 (20 to 23 lb)

Medium Heavy
88 to 104 g/m2 (24 to 27 lb)

Heavy
105 to 122 g/m2 (28 to 32 lb)

Ultra Heavy
123 to 163 g/m2 (33 to 43 lb)

Manual Feeder
(MB441/
MB461/
MB461+LP/
ES4161 MFP)

 1 sheet
 1 envelope

Tray Supported paper 
size Paper capacity Paper weight

1

2
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4 Flex paper back and forth, and then fan 
it. Straighten the edges of the paper 
stack on a level surface.

5 Load paper with the print side face down.

Note

 Do not load paper above the fill line (3).

6 Push the paper tray until it stops.
Register the loaded paper on your machine. 
Proceed to "Configuring the Tray Settings" P. 36.

 Loading Paper on the MP Tray 
(MB451/MB451w/MB471/
MB471w/MB491/MB491+/
MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb)

The following procedure explains how to load 
paper in the MP tray.

1 Open the MP tray.

2 Pull out the paper support.

3 Pull out the sub support.

[ ▼ ▼ ▼ ]

3
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4 Adjust the manual feeding paper guide to 

the width of paper to be loaded.

5 Insert the paper with the print side face 
up until its edge touches the paper feed 
entrance.

Note

 Do not load paper above the fill line (1).

6 Press the Set button (2).

Register the loaded paper on your machine. 
Proceed to "Configuring the Tray Settings".

Note

 Do not load paper of different sizes, types or weights at 
the same time.

 When adding paper, remove the paper in the MP tray and 
straighten the edges of both stacks of paper, and then load 
them again.

 Do not put anything other than paper for printing. 

Memo

 When loading envelopes in the MP tray, load them face up 
with the orientation as stated below.

- Your envelopes (Monarch, Com-9, Com-10, DL and C5) 
are loaded with the flap folded and the flap should come 
to the right side to the feeding direction.

 Loading Paper in the Manual 
Feeder (MB441/MB461/
MB461+LP/ES4161 MFP)

The following procedure explains how to load 
paper in the Manual Feeder. 

1 Open the Manual Feeder. 

2 Adjust the manual feeding paper guide to 
the width of paper to be loaded. 

3 Load a paper.

Note

 Only one sheet can be set in the Manual Feeder each time.

 The machine will not load paper when it is in the sleep 
mode or power save mode. If it is in either mode when you 
use the manual feeder, press the <POWER SAVE> key on 
the operator panel. Then it goes to the standby mode. 
After that, load paper.

1

2
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Configuring the Tray Settings
After you load paper in tray 1, tray 2 (optional), 
or the MP tray, you need to register the loaded 
paper on your machine.

With Tray 1/Tray 2: The paper size selection 
screen will be displayed automatically when you  
pull out the Tray. Please use settings from 
Section 4.

With MP Tray: Please use settings from Section 1.

1 Press the <SETTING> key on the operator panel.

2 Press the  to select [Paper Setup] and 
then press .

3 Press the  to select the paper tray in 
which you loaded paper and then press .

4 Select [Paper Size] and then press .

5 Press the  to select the size of the 
loaded paper and then press .
Reference

 If [Custom] is selected for [Paper Size], you need to 
register the custom size. For how to register the 
custom size, refer to "Registering Custom Sizes" P. 36.

6 Press the  to select [Media Type] and 
then press .

7 Press the  to select the type of media 
loaded and then press .

8 Press the  to select [Media Weight] 
and then press .

9 Press the  to select the weight of the 
loaded paper and then press .

10 Press the  until the top screen is 
displayed.

Registering Custom Sizes
To load custom size paper, you need to register 
the width and length of the paper before printing. 
The range of the sizes you can set differs 
according to the paper tray.

Note

 For tray 1 and tray 2, you can configure the [Custom] 
setting only when [Paper Size] is set to [Custom].

 The available size range for duplex printing is the same as 
that for tray 2.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Paper Setup] and 
press .

OK

OK

OK

OK

OK

OK

OK

OK

Tray Available size range

Tray1 Width:
100 to 216 mm (3.94 to 8.5 inches)
Length:
148 to 355.6 mm (5.83 to 14.0 
inches)

Tray2 
(Optional) 
(MB461, 
MB461+LP, 
MB471, 
MB471w, 
MB491, 
MB491+/
MB491+LP, 
ES4161 MFP, 
ES4191 MFP, 
MPS4200mb, 
MPS4700mb 
only)

Width:
148 to 216 mm (5.83 to 8.5 inches)
Length:
210 to 355.6 mm (8.27 to 14.0 
inches)

MP tray 
(MB451/
MB451w/
MB471/
MB471w/
MB491/
MB491+/
MB491+LP/ 
ES4191 MFP/
MPS4200mb/
MPS4700mb)
Manual 
Feeder 
(MB441/
MB461/
MB461+LP/
ES4161 MFP)

Width:
86 to 216 mm (3.4 to 8.5 inches)
Length:
140 to 1320.8 mm (5.5 to 52.0 
inches)

OK
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3 Press the  to select the paper tray in 

which you loaded paper and then press .

4 Press the  to select [Custom] and then 
press .

5 Enter the desired value using the ten-key 
pad and then press .
Press the  or  to move to the next box.

6 Press the  until the top screen is 
displayed.

Paper Output

Your machine outputs to the facedown or faceup 
stacker. Paper types that can be outputted to 
each stacker are as follows.

When performing duplex printing, paper outputs 
to the facedown stacker.

Note

 Do not open or close the faceup stacker while printing as it 
may result in a paper jam.

Using the Facedown Stacker
Delivers paper with the print side face down.

Note

 Check that the faceup stacker on the rear side of the 
machine is closed. If the faceup stacker is open, paper is 
always outputted to the faceup stacker.

Using the Faceup Stacker
Delivers paper with the print side face up.

Note

 The faceup stacker is not available in duplex printing.

1 Pull the faceup stacker on the rear side 
of the machine and open it toward you.

2 Unfold the faceup stacker.

Documents
You can use the auto document feeder (ADF) or 
the document glass to load documents for 
copying, scanning or faxing.

Document Requirements

You cannot load the following documents on the 
ADF. Use the document glass instead:

 Torn or perforated paper

 Curled or rolled paper

 Wet paper

 Static paper

 Carbon-backed paper

 Fabrics, metallic sheets or Transparency films

 Paper with staples, paper clips, ribbons, or tape

 Pasted paper, paper with glue

 Glossy paper

 Specially coated paper

Output 
Stacker

Supported 
paper type

Paper output 
capacity

Facedown Standard
Recycled 

paper

 150 sheets (when 
paper weight is less 
than 80 g/m2)

OK

OK

OK
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Keep the following in mind to avoid damaging the 
document glass:

 Do not hold a document firmly on the glass when 
copying a thick document.

 Place hard documents gently.

 Avoid loading documents with sharp projections.

Scannable Area

The text or images on the shaded area shown 
below are not scanned.

Memo

 The arrow in the above drawing indicates the feeding 
direction in the auto document feeder, or the scanning 
start side on the document glass.

Loading Documents

Note

 For documents using adhesives, ink, or correction fluid, set 
them after checking that these have completely dried.

 Duplex scanning cannot be performed on paper indicated 
by an "*".

 "**" supported only MB461+LP/MB491+LP/MPS4700mb.

 Loading Documents on the ADF

1 Load your documents face up on the ADF.
If your documents are portrait, load them with the 
top edge of the documents in first.

If your documents are landscape, load them with 
the left edge of the documents in first.

2 Adjust the document guides to the width 
of your documents.

 Loading Documents on the Docu-
ment Glass

1 Lift and open the document glass cover.

2 Place a document face down on the 
document glass.
If your document is portrait, align its top edge to 
the upper-left corner of the glass.

Scanner 
type

Scannable 
size

Paper 
capacity

Paper 
weight

ADF A4
A5
B5
A6*
 Letter
 Legal 13
 Legal 13.5
 Legal 14
 Executive

50 sheets
(80 g/m2)

60 to 105 g/m2  
(16 to 28 lb) 

Document 
glass

A4
A5
B5
A6
 Letter
 Executive
 Legal 13**
 Legal 

13.5**
 Legal 14**

- 20 mm

2 mm

2 mm

2 mm

2 mm
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If your document is landscape, align its right edge 
to the upper-left corner of the glass.

3 Close the document glass cover gently.
Reference

 Set [Document Direction] according to the direction of 
your document to get the output you want. The factory 
default is [Portrait]. Refer to "Changing Image 
Orientation of Document (Direction)" P. 81.

Note

 When you take a copy with the document glass, do not 
apply an excessive load to the document glass.
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Basic Settings for Faxing (for MB451, MB451w, 
MB471, MB471w, MB491, MB491+, MB491+LP, 
ES4191 MFP, MPS4200mb, MPS4700mb only)

This section explains basic settings for faxing. Be sure to configure the following settings before you transmit faxes.

Setting for Country Code 
Note

 Please select the correct country code.
 If [Country Code] is set to the wrong value, there is a possibility 

that fax transmission and reception may not function correctly.
Though the line connection is correctly, if the fax transmission or 
reception fails, ensure the [Country Code] setting first.

1 Hold down the power switch for about a 
second to turn on the power.

2 Press the <SETTING> key on the operator panel.

3 Press the  to select [Admin Setup] 
and then press .

4 Enter the administrator password. 
The default password is "aaaaaa".
a Press , , ,  to select the 

character you want, and then press . 

- The selected character is entered as "*" 
in the text filed.

- If you have entered an incorrect value, 
press the <CLEAR> key and then 
enter the correct value.

b Repeat step a until all characters 
required are entered.

c Press the  and  to select [Enter] and 
press .

5 Press the  to select [Fax Setup] and 
then press .

6 Press the  to select [Fax Setting] and 
then press .

7 Press the  to select [Country Code] 
and then press .

8 Press the  or  to select your country 
name and then press .

If your country name is not displayed, select 
the following value.

- If your country is Czech Republic or 
Slovakia, select [Czech/Slovakia].

- If your country is Canada, select [U.S.A].

- If the region of your country is Latin 
America, select [Latin America].

- If the region of your country is Europe or 
Middle East, select [International].

Settable Country Code:

9 If the confirmation message is displayed 
then press .
The machine will re-start automatically 
and the default screen will be displayed a 
few minutes later.

10 Hold down the power switch for about a 
second to turn off the power.

Memo

 If the Country Code is changed, the values of [PBX Line] 
and [MF (Tone)/DP (Pulse)] are changed to the default 
values for each Country Code.

OK

OK

U.S.A.  International  United Kingdom  Ireland  
Norway    Sweden      Finland  Denmark  
Germany  Hungary  Czech/Slovakia  Poland  
Switzerland  Austria  Belgium  Netherlands  
France  Portugal  Spain  Italy  Greece  Australia  
New Zealand  Singapore  Hong Kong  Latin 
America  Mexico  China  Russia  Taiwan  Japan  
Korea  Thailand  Malaysia  Jordan  Argentina  
Brazil  South Africa  Belarus  Moldova  Turkey  
Ukraine

OK

OK

OK

OK

OK

OK
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Connecting a Telephone Line 

Depending on your environment, a method to 
connect the telephone line is different. Based on 
the following figures, connect the line for your 
environment.

Note

 Turn off the machine when you connect the telephone line 
with the machine.

 You cannot connect to the ISDN line directly. To connect to 
it, use the terminal adopter (TA) and connect to the LINE 
connection of the machine.

 Don't connect with USB cable or LAN cable at this point.

Memo

 Depending on your environment of the machine, Checking 
the reception mode, refer to "Specifying Reception Mode" 
P. 45.

 Checking the dial type settings, refer to "Settings for each 
dialing type" P. 43.

Connecting to the Public Line
(Connecting for Fax Only)

1 Plug one end of the [Telephone cable] 
into the [LINE connection] of your 
machine and the other end into a 
[Public Line (Analog)].

Note

 Connect telephone cable to [LINE connection] without 
fail. Never connect it to [TEL connection].

Connecting to the Public Line
(Connecting for Fax and Telephone)

1 Plug one end of the [Telephone cable] 
into the [LINE connection] of your 
machine and the other end into a 
[Public Line (Analog)].

2 Remove the [Telephone connector cover].

3 Plug the external telephone's cable into 
the [TEL connection] of your machine.

The telephone that is connected to the machine 
is called an external telephone.

Note

 Only one telephone can be connected to this machine.

 Don't connect the telephone to the machine in parallel. If you 
connect the telephone to the machine in parallel, the following 
problem will occur and the machine will not work correctly.

LINE connection

Telephone cable

Public Line
(Analog)

LINE connection

Telephone cable

Public Line
(Analog)

Telephone connector 
cover

TEL connection
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- Picking up the telephone receiver when sending or 
receiving a fax may interrupt pictures or cause 
communication error to occur.

- The fax transfer function is not able to work from the 
external telephone.

Memo

 In the case of direct interconnection, separate construction is 
needed. Please contact the telephone company that you use.

Other cases

Note

 Turn off the machine when you connect the telephone line 
with the machine.

Connecting to the ADSL Environment

Plug the [Telephone cable] connected to the 
ADSL modem into the [LINE connection] of 
your machine. 
Remove the telephone connector cover.
Plug the external telephone's cable into the [TEL 
connection] of your machine.

Memo

 Check the dial tone detection if it is unable to dial and refer 
to "Admin Setup - User install" P.103 Advanced.

 If you cannot send or receive faxes well, set [Super G3] to 
off. Refer to "Setting for Super G3" P. 45.

Connecting to IP Telephone

Plug the [Telephone cable] connected to the IP 
telephone into the [LINE connection] of your 
machine.
Remove the telephone connector cover.
Plug the external telephone's cable into the [TEL 
connection] of your machine.

Memo

 Check the dial tone detection if it is unable to dial and refer 
to "Admin Setup - User install" P.103 Advanced.

 If you cannot send or receive faxes well, set [Super G3] to 
off. Refer to "Setting for Super G3" P. 45.

Connecting CS Tuner or Digital 
Television

Plug the [Telephone cable] connected to the 
[Public Line (Analog)] into the [LINE 
connection] of your machine.

Remove the telephone connector cover.

Plug the telephone cable connected to the CS tuner 
or digital television into the [TEL connection] of 
your machine.

Public Line (Analog) Public Line (Analog) first floor second floor

TEL connection

LINE connection

Telephone cable
Splitter

ADSL modem

Public Line
(Analog)

LINE connection

TEL connection

Telephone cable

Optical IP telephone
Corresponding telephone

*Insert into the
telephone cable jack.

Optical Network Unit (ONU)

Optical cable
LAN
cable

LINE connection

TEL connection

CS tuner or digital
television

Telephone cable
Public Line
(Analog)
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Connecting PBX, Home Telephone or 
Business Phone

Plug the [Telephone cable] connected to the 
[Public Line (Analog)] into the [LINE 
connection] of your machine.

Remove the telephone connector cover.

Plug the telephone cable connected to a control 
device including PBX, etc. into the [TEL 
connection] of your machine.

- Home Telephone -

A number of telephones are connected with one or 
two telephone lines to allow internal and door 
phone communication. This is simple switching 
equipment for household.

- Business Phone -

More than two telephone lines can be 
accommodated, and these telephone lines can be 
shared with a number of telephones to allow 
internal communication. This is simple switching 
equipment.

Connecting as an Internal Telephone

Plug the [Telephone cable] connected to a 
control device including PBX, etc. into the [LINE 
connection] of your machine.

Memo

 Set [PBX Line] to [ON]. Refer to "PBX Connecting" P. 45.

Settings for each dialing type
The factory default [MF (Tone)/DP (Pulse)] is 
set to [Tone].

 For push-button phones, if you hear a "Beep, boop, 
beep" sound, leave [MF (Tone)/DP (Pulse)] as 
[Tone].

 For push-button type phones, if you do not hear a 
"Beep, boop, beep" sound, or if you are using a 
rotary-dial type phone, set [MF (Tone)/DP 
(Pulse)] to [Pulse].

How to Configure Settings

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup], 
and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter], and press .

5 Press the  to select [User Install], 
and press .

6 Press , select [MF (Tone)/DP 
(Pulse)], and then press .

7 Press , select Dial Type, and then press 
.

LINE connection

TEL connection

Telephone cable
Public Line
(Analog)

Control device
including PBX, 
etc.

LINE connection

Public Line
(Analog)

Telephone cable

Control device
including PBX,
etc.

OK

OK

OK

OK

OK
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8 Press the  until the top screen is displayed.

Setup of Date/Time
Setup of Date/Time of your region.

Reference

 You can set up date and time automatically using Webpage. 
For details, refer to the User's Manual Advanced.

1 Press the <SETTING> key on the operator panel.

2 Press the  select [Easy Setup] and 
then press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter], and press .

5 Press the  to select [Date/Time 
Setting] and then press the .

6 Press the  to select the appropriate 
time zone and then press .

7 Press the  to select [Manual] and then 
press .

8 Press the  or  to select the current 
date and then press .
To move to the next box, press the .

9 Press the  or  to select the current 
time and then press .
To move to the next box, press the .

10 When the setup menu screen is displayed, 
press  to complete the setup.

Specifying Sender Information
Specify the fax number and sender name for 
your machine.

1 Press the <SETTING> key on the operator panel.

2 Press the  to select [Easy Setup] and 
press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter], and press .

5 Press the  to select [Fax Setting] and 
then press the .

6 Press  to select the [Fax Number] 
entry box.

7 Enter the fax number of your machine 
with the numerical keypad.

8 Select [Enter] and then press .

9 Press  to select the [Sender ID] entry box.

10 Enter arbitrary sender information.
Up to 22 characters can be entered.

Memo

 When a receiver prints faxes, sender information 
entered here is printed on the top of the faxes.

11 Select [Enter] and then press .

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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12 When the setup menu screen is displayed, 

press  to complete the setup.

PBX Connecting
When connecting to PBX (internal exchange), put 
[PBX Line] to [ON].

1 Press the <SETTING> key.

2 Press the  to select [Admin Setup] 
and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [Fax Setup] and 
then press .

6 Press the  to select [Fax Setting] and 
then press .

7 Press the  to select [PBX Line] and 
then press .

8 Press the  to select [ON] and then 
press .

9 Press the  until the top screen appears.

Setting for Super G3

1 Press the <SETTING> key.

2 Press the  to select [Admin Setup] 
and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [User Install] and 
then press .

6 Press the  to select [Super G3] and 
then press .

7 Press the  to select [OFF] and then 
press .

8 Press the  until the top screen appears.

Specifying Reception Mode
The optimal reception mode differs depending on 
the environment for your machine. Refer to the 
following description.

 Fax Ready Mode

This mode is recommended when you use the 
machine as a fax machine.

 Tel/Fax Ready Mode

This mode is recommended when you connect an 
external phone to the machine.

 Ans/Fax Ready Mode

This mode is recommended when you connect an 
external answering machine to the machine.

 Tel Ready Mode

This mode is recommended when you generally 
use an external phone connected to the machine.

 DRD

This mode is recommended when you use the 
distinctive ring detection (DRD) function provided 
by a telephone company.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup] 
and press .

3 Enter the administrator password.
The factory default password is "aaaaaa".

4 Select [Enter] and press .

5 Press the  to select [User Install] and 
press .

6 Press the  to select [Reception Mode] 
and press .

7 Press the  to specify the reception 
mode and press .

8 Press the  until the fax start screen 
appears.

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
Settable Reception Mode:

Fax Ready Mode*     Tel/Fax Ready Mode
Ans/Fax Ready Mode    Tel Ready Mode     DRD

*indicates the factory default.

OK

OK

OK

OK

OK
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Connecting to a Computer
This section explains how to connect your machine to a computer and install a printer and fax driver. 

Connecting method
You can select either of the following connection methods:

 "Network Connection" P. 47

 "USB Connection" P. 60

Product Requirements
Your machine supports the following operating systems:

 Windows 8/Windows 8 (64bit Version)

 Windows Server 2012

 Windows 7/Windows 7 (64bit Version)

 Windows Vista/Windows Vista (64bit Version)

 Windows Server 2008 R2

 Windows Server 2008/Windows Server 2008 (x64 Version)

 Windows XP/Windows XP (x64 Version)

 Windows Server 2003/Windows Server 2003 (x64 Version)

 Mac OS X 10.4.0 to 10.8

Types of Drivers
The types of the drivers that can be installed are as follows.

 For Windows

 For Mac OS X

Note

 Depending on a version of a printer driver, Windows or Mac OS X, the description may be different.

Type Description

PCL The PCL printer driver is suitable for printing of business documents.

PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS 
data.

PCL XPS The PCL XPS printer driver is suitable for printing from an application for XPS.

* It does not support Windows Vista/Windows Server 2008/Windows XP/ Windows Server 2003.

FAX It is installed when directly sending faxes to destinations from the computer via the machine.

Type Description

PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS 
data.
It can be also used for normal printing.

PCL The PCL printer driver is suitable for printing of business documents.
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Network Connection

Perform the following procedure to connect your 
machine to a computer via network.

Connecting using wired LAN

Connecting an Ethernet Cable
Be sure to connect your machine to a network 
with an Ethernet cable before driver installation.

1 Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted 
pair, straight) and a hub separately.

2 Hold down the power switch for about a 
second to turn on the power and 
computer.
Reference

 "Turning Off Your Machine" P. 20

3 Plug one end of the Ethernet cable into 
the network interface connection on the 
back of the machine.

4 Plug the other end of the Ethernet cable 
into the hub.

Connecting using wireless LAN 
(MB451w, MB471w only)

Configuring automatically using 
push-button method

Use the WPS (push button) function to set the 
wireless LAN.

1 Log in as the administrator.

2 Press the  to select [Network Menu], 
and then press the . 

3 Press the  to select [Network Setup], 
and then press the .

4 Press the  to select [Wireless 
Setting], and then press the .

5 Press the  to select [Automatic setup 
(WPS)], and then press the .

6 Press the  to select [WPS-PBC], and 
then press .

7 Press the  to select [Yes], and then 
press .

2

OK

OK
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Memo

 Start the WPS push button for wireless AP after 
clicking [Yes] in the confirmation screen. 
Alternatively, if WPS push button for wireless AP is 
started first, start the WPS push button on this 
equipment. 

 If [No] is selected, the screen returns to that from 
step 6.

8 If [Yes] is selected in step 7, [Running 
pushbutton method...] is displayed in 
the screen.

Note

 Panel operations cannot be performed during WPS 
execution.

 When [Connection successful] is displayed, this 
equipment is connected to the wireless LAN.

Memo

 If [Timeout] is displayed, it is possible that the 
wireless AP of the connection destination could not be 
found within the time limit. Select [Yes] again in step 
7 within 2 minutes of starting WPS push button for 
wireless AP.

 If [Overlap] is displayed, WPS-push button is being 
executed on 2 or more wireless AP. Please wait for a 
short time and then retry.

Configuring automatically using  
PIN method

1 Log in as the administrator.

2 Press the  to select [Network Menu], 
and then press the .

3 Press the  to select [Network Setup], 
and then press the .

4 Press the  to select [Wireless 
Setting], and then press the .

5 Press the  to select [Automatic setup 
(WPS)], and then press the .

6 Press the  to select [WPS-PIN], and 
then press .

7 Press the  to select [Yes], and then 
press .

Memo

 If [Yes] is selected in step 7, [Implementing PIN 
method...] is displayed in the screen.

 If [No] is selected, the screen returns to that from 
step 6. Each time the confirmation screen is displayed, 
the PIN code is automatically generated and changed.

8 Enter the displayed 8 character PIN code 
to the wireless AP, and start WPS-PIN for 
the wireless AP.

Note

 Panel operations cannot be performed during WPS 
execution.

 When [WPS connection successful] is displayed, 
this equipment is connected to the wireless LAN.

 Alternatively, if WPS-PIN for wireless AP is started 
first, start the WPS-PIN on this equipment.

OK

OK
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Memo

 If [Timeout] is displayed, it is possible that the 
wireless AP of the connection destination could not be 
found within the time limit. After entering the PIN 
code from this equipment into the wireless AP and 
starting WPS-PIN, select [Yes] in step 7 again within 2 
minutes.

 Configuring wireless network selection

1 Log in as the administrator.

2 Press the  to select [Network Menu], 
and then press the .

3 Press the  to select [Network Setup], 
and then press the .

4 Press the  to select [Wireless 
Setting], and then press the .

5 Press the  to select [Wireless 
Network Selection], and then press 
the .

6 The product starts to search the wireless 
access point. 

7 A list of access points found by the 
search will be displayed. Select the 
access point you wish to connect to using 
the   keys, then press .

8 Enter the security password of the 
selected access point.

(1) With WEP

a) [Enter the WEP key] will be displayed. 
Enter the encryption key using the   

  keys, and press .

Go to Section 9

(2) With WPA-PSK or WPA2-PSK

a) [Enter the Pre-shared key] will be 
displayed. Enter the encryption key using 
the     keys, and press .

Go to Section 9

(3) With WPA-EAP or WPA2-EAP

a) Configure settings from Web Page.

(4) With Disable

a) The password input screen will not be 
displayed. Go to Section 9.

9 In the confirmation screen, please check 
the contents on the confirmation screen, 
select [Yes], and press .

OK

OK

OK

OK
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10 Connection successful will be displayed 
once you have successfully connected to 
the wireless LAN.

Memo

 If unable to connect to a wireless LAN, [Connection 
failed] will be displayed and you will be returned to 
the Wireless Settings screen in Section 5.

Configuring manually

1 Log in as the administrator.

2 Press the  to select [Network Menu], 
and then press the .

3 Press the  to select [Network Setup], 
and then press the .

4 Press the  to select [Wireless 
Setting], and then press the .

5 Press the  to select [Wireless 
Network Selection], and then press 
the .

6 The product starts to search the wireless 
access point.

7 A list of access points found by the 
search will be displayed. With the  key, 
select [Manual Setup], which will be 
displayed at the very bottom.

8 Press the  to select [SSID], and then 
press the .

Memo

 When the [OK] button is pressed, the screen switches 
to the security settings screen in step 5 without 
switching to the screen in step 6. If the SSID is not 
set, a warning screen is displayed.

9 Enter the SSID name (within 1-32 
characters) of the wireless AP that you 
want to connect to.
After entering the SSID, move the cursor 
to the [Done] field and press .

10 In the security settings screen, select the 
same security setting as the wireless AP 
that you want to connect to.

Memo

 The default is [Disable].

 Depending on the model of wireless AP, mixed WPA-
PSK/WPA2-PSK may be supported. In this case, we 
recommend using WPA2-PSK.

Note

 Security settings (WPA-EAP/WPA2-EAP) using an 
authentication server are also supported, but this can 
only be set from the Web. For details, see the 
Advanced section of the User Manual.

OK

OK
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11 Depending on the security setting 

selected in step 8, execute the settings 
from either (1) or (2) below. If [Disable] 
is selected, proceed to step 10. (For 
security reasons, we do not recommend 
setting [Disable].)

(1) When WEP is selected:

a) Press the  on the WEP KEY input screen.

Memo

 Nothing is set by default. If the WEP KEY is already 
set, it is displayed using "*" symbols. When the [OK] 
button is pressed, the screen switches to the screen in 
step 10 without switching to the screen in step b). If 
the right button is pressed to switch to the screen in 
step b) when a WEP KEY is set, the set KEY is cleared.

Note

 There is not setting for the WEP KEY index. The WEP 
KEY index communications with the wireless AP as 1.

b) Enter the same KEY as the WEP KEY set 
for the wireless AP that you want to 
connect to.
After entering the WEP KEY, move the 
cursor to the [Done] field and press .

Memo

 After entering the KEY, the key is displayed as "*" 
symbols for security reasons.

(2) When WPA-PSK or WPA2-PSK is 
selected:

a) Press the  to select the encryption type, 
and then press .

Memo

 The default is [TKIP].

 Depending on the model of wireless AP, the mixed 
TKIP/AES may be supported. In this case, we 
recommend using AES.

b) Press the  on the Pre-shared KEY input 
screen.

Memo

 Nothing is set by default. If a Pre-shared KEY is 
already set, "*" is displayed. When the [OK] button is 
pressed, the screen switches to that shown in step 10 
without switching to the screen shown in step c). If 
the right button is pressed to switch to step c) when a 
Pre-shared KEY is set, the set KEY is cleared.

c) Enter the same KEY as the Pre-shared KEY 
set for the wireless AP that you want to 
connect to. 
After entering the Pre-shared KEY, move 
the cursor to the [Done] field and 
press .

Memo

 After entering the KEY, the key is displayed as "*" 
symbols for security reasons.

12 In the confirmation screen, check the 
entered SSID and selected security 
settings. 
If there are no problems, press the  to 
select [Yes], and then press .

13 If [Yes] is selected in step 10, 
[Searching for connection...] is 
displayed in the screen.

When [Connection successful] is 
displayed, this equipment is connected to 
the wireless LAN.

OK

OK

OK

OK
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Memo

 If [Timeout] is displayed, the connection destination wireless 
AP may not have been found within the specified time. Check 
the SSID, security settings, and KEY settings, and retry.

Reconnect to the wireless LAN
When the wireless is enabled, restart the wireless 
function. If a problem has occurred in the wireless 
AP communication or performance, the wireless 
function can be restarted.

(If the wired is enabled, the wireless function is 
enabled with the configured wireless settings.)

1 Log in as the administrator.

2 Press the  to select [Network Menu], 
and then press the .

3 Press the  to select [Network Setup], 
and then press the .

4 Press the  to select [Wireless 
Setting], and then press the .

5 Press the  to select [Wireless 
Network Selection], and then press .

6 Press the  to select [Yes], and then 
press .

7 When [Yes] is selected in step 6, 
[Searching for connection...] is 
displayed in the screen.

After this, [Connection successful] is 
displayed, and the wireless LAN can be 
used on this equipment.

Memo

 If [A Timeout occurred.] is displayed, the connection 
destination wireless AP may not have been found within 
the required time. The SSID, security settings, and KEY 
need to be configured to match the wireless AP settings. 
Check each of the settings. For details on each of the 
setting items, see "Using the wireless LAN".

Switching from wireless to wired
The network connection can be switched from 
wireless to wired.

1 Log in as the administrator.

2 Press the  to select [Network Menu], 
and then press the .

3 Press the  to select [Network Setup], 
and then press the .

4 Press the  to select [Enabling Wired 
Communications], and then press .

5 Press the  to select [Yes], and then 
press .

OK

OK

OK

OK
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Install a Printer and Fax Driver
(for Windows)

To complete the network connection with a 
Windows computer, first set IP addresses for the 
machine, and then install a printer and fax driver 
on the computer.

If there is no DHCP server or BOOTP server on 
the network, you need to manually configure the 
IP address on the computer or machine.

Your network administrator or Internet service 
provider specifies a unique IP address for the 
computer and your machine. Set the IP 
addresses manually.

Note

 You need to complete the network setting of the computer 
before this procedure.

 To complete this procedure, you must be logged in as an 
administrator.

 When setting an IP address manually, ask the network 
administrator or your Internet service provider which IP 
address to use. If the IP address is set wrong, the network 
may go down or Internet access may be disabled.

Memo

 If configuring a small network consisting of only your 
machine and a computer, set IP addresses as shown below 
(according to RFC1918).

 To set [Network Scale], press the <SETTING> key and 
then select [Admin Setup] > [Network Menu] > 
[Network Setup] > [Network Scale].

 First, Set the IP address of the machine.

1 Hold down the power switch for about a 
second to turn on the power.

2 Press the <SETTING> key on the 
operator panel.

3 Press the  to select [Easy Setup], and 
press .

4 Enter the administrator password.
The factory default password is "aaaaaa".

5 Select [Complete], and press .

6 Press the  and [Network Setting], 
and then press the .

7 If setting the IP address manually, check 
that [Manual] is selected, and press .

If obtaining the IP address automatically, press 

the  and select [Auto], and press . Proceed 
to step 12.

8 Enter the IP address and press .
To move to the next box, press the .

9 Enter the subnet mask and press .
To move to the next box, press the .

10 Enter the default gateway address and 
press .
To move to the next box, press the .

11 Enter the DNS server and WINS server if 
needed.
If it is not necessary to connect the DNS server or 

WINS server to the network, press  until the 
pop-up message showing the setting completion is 
displayed.

12 When the setup menu screen is 
displayed, press  to complete the 
setup.

For the computer
IP address : 192.168.0.1~254
Subnet mask : 255.255.255.0
Default gateway : not used
DNS server : not used
For the machine
IP address Set : Manual
IP address: 192.168.0.1~254 (select a dif-

ferent value from the com-
puter)

Subnet Mask : 255.255.255.0
Default Gateway : 0.0.0.0
Network Scale : Small

OK

OK

OK

OK

OK

OK

OK

OK
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 Next, install the printer and fax driver into the 
computer.

Note

 To complete this procedure, you must be logged in as an 
administrator.

1 Ensure that your machine and the 
computer are turned on and connected, 
and then insert the "Software DVD-ROM" 
into the computer.

2 Click [Run Setup.exe] after [AutoPlay] 
is displayed.
If the [User Account Control] dialog box 
appears, click [Yes].

3 Select the language and then click [Next].

4 Select the device of your machine, and 
then click [Next].

5 Read the license agreement and then 
click [I Agree].

6 Read the "Environmental advice for Users" 
and click [Next].

7 Select the checkbox for the printer driver 
and fax driver you wish to install, and click 
the Install bunch button.

Memo

 By factory default, [PCL driver], [Scanner driver], 
and [ActKey] are selected.

 All drivers and software packages are installed by the 
collective installation if their boxes are checked. If you 
wish to install drivers and software separately, click 
the Install button on their right and follow the on-
screen instructions.

8 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].

9 Click the [Network] button.
The device search starts.

- If the machine is detected, it is automatically 
installed. Proceed to step 11.

- If the machine is not detected, the 
[Review your installation settings.] 
screen is displayed. Proceed to step 10.

10 click [Restart search] to restart the 
device search.

After the machine is displayed, select the machine 
and click [Next].
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Memo

 If the machine is not displayed by clicking [Restart 
search], select [Printer name/IP Address] and 
enter the IP address assigned to your machine, and 
then click [Next].

11 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].

12 Click the [Exit] button.

13 Remove the "Software DVD-ROM" from 
the computer.
The installation is complete.

 Print a test page to check that the printer 
driver is successfully installed on the 
computer.

1 Click [Start] > [Devices and Printers].

2 Right-click the OKI MB491 icon and 
select [Printer properties] (> a desired 
printer driver if you have installed 
multiple drivers) from the pop-up menu.

3 On the [General] tab, click [Print Test 
Page].

Installing a Printer Driver
(For Mac OS X)

To complete the network connection with a Mac 
operating system, install a printer driver on the 
computer and set your machine as a network 
printer.

Select the protocol for your network connection 
from the following:

 EtherTalk

 Bonjour

Note

 EtherTalk is not supported in Mac OS X 10.6 or later.

 Disable the anti-virus software before starting this 
procedure.

 EtherTalk is not supported in Mac  PCL.

Using EtherTalk (For Mac OS X 
10.5)

When connecting to the network with EtherTalk, 
it is necessary to enable EtherTalk in the 
machine. Then, install the driver in the computer.

 First, enable EtherTalk in the machine.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 47

2 Press the <SETTING> key on the 
operator panel.

3 Press the  to select [Admin Setup], 
and press .

4 Enter the administrator password.
The factory default password is "aaaaaa".

5 Select [Complete], and press .

6 Press the  to select [Network Menu], 
and press .

7 Press the  to select [Network Setup], 
and press .

8 Press the  to select [EtherTalk], and 
press .

9 Press the  to select [Enable], and 
press .

10 Press the  until the top screen is 
displayed.

OK

OK

OK

OK

OK

OK
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 Next, install the driver in the computer.

1 Insert the "Software DVD-ROM" into the 
computer.

2 Double-click the [OKI] icon on the 
desktop.

3 Double-click [Driver] > [Printer] > 
[Installer for OS X 10.5-10.8].

4 Enter the administrator password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

5 From the Apple menu, select [System 
Preferences].

6 Click [Print & Fax].

7 Click [+].

8 Click [AppleTalk].

9 Select the name of your machine and 
then check that [OKI MB491(PS)] is 
displayed in [Print Using].

10 Click [Add].

11 Check that your machine is displayed in 
[Printers] and [OKI MB491(PS)] is 
displayed in [Kind].

Note

 If [OKI MB491(PS)] is not correctly displayed in 
[Kind], click [-] to remove your machine from [Print 
& Fax] and then redo the procedure from steps 7 to 
10.

12 Close [Print & Fax].

13 Remove "Software DVD-ROM" from the 
computer.
The installation is complete.
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Using EtherTalk

(For Mac OS X 10.4.0 to 10.4.11)
When connecting to the network with EtherTalk, 
it is necessary to enable EtherTalk in the 
machine. Then, install the driver in the computer.

Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

 First, enable EtherTalk in the machine.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 47

2 Press the <SETTING> key on the 
operator panel.

3 Press the  to select [Admin Setup], 
and press .

4 Enter the administrator password.
The factory default password is "aaaaaa".

5 Select [Complete], and press .

6 Press the  to select [Network Menu], 
and press .

7 Press the  to select [Network Setup], 
and press .

8 Press the  to select [EtherTalk], and 
press .

9 Press the  to select [Enable], and 
press .

10 Press the  until the top screen is 
displayed.

 Next, install the driver in the computer.

1 From the Apple menu, select [System 
Preferences].

2 Select [Network].

3 Select [Network Port Configurations] 
from [Show], and then check that 
[Built-in Ethernet] is selected.

4 Select [Built-in Ethernet] from [Show] 
and select the [AppleTalk] tab, and 
then check that [Make AppleTalk 
Active] is selected.

5 Close [Network].

6 Insert "Software DVD-ROM" in the 
computer.

7 Double-click the [OKI] icon on the 
desktop.

8 Double-click [Driver] folder > [PS] Or 
[PCL] folder > [Installer for OS X 10.4].

9 Enter the administrator password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

10 From the [Go] menu, select [Utilities] 
and then double-click [Printer Setup 
Utility].
Note

 If [Printer Setup Utility] is already running, close it 
and open it again.

OK

OK

OK

OK

OK

OK
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11 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

12 Select the name of your machine whose 
[Connection] is [AppleTalk], and then 
check that [OKI MB491(PS)] is 
displayed in [Print Using].

13 Click [Add].

14 Check that the name of your machine is 
displayed in [Printer List], and then 
close the window.

15 From the [Go] menu, select 
[Applications] and then double-click 
[TextEdit].

16 Select the [File] menu > [Page Setup].

17 Select the name of your machine from 
[Format for].

18 Check that the [OKI MB491(PS)] is 
displayed correctly under [Format for].

19 Click [OK].

20 Remove "Software DVD-ROM" from the 
computer.
The installation is complete.

Using Bonjour
(For Mac OS X 10.5 to 10.8)

Then, install the driver in the computer and set 
the machine as a network printer.

Install the driver in the computer.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 47

2 Insert "Software DVD-ROM" into the 
computer.

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > [PS] or  
[PCL] folder > [Installer for OS X 
10.5-10.8].

5 Enter the administrator password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

6 From the Apple menu, select [System 
Preferences].

7 Click [Print & Scan] (For Mac OS X 10.5 
and 10.6:[Print & Fax]).

8 Click [+].
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9 Click [Default].

10 Select the name of your machine whose 
[Kind] is [Bonjour], and then check 
that [OKI MB491(PS)] or [OKI 
MB491(PCL)] is displayed in [Print 
Using].
The name of your machine is displayed with the 
format of "OKI-MB491- (the last six digits of the 
MAC address)".

11 Click [Add].

12 If the [Installable Options] window is 
displayed, click [Continue].
If you have installed the optional second tray unit 
before the driver installation, configure each item 
and then click [Continue].

13 Check that your machine is displayed in 
[Printers] and [OKI MB491(PS)] or 
[OKI MB491(PCL)] is displayed in 
[Kind].

Note

 If [OKI MB491(PS)] or [OKI MB491(PCL)] is not 
correctly displayed in [Kind], click [-] to remove your 
machine from [Print & Fax] and then Redo the 
procedure from step 8 to 12.

14 Close [Print & Scan] (For Mac OS X 
10.5 and 10.6:[Print & Fax]).

15 Remove "Software DVD-ROM" from the 
computer.
The installation is complete.

Using Bonjour (for Mac OS X 10.4.0 
to 10.4.11)

Install the driver in the computer and set the 
machine as a network printer.

Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

Install the driver in the computer.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting an Ethernet Cable" P. 47

2 From the Apple menu, select [System 
Preferences].

3 Select [Network].

4 Select [Network Port Configurations] 
from [Show], and then check that 
[Built-in Ethernet] is selected.

5 Close [Network].

6 Insert "Software DVD-ROM" into the 
computer.

7 Double-click the [OKI] icon on the 
desktop.
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8 Double-click [Driver] folder > [PS] or 
[PCL] folder [Installer for OS X 10.4].

9 Enter the administrator password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

10 From the [Go] menu, select [Utilities] 
and then double-click [Printer Setup 
Utility].
Note

 If [Printer Setup Utility] is already running, close it 
and open it again.

11 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

12 Select the name of your machine whose 
[Connection] is [Bonjour], and then 
check that [OKI MB491(PS)] or [OKI 
MB491(PCL)] is displayed in [Print 
Using].
The name of your machine is displayed with the 
format of "OKI-MB491- (the last six digits of the 
MAC address)".

13 Click [Add].

14 If the [Installable Options] window is 
displayed, click [Continue].
If you have installed the optional second tray unit 
before the driver installation, configure each item 
and then click [Continue].

15 Check that the name of your machine is 
displayed in [Printer List], and then 
close the window.

16 From the [Go] menu, select 
[Applications] > [TextEdit].

17 Select the [File] menu > [Page setup].

18 Select the name of your machine from 
[Format for].

19 Check that [OKI MB491(PS)] or [OKI 
MB491(PCL)] is displayed correctly 
under [Format for].

20 Click [OK].

21 Remove "Software DVD-ROM" from the 
computer.
The installation is complete.

USB Connection
Perform the following procedure to connect your 
machine to a computer via USB.

Connecting a USB Cable

1 Prepare a USB cable.
A USB cable is not supplied with your machine. 
Prepare an USB 2.0 cable separately.

Memo

 Use a USB 2.0 Hi-Speed cable for a USB 2.0 Hi-Speed 
connection.
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2 Hold down the power switch for about a 

second to turn on the power and the 
computer.
Reference

 "Turning Off Your Machine" P. 20

3 Plug one end of the USB cable into the 
USB interface connector on the back of 
the machine.

4 Plug the other end of the USB cable into 
the computer's USB interface connector.

Note

 For Windows OSs, do not plug the other end of the 
USB cable into the computer until prompted during 
driver installation.

Note

 Do not plug the USB cable into the network interface 
connection. Doing so may damage your machine.

Installing a Printer and Fax Driver 
(For Windows)

Note

 You must be logged in as an administrator to complete this 
procedure.

1 Ensure that your machine is turned off 
and the USB cable is unplugged from the 
computer.

2 Turn on the computer.

3 Insert "Software DVD-ROM" into the 
computer.

4 Click [Run setup.exe] after [Auto 
Play] is displayed.
If the [User Account Control] dialog box 
appears, click [Yes]. 

5 Select the language and then click 
[Next].

6 Select the device of your machine, and 
then click [Next].

7 Read the license agreement and then 
click [I Agree].

8 Read the "Environmental advice for 
Users" and click [Next].

2



Connecting to a Computer

- 62 -

9 Select the checkbox of the printer driver, 
fax driver or both you want to install, and 
click the Install bunch button.
Memo

 By factory default, [PCL driver], [Scanner driver], 
and [ActKey] are selected.

 All of drivers and software packages are installed by 
the collective installation if their boxes are checked. If 
you wish to install drivers and software separately, 
click the Install button at the right to them and follow 
the on-screen instructions.

10 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].

11 When the instruction prompting to 
connect the machine to the computer 
and turn on the machine appears, plug 
the other end of the USB cable into the 
computer’s USB interface connector and 
turn on your machine.

Note

 Do not plug the USB cable into the network interface 
connection. Doing so may cause a malfunction.

12 Click the [Exit] button.

13 Remove "Software DVD-ROM" from the 
computer.
The installation is complete.

 Print a test page to check that the printer 
driver is successfully installed on the 
computer.

1 Click [Start] > [Devices and Printers].

2 Right-click the OKI MB491 icon and 
select [Printer properties] (> a desired 
printer driver if you have installed 
multiple drivers) from the pop-up menu.

3 On the [General] tab, click [Print Test 
Page].

Installing a Printer Driver
(For Mac OS X)

Note

 Disable the anti-virus software before starting this 
procedure.

 For Mac OS X 10.5 to 10.8

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting a USB Cable" P. 60

2 Insert "Software DVD-ROM" into the 
computer.

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > [PS] or [PCL] 
folder [Installer for OS X 10.5-10.8].

5 Enter the administrator password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

6 From the Apple menu, select [System 
Preferences].

7 Click [Print & Scan] (Mac OS X 10.5 and 
10.6:[Print & Fax]).
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8 Click [+].

Note

 If the machine is already shown in [Printers], select 
your machine, and click on [-] to delete. After this, 
click [+].

9 Select the name of your machine whose 
[Connection] is [USB], and then check 
that [OKI MB491(PS)] or [OKI 
MB491(PCL)] is displayed in [Print 
Using].

10 Click [Add].

11 Check that the name of your machine is 
displayed in [Printers] and [OKI 
MB491(PS)] or [OKI MB491(PCL)] is 
displayed.

Note

 If [OKI MB491(PS)] or [OKI MB491(PCL)] is not 
correctly displayed, click [-] to remove your machine 
from [Printers] and then redo the procedure from 
steps 8 to 10.

12 Close [Print & Scan](Mac OS X 10.5 
and 10.6:[Print & Fax]).

13 Remove "Software DVD-ROM" from the 
computer.
The installation is complete. 

 For Mac OS X 10.4.0 to 10.4.11
Memo

 The procedure below uses Mac OS X 10.4.11 as an 
example. Depending on your OS, the description may be 
different.

1 Ensure that your machine and the 
computer are turned on and connected.

Reference

 "Connecting a USB Cable" P. 60

2 Insert "Software DVD-ROM".

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > [PS] or 
[PCL] folder > [Installer for OS X 10.4].

5 Enter the administrator password, and 
then click [OK].
Follow the instructions displayed on the screen to 
complete the installation.

6 From the [Go] menu, select [Utilities], 
and then double-click [Printer Setup 
Utility].
Note

 If [Printer Setup Utility] is already running, close it 
and open it again.

7 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

Note

 If the name of your machine whose [connection] is 
[USB] is already displayed, select it and click 
[Delete], and then click [Add].
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8 Select the name of your machine whose 
[Connection] is [USB], and then check 
that [OKI MB491(PS)] or [OKI 
MB491(PCL)] is displayed in [Print 
Using].

9 Click [Add].

10 Check that the name of your machine is 
displayed in [Printer List], and then 
close the window.

11 Remove "Software DVD-ROM" from the 
computer.
The installation is complete.
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Configuring the Network Settings
This section describes the setup required for using Scan To E-mail, Scan To Network PC, Scan To Fax 
Server, Internet Fax functions.
The above functions enable you to send scanned data to a computer via the network connection. To use 
them, you need to set up your machine and the computer to which you want to send scanned data.
First check the settings of the computer and fill in the information in the [User Value] column of the Setup 
Information Form below. Then, configure your machine and the computer using the information in [User Value].

Reference

 Be sure to configure the network connection before performing the procedures below. For the network connection, refer to 
"Network Connection" P. 47.

Setup Information Form

No. Item Outline Introduction Example

User Value
*You can look at the following 

page and write memos here 
on the details you have 
checked or the settings you 
have configured.

Common Setup Information
A-1 Administrator pass-

word for your machine
The password you use to change the 
machine's system settings

aaaaaa

A-2 IP address of your 
machine

The IP address allocated to your machine 192.168.0.2

A-3 DNS server address DNS server address 192.168.0.1

Setup Information Required for Scan To E-mail, Scan To Fax Server and Internet Fax
B-1 E-mail address for 

your machine
The e-mail address used when sending e-
mails from the machine

mb491@test.
com

(Up to 80 characters)

B-2 SMTP server address The address of the server used when 
sending e-mails 

smtp.test.com

B-3 POP3 server address The address of the server used when 
receiving e-mails

pop3.test.com

B-4 Authentication 
method

Sending mail server authentication SMTP

B-5 SMTP user ID Sending mail server account name OKIMB491

B-6 SMTP password Sending mail server password okimb491

B-7 POP user ID Receiving mail server account name user

B-8 POP password Receiving mail server password okimb491

B-9 Name of the e-mail 
destination

The name of the recipient to whom you 
are sending a scan-to-mail/Internet fax 
from the machine

User

B-10 E-mail address of the 
e-mail destination

The e-mail address of the recipient to 
whom you are sending a scan-to-mail/
Internet fax from the machine

user@test.com

Setup Information Required for Scan To Network PC
C-1 Name of the destina-

tion computer
The name of the computer to which you 
are forwarding scanned data

PC1

C-2 User name to log into 
the destination com-
puter

User name to log in to the computer to 
which you are forwarding scanned data

mb491 (Up to 32 characters)

C-3 Password to log into 
the destination com-
puter

Password to log in to the computer to 
which you are forwarding scanned data

mb491 (Up to 32 characters)

C-4 Profile name to regis-
ter the settings

Name when registering the machine 
settings

Sales (Up to 16 characters)

C-5 Shared folder name 
on the destination 
computer

Folder name of the computer to which 
you are forwarding scanned data

SalesDev (Up to 64 characters)

C-6 File name of the 
scanned data

Scanned data folder name ScanData (Up to 64 characters)
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Checking the Common Setup 
Information

Check the common setup information for Scan To 
E-mail, Scan To Network PC, Scan To Fax Server 
and Internet Fax, and fill in the corresponding 
columns of the Setup Information Form.

Administrator Password for Your 
Machine

Enter the administrator password of your 
machine in A-1 of the Setup Information Form.
If you are not the administrator of the machine, 
ask the administrator the password.

Memo

 Passwords are case-sensitive.

 The administrator password is set to "aaaaaa" as the 
factory default setting.

Gateway address/DNS server

1 Press the <SETTING> key on the 
operator panel.

2 Check that [Reports] is selected and 
press .

3 Check that [Configuration] is selected 
and press .

4 On the confirmation screen press  or , 
select [Yes], and press .

5 Enter the address written on the gateway 
address line at the bottom right of page 
3 of the printed configuration into A-2 on 
the setting information sheet.

6 Enter the address written on the DNS 
server (primary) line on the bottom right 
of the same page into A-3.

Note

 It is necessary that the gateway address be configured 
beforehand. Also, if using an Internet service provider, it is 
necessary that the DNS server be configured. If it has not 
been configured (0.0.0.0), follow the procedure on 
55 page to configure it.

Setting Up Scan To E-mail and 
Internet Fax

The Scan To E-mail, Scan To Fax Server and 
Internet Fax functions enable you to send 
scanned images as an attached file of an e-mail 
to the specified e-mail address on the network. 
To use these functions, set up the e-mail setting 
for your machine.
When using Auto Delivery or Transmission Data 
Save function (MB491/MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb only), the following 
setup is required.

Checking the E-mail Settings of the 
Computer

Note

 If a network administrator specifies the values such as a 
mail server account, password and e-mail address for your 
machine, enter them in the Setup Information Form.

Memo

 The procedure below uses Windows Live Mail on Windows 
7. If you are using different mail software, refer to the 
manual for the e-mail software.

1 Click [Start] and select [Windows Live 
Mail].

2 Select the [Tools] menu > [Accounts].
If the menu bar is not displayed, click the 
[Menus] icon and then select [Show menu bar].

3 Select the mail account and then click 
[Properties].

OK

OK

OK
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4 On the [General] tab, enter the contents 

of [Name] and [E-mail address] in B-9 
and B-10 of the Setup Information Form.

5 Click the [Servers] tab, and then note 
each setting in the corresponding 
columns of the Setup Information Form.

- If there is a check in the [My server requires 
authentication] checkbox, enter "SMTP" into B-4 
and follow procedure 6.

- If there is no check in the [My server requires 
authentication] checkbox, enter [POP or not 
yet authenticated] in B-4. At this point the 
confirmation of e-mail settings is complete.

Note

 If using an Internet service provider, enter [POP].

6 Click [Settings].

7 Check the login information on the 
[Outgoing Mail Server] dialog.

- If [Use same settings as my incoming mail 
server] is selected, enter the same values as B-7 
and B-8 on B-5 and B-6.

- If [Log on using] is selected, note the content of 
[Accountname] and [Password] in B-5 and B- 
6, respectively.

Setting the E-mail Address for Your 
Machine

When sending data scanned from the machine by 
e-mail, the e-mail address for the machine is 
necessary.According to the following procedure, 
set the e-mail address of the machine and enter 
an e-mail address to be used by your machine in 
B-1 of the Setup Information Form.
 If the e-mail address for your machine is specified 

by the network administrator, enter the e-mail 
address in B-1.

 If you are using an Internet service provider, obtain 
an e-mail address for your machine from the 
provider and then enter the e-mail address in B-1.

 If the e-mail address for your machine is neither 
specified nor obtained, determine the e-mail 
address according to the value you entered in B-4 
(authentication method):

- If B-4 is "SMTP", determine an e-mail address and 
enter it in B-1.

- B-4 is "POP", enter the same e-mail address as B-
10 in B-1.

Note

 If you want your machine to receive e-mail, you must 
obtain an e-mail address for your machine from a network 
administrator or your Internet service provider.

Configuring Your Machine for Scan To 
E-mail, Scan To Fax Server and Internet Fax

Set up your machine for Scan To E-mail and 
Internet Fax using the information in the Setup 
Information Form.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Easy Setup] and 
press .

3 Enter the administrator password (A-1).

4 Select [Enter] and then press .

5 Press the  to select [E-mail Setting] 
and then press the .

6 Press the  and then enter the 
information in B-2.

B-9

B-10

B-3
B-2

B-7
B-8

OK

OK
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7 Select [Enter] and then press .

8 Press the  and then enter the 
information in B-1.

9 Select [Enter] and then press .

10 Press the  and then select a protocol 
for receiving e-mail for the machine, and 
then press .

- If you want your machine to receive e-mail from 
the POP3 server, select [POP3]. Proceed to step 
11.

- If you want your machine to receive e-mail 
without using a mail server, select [SMTP]. 
Proceed to step 13.

- If you do not want your machine to receive e-mail, 
select [Disable]. Proceed to step 13.

11 Press the  and then enter the 
information in B-3.

12 Select [Enter] and then press . 

13 Press the  and then select an 
authentication method based on the 
information in B-4. Then, press .

- If B-4 is "Do not authenticate", select [Do not 
authenticate]. Proceed to step 24.

- If B-4 is "SMTP", select [SMTP Auth]. Proceed to 
step 14.

- If B-4 is "POP", select [POP Before SMTP]. 
Proceed to step 18.

14 Press the  and then enter the 
information in B-5. 

15 Select [Enter] and then press .

16 Press the  and then enter the 
information in B-6.

17 Select [Enter] and then press .
Proceed to step 24.

18 Press the  and then enter the 
information in B-3.

19 Select [Enter] and then press .

20 Press the  and then enter the 
information in B-7.

21 Select [Enter] and then press .

22 Press the  and then enter the 
information in B-8.

23 Select [Enter] and then press .

24 When the setup menu screen is 
displayed, press .

The setup for Scan To E-mail, Scan To Fax Server 
and Internet Fax is complete.

Reference

 For details on how to use Scan To E-mail, refer to "Scan to 
E-mail" P. 109.

 For details on how to use Scan To Fax Server, refer to  
"Basic Procedure for Scan To Fax Server" P. 98.

 For details on how to use Internet Fax, refer to "Basic 
Procedure for Internet Faxing" P. 100.

Setting Up Scan To Network 
PC

The Scan To Network PC function enables you to 
send and save scanned images to the "shared 
folder" of a computer on the network. To use this 
function, register your machine on the computer 
as a user and create a shared folder, and then 
create a profile on your machine to register the 
settings for the computer.

Note

 Before starting the setup, get permission from the network 
administrator to create a shared folder on the computer by 
following the procedure below.

Memo

 The CIFS protocol is used in this procedure.

Checking the Name of the Computer

Check the name of the computer following the 
procedure below, and fill in C-1 of the Setup 
Information Form.

 For Windows 7, Windows Server 
2008 R2, Windows Server 2008 
and Vista

1 Click [Start] and select [Control 
Panel].

2 Select [System and Security].
For Windows Server 2008 and Windows Vista, 
select [System and Maintenance].

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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3 Select [See the name of this 

computer] under [System].

4 Enter the name in [Computer name] in 
C-1 of the Setup Information Form.

5 Close the window.

 For Windows Server 2003 and 
Windows XP

1 click [start] > [Control Panel] >
[Performance and Maintenance] >
[System].
For Windows Server 2003, click [Start] > 
[Operator panel] > [System].

2 Select the [Computer Name] tab and 
then click [Change].

3 Enter the name in [Computer Name] in 
C-1 of the Setup Information Form.

4 Click [Cancel] to close the window.

 For Mac OS X

1 From the Apple menu, select [System 
Preferences].

2 Click [Sharing].

3 Enter the name in [Computer Name] in 
C-1 of the Setup Information Form.

Memo

 If the computer name is over 16 characters, for Mac OS X 
10.4.11 enter the first 15 characters in C-1. For Mac OS X 
10.5-10.6, select the network service you are using from 
[System Environment Settings] > [Network], and 
enter the NetBios field name into C-1 within WINS in 
Detailed Settings.

4 Close [Sharing].

Determining the Names of the Items 
Required for Scan To Network PC

Determine the names of the following items and 
fill in C-2 to C-6 on the Setup Information Form.

 User name to log into the destination computer (C-2)

Note

 If the username is managed on the domain, enter 
"Username@Domainname" in C-2. To check the 
domain name, click on [Change] within the 
[Computer Name] tab in the [System Properties] 
dialogue box.

 Password to log into the destination computer (C-3)

 Profile name to register the settings on your 
machine (C-4)

 Shared folder name on the destination computer 
(C-5)

 File name of the scanned data (C-6)

Configuring the Computer for Scan 
To Network PC

With the setup information form, create an 
account and shared folder for the machine in the 
computer.

Memo

 If the computer is in a domain, the procedure for adding a 
user account may be different to the procedure below. 
Refer to the Microsoft Windows manual.

 For Windows 7, Windows Server 
2008 R2, Windows 2008 and Win-
dows Vista

1 Click [Start] > [Control Panel].

2 Select [Add or remove user 
accounts].

3 Select [Create a new account].

C-1

C-1
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4 Enter the information in C-2 in the text 
box.

5 Ensure that [Standard user] is 
selected, and then click [Create 
Account].

6 Click the icon of the user account created 
in step 5.

7 Select [Create a password].

8 Enter the information in C-3 in [New 
password] and [Confirm new 
password], and then click [Create 
password].

9 Close the operator panel.

10 Create a new folder on the computer 
with the name entered in C-5.

Memo

 It is recommended to create a folder in the local drive 
(C drive or D drive), not on the desktop, [My 
Documents], or network drive.

11 Right-click the folder created in step 10 
and select [Properties].

12 Select the [Sharing] tab and then click 
[Share].

13 Select the user account created in step 5 
from the drop down box, and then click 
[Add].

14 Check that the user added in step 13 is 
displayed and then click [Share].

After the [Network discovery and file sharing] 
dialog box is displayed, click [No, make the 
network that I am connected to a private 
network].

15 Click [Done].

16 Click [Advanced Sharing] on the 
[Sharing] tab.

17 Click [Permissions].

For Windows Vista/Windows Server 2008, proceed 
to step 20.
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18 Click [Add].

19 Enter the value in C-2 in the entry field 
and then click [OK].

20 Select the user added in step 13 and 
select the [Allow] check box for [Full 
Control], and then click [OK].

21 click [OK].

22 Click [Close].
Proceed to "Creating a Profile for Scan To Network 
PC" P. 76.

 For Windows XP

1 Click [start] > [Control Panel].

2 Double-click [User Accounts].

3 Select [Create a new account].

4 Enter the value of C-2 in the text box and 
click [Next].

5 Select [Limited] and click [Create 
Account].

6 Click the icon of the user account created 
in step 5.

7 Select [Create a password].

8 Enter the value of C-3 in [Type a new 
password] and [Type the new 
password again to confirm], and then 
click [Create Password].

9 Close the operator panel.

10 Create a new folder on the computer 
with the name entered in C-5.

Memo

 It is recommended to create a folder in the local drive 
(C drive or D drive), not on the desktop, [My 
Documents], or network drive.

11 Right-click the folder created in step 10, 
and then select [Sharing and 
Security].
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12 Click [If you understand the security 
risks but want to share files without 
running the wizard, click here.].

If the screen below appears, select [Share this 
folder] and click [Permissions]. Proceed to step 
15.

13 Select [Just enable file sharing] in 
Windows Firewall, and then click [OK].

14 Select the [Share this folder on the 
network] and [Allow network users 
to change my files] check box, and 
then click [OK].

Proceed to "Creating a Profile for Scan To Network 
PC" P. 76

15 Click [Add].

16 Enter the value in C-2 in the entry field 
and click [OK].

17 Select the [Allow] check box for [Full 
Control], and then click [OK].

Proceed to "Creating a Profile for Scan To Network 
PC" P. 76
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 For Windows Server 2003

Memo

 The items here may differ depending on the edition you 
are using.

1 Click [Start] > [Administrative Tools] > 
[Computer Management].

2 In the right window, double-click 
[System Tools] > [Local Users and 
Groups], and then Right-click [Users] 
and select [New User].

3 Enter the value of C-2 in [User name] 
and the value of C-3 in [Password] and 
[Confirm password].

4 Select [User cannot change 
password] and [Password never 
expires], and then click [Create].

Memo

 If [User must change password at next logon] is 
selected, clear it so that you can select [User can not 
change password] and [Password never expires].

5 Click [Close].

6 Double-click [User] and check that the 
user created in step 4 is displayed.

7 Close the window.

8 Create a new folder on the computer 
with the name entered in C-5.

Memo

 It is recommended to create a folder in the local drive 
(C drive or D drive), not on the desktop, [My 
Documents], or network drive.

9 Right-click the folder created in step 8 
and then select [Sharing].

10 Select [Share this folder] and then 
click [Permissions].

11 Click [Add].

12 Enter the value in C-2 in the entry field 
and click [OK]. 

Proceed to step 15.

13 Select the [Allow] check box for [Full 
Control], and then click [OK].

14 Ensure that the icon of the shared folder 
created in step 8 changes into the icon 
with a hand, and then close the window.
"Creating a Profile for Scan To Network PC" P. 76
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 For Mac OS X 10.5 to 10.7

1 From the Apple menu, select [System 
Preferences].

2 Click [Users & Groups] (for Mac OS X 
10.5 and 10.6: [Accounts]).

3 Click [Click the lock to make 
changes.] at the bottom left of the 
screen and enter the administrator 
password. Then, click [Unlock] (for Mac 
OS X 10.5 and 10.6: [OK]).

4 Click [+].

5 Select [Standard] from [New 
Account].

6 Enter the value of C-2 in [Name].
For Mac OS X 10.5, enter the value of C-2 in 
[Name].

7 Enter the value in C-3 in both 
[Password] and [Verify].

8 Click [Create User] (for Mac OS X 10.5 
and 10.6: [Create Account]).

Memo

 After the dialog box for auto login appears, disable the 
auto login.

9 Check that an account is added to 
[Other Users] (for Mac OS X 10.5 and 
10.6: [Other Accounts]) with the name 
of C-2, and close [Users & Groups] (for 
Mac OS X 10.5 and 10.6: [Accounts]) .

10 Create a new folder on the computer 
with the name entered in C-5.

11 From the Apple menu, select [System 
Preferences].

12 Click [Sharing].

13 Check the check box of [File Sharing].

14 Click [+] under [Shared Folder].

15 Select the folder created in step 10 and 
click [Add].

16 Select the folder added in step 15 and 
click [+] under [Users].
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17 Select the account created in step 8 and 

click [Select].

18 Click the triangle button at the right side 
of the user added in step 17 and select 
[Read & Write].

19 Click [Options].

20 Check the checkbox of [Share files and 
folders using SMB (Windows)].
For Mac OS X 10.5, check the checkbox of [Share 
files and folders using SMB].

21 Check the checkbox of the account 
added in step 16.

22 Enter the value of C-3 in [Password] 
and click [OK].

23 Click [Done].

24 Close [Sharing].
Proceed to "Creating a Profile for Scan To Network 
PC" P. 76

 For Mac OS X 10.4.0 to 10.4.11
Memo

 The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

1 From the Apple menu, select [System 
Preferences].

2 Click [Accounts].

3 Click [Click the lock to make 
changes.] at the bottom left of the 
screen and enter the administrator 
password. Then, click [OK].

4 Click [+].

5 Enter the value of C-2 in [Name].

6 Enter the value in C-3 in both 
[Password] and [Verify].

7 Click [Create Account].
Memo

 After the dialog box for auto login appears, disable the 
auto login.
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8 Check that an account is added to 
[Other Accounts] with the name of C-2, 
and close [Accounts].

9 Create a new folder on the computer 
with the name entered in C-5.

10 From the Apple menu, select [System 
Preferences].

11 Click [Sharing].

12 Check the checkbox of [Windows 
Sharing].

13 Click [Enable Accounts...].

14 Check the checkbox of the account 
created in step 7.

15 Enter the value in C-3 in [Password] 
and click [OK].

16 Click [Done].

17 Close [Sharing].
Proceed to "Creating a Profile for Scan To Network 
PC".

Creating a Profile for Scan To 
Network PC

Register the information on the Information form 
on the computer as a profile. It is necessary to 
specify the profile to send data when you 
perform Scan To Network PC with the computer.

1 Press the  the <SETTING> key on the 
operator panel.

2 Press the  to select [Profile] and then 
press .

3 Press the  to select the profile number 
you want to register and then press .

4 Press the  to select [Register] and 
then press .

5 Press to select [Profile Name] and then 
press the .

6 Enter the information in C-4.

7 Select [Enter] and then press .

8 Press the  to select [Target URL] and 
then press .

9 Enter the value of C-1 and C-5 as "\\C- 
1\C-5".

Note

 If there is no DNS server on the network, you cannot 
specify the computer by using the computer name 
(C-1). In such a case, you can configure the settings 
by using the computer's IP address.

Memo

 In order to enter the "\" sign while using a QWERTY 
keyboard, press <CTRL> and then press <\>.

10 Select [Enter] and then press .

11 Press the  to select [User Name] and 
then press .

Example: \\PC1\SalesDev

Example: \\192.168.0.3\SalesDev

OK

OK

OK

OK

OK

OK
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12 Enter the information in C-2.

Note

 If domain management is performed, enter 
"C-2@domain name".

 When carrying out domain management, if you cannot 
connect even after entering "C-2@Domainname", 
delete "@Domainname". 
Access the machine's website again, and set the 
NetBIOS domain name in [Workgroup name] within 
[Admin Setup] > [Network Menu] > [NBT/
NetBEUI].
*For the domain name, please check with the network 
manager.

13 Select [Enter] and then press .

14 Press the  to select [Password] and 
then press .

15 Enter the value of C-3.

16 Select [Enter] and then press .

17 Press the  to select [File Name] and 
then press .

18 Enter the information in C-6.
- By adding "#n" to the end of the file name, a 

serial number is automatically assigned to the end 
of the name of sent files.

- By adding "#d" to the end of the file name, a date 
is automatically assigned to the end of the name 
of sent files.

19 Select [Enter] and then press .

20 Configure other items if necessary.

21 Press  to register the settings.

The setup for Scan To Network PC is complete.

Reference

 For details how to use Scan To Network PC, refer to "Scan 
to Network PC" P. 111.

Managing Profiles
To perform the Scan To Network PC, Auto 
Delivery or Transmission Data Save function (for 
MB491/MB491+LP/ES4191 MFP/MPS4200mb/
MPS4700mb Only), a profile for each destination 
must be created. You can register up to 50 
profiles.

Reference

 Refer to "Creating a Profile for Scan To Network PC" P. 76

Modifying a Profile

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Profile] and then 
press .

3 Press the  to select the profile you 
want to modify and then press .

4 Press the  to select [Edit] and then 
press .

5 Press the  to select the item you want 
to modify and then press .

6 Modify the item.

7 Select [Enter] and then press .

8 If you want to modify more than one 
item, repeat steps 5 and 7.

9 Press  to register the settings.

Deleting a Profile

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Profile] and then 
press .

3 Press the  to select the profile you 
want to delete and then press .

4 Press the  to select [Delete] and then 
press .

5 Press the  or  to select [Yes] on the 
confirmation message and then press .

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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Printing Configuration
This section explains how to print the Configuration on which you can check the detailed information of 
your machine, such as the settings and status of your machine.

Printing Procedure

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Reports] and 
press .

3 Press the  to select [Configuration] 
and press .

4 On the confirmation message, press the 
 or  to select [Yes] and press .

Reference

 You can also print reports and lists for each function. Refer 
to the User's Manual Advanced.

OK

OK

OK
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2. Copying
This chapter explains the basic operation and settings for your machine's copy function.

Basic Operation
This section explains how to start and cancel copy jobs.

Starting a Copy Job

1 Press the <COPY> key on the operator 
panel to open the copy standby screen.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Configure the copy settings if necessary.

4 Enter the number of copies using the 
ten-key pad.

- You can enter up 1 to 99 sets.

- If you have entered an incorrect value, press the 
<CLEAR> key and then enter the correct value.

5 Press  to start copying.

Reference

 For details on how to configure each copy setting, refer to 
"Configuring Copy Settings" P. 80.

 For details on how to load your documents in the ADF or on 
the document glass, refer to "Loading Documents" P. 38.

Canceling a Copy Job in 
Progress

You can cancel copying until the message 
showing the copy completion is displayed.

1 Press the <STOP> key on the operator 
panel.

Note

 When you make a copy with the document glass, do not 
apply an excessive load to the document glass.

MONO
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Configuring Copy Settings
You can change the copy settings to alter the output to suit your needs. Each setting can be configured 
from the [Change Settings] menu on the copy standby screen.

Perform the following procedures at step 3 of "Starting a Copy Job" P. 79 described above.

Reference

 The changes made in the [Change Settings] menu on the copy standby screen are temporary. You can change the default 
settings by configuring [Admin Setup] from the <SETTING> key. For details, refer to the User's Manual Advanced.

Changing the Scan Size (Scan Size)
You can select the appropriate size of the 
document to be scanned.

1 Press the  to enter the [Change 
Settings] menu.

2 Check that [Scan Size] is selected and 
then press .

3 Press the  to select a scan size and 
then press .

4 Press the  until the start screen is displayed.

Note

 If you select the scan size of less than or equal to 
177.8mm (7 inches) wide, and make copies from ADF, 
Scan Resolution is changed to High Quality automatically.

Changing the Paper Tray 
(Paper Feed)

You can select the size of the document to be copied.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Paper Feed] and 
then press .

3 Press the  to select a tray and then 
press .

4 Press the  until the start screen is displayed.

Memo

 [Tray 2] is displayed only when the optional second tray 
unit is installed.

 When set to [Auto], the MP tray is not selected in the 
default setting. To use the MP tray, press the <SETTING> 
key and select [Paper Setup] > [Select Tray] > [Copy] > 
[MP tray], and then select [ON] or [ON (Prior)].

 When set to [Auto], the paper tray that holds paper other 
than A4, B5, A5, A6, letter, legal 13/13.5/14, or executive 
is not selected. To use a different paper size, select the 
desired paper tray in the [Paper Feed Tray] setting.

Copying Using the MP Tray
If you have selected [MP Tray], you can copy your 
documents onto the paper loaded in the MP tray.

1 Place your document with text face up in the 
ADF or face down on the document glass.

2 Load the paper in the MP tray.

3 Press .

Settable Values:

A4*    A5    A6    B5    Letter    Legal 13  
Legal 13.5    Legal 14    Executive

*indicates the factory default.

OK

OK

OK

Settable Values:

Auto*    Tray 1    Tray 2    MP Tray**
*indicates the factory default.
**Not displayed in MB441, 

MB461, MB461+LP and 
ES4161 MFP.

OK

MONO
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4 When the pop-up message is displayed, 
press the  or  to select [Start] and 
then press .

Reference

 For details on how to load the paper in the MP tray, refer to 
"Loading Paper on the MP Tray (MB451/MB451w/MB471/
MB471w/MB491/MB491+/MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb)" P. 34.

Changing Image Orientation 
of Document (Direction)

You can select [Portrait] or [Landscape] for the 
document's orientation. Specify an appropriate 
orientation to get the copy result you want.

Reference

 For details on how to load documents in each orientation, 
refer to "Loading Documents" P. 38.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Direction] and 
then press .

3 Press the  to select the orientation of a 
document and then press .

4 Press the  until the start screen is 
displayed.

Making Enlarged or Reduced 
Copies (Zoom)

You can make enlarged or reduced copies by 
setting [Zoom]. You can set the zoom ratio in 
the following three ways:

 Using [Auto]

 Selecting a preset zoom ratio

 Setting the zoom ratio using the ten-key pad

Using [Auto]

By selecting [Auto], the zoom ratio is 
automatically determined according to the 
selected scan size and paper tray.

Note

 You can use [Auto] only when copying on A4, A5, A6, B5 
letter, legal 13/13.5/14, and executive paper.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Zoom] and then 
press .

3 Press the  to select [Auto] and then 
press .

4 Press the  until the start screen is 
displayed.

Memo

 Setting the [Paper Tray] to [Automatic] will 
automatically set [Enlarge/Reduce] to [100%]. When 
selecting another scaling factor, initially set [Paper Tray], 
and then set [Enlarge/Reduce].

Selecting a Preset Zoom Ratio

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Zoom] and then 
press .

3 Press the  to select the desired value 
and then press .

Memo

 By selecting [Fit to page(98%)], if the sizes of the 
document and the paper are the same, the document 
is reduced to fit onto the paper.

Settable Values:

Portrait*    Landscape
*indicates the factory default.

OK

OK

OK

Values:

100%* A4->A5(70%)             
Leg14->Let(78%) Leg13.5->Let(81%)    
Leg13->Let(84%) A4->B5(86%)           
A4->Let(94%) Let->A4(97%)           
Fit to page(98%) B5->A4(115%)     
A5->A4(141%)

*indicates the factory default.

OK

OK

OK

OK
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4 Press the  until the start screen is 
displayed.

Note

 When [Paper Feed] is set to [Auto], some values cannot 
be selected. The selectable values differ according to the 
selected scan size.

 With some ratios, parts of the document's image may be 
missing or margins may appear on the copied outputs.

Memo

 When [Paper Feed] is set to [Auto], the paper tray is 
automatically selected according to the selected zoom 
ratio. If you want to use a specific paper tray, reconfigure 
the [Paper Feed] setting.

 A paper tray that holds paper other than A4, B5, A5, A6, 
letter, legal 13/13.5/14, or executive is not selected even if 
[Paper Feed] is set to [Auto]. To select the desired paper 
tray, reconfigure the [Paper Feed] setting.

Setting the Zoom Ratio Using the 
ten-key pad

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Zoom] and then 
press .

3 Press the  to select [Zoom 
(25~400%)] and then press .

4 Enter the zoom ratio from 25 to 400% 
using the ten-key pad and then press .

- You can set the ratio in 1% increments.

- If you have entered an incorrect value, press the 
<CLEAR> key and then enter the correct value.

5 Press the  until the start screen is 
displayed.

Enabling Continuous Scan Mode 
(Continuous Scan)

If you want to copy multiple sets of documents 
as a single copy job, enable the continuous scan 
mode. It is useful when using [Sort], [N-in-1], 
or [Duplex Copy] functions.

Memo

 Continuous Scan Mode is also available for faxes, Internet 
faxes, as well as for scan functions. You can configure 
faxes from [Applied Settings], and Internet faxes and 
scans from [Reading Settings].

Reference

 For details on the [DuplexCopy] functions, refer to 
"Making Duplex Copies (Duplex Copy)".

 For details on the [Sort] and [N-in-1] functions, refer to 
the User's Manual Advanced.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Continuous 
Scan] and then press .

3 Press the  to select [ON] and then 
press .

4 Press the  until the start screen is 
displayed.

Copying With Continuous Scan 
Mode

With the continuous scan mode, you can copy 
your documents from the ADF or document 
glass, or both of them.

1 Place the first document with text face 
up in the ADF or face down on the 
document glass.

2 Configure the copy settings if necessary.
Change other copy settings as required.

3 Enter the number of copies with the ten-
key pad.

4 Press  to start scanning the first 
document.

5 When the [Please set next document] 
screen is displayed, place the next document 
in the ADF or on the document glass.

Note

 When changing the place to load the next document, be 
sure to remove the document from the place you used first.

6 Press the  to select [Start Scan] and 
then press .

7 When all sets of the documents are 
scanned, press the  to select [Scan 
Complate] and then press .

Memo

 When making N-in-1 and/or duplex copies using the 
document glass, the [Please set next document] screen 
is displayed after scanning the documents even if 
[Continuous Scan] is set to [OFF].

 For fax, Internet fax and scan functions, please follow 
procedures 5-7 after the first page of the document has 
started to be read.

OK

OK

OK

OK

OK

MONO

OK

OK
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Making Duplex Copies (Duplex 
Copy)

You can copy 1-sided (simplex) and 2-sided 
(duplex) documents on to one side (simplex) or 
both sides (duplex) of a sheet of paper. You can 
also select the binding position from either long-
edge or short-edge binding.

Specify the appropriate orientation of the 
document in [Direction] beforehand to get the 
copy result you want.

Note

 Use standard size plain paper for duplex copies. Using 
non-standard paper may cause a paper jam in the duplex 
unit of your machine.
Duplex printing cannot be done while paper is fed by 
Manual Feeder in MB441, MB461, MB461+LP and ES4161 
MFP.

Reference

 For details on the available paper for your machine, refer 
to "Loading Paper" P. 32.

 For details on how to configure the [Direction] setting, 
refer to "Changing Image Orientation of Document 
(Direction)" P. 81.

 Long-Edge Binding
Copies your document to be bound along the 
long edge of the paper.

Short-Edge Binding
Copies your document to be bound along the 
short edge of the paper.

Reference

 To set margins for binding, refer to the User's Manual 
Advanced.

Enabling Duplex Copies

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Duplex Copy] 
and then press .

3 Press the  to select the desired value 
and then press .

4 Press the  until the start screen is 
displayed.

Note

 You can copy "duplex to duplex" or "duplex to simplex" 
copies only when scanning the documents from the ADF.

Memo

 When making duplex copies using the document glass, the 
continuous scan mode is automatically enabled. Follow the 
on-screen instructions.

Adjusting Copy Density 
(Density)

You can adjust the copy density from 7 levels.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 
and then press .

3 Check that [Density] is selected and 
then press .

4 Press the  or  to select the desired 
density and then press .

Memo

 [0] is the standard value. To darken the document 
image, select [+1], [+2] or [+3] (most dense). 
Conversely, to lighten the document image, select 
[-1], [-2] or [-3] (least dense).

5 Press the  until the start screen is 
displayed.

Changing Document Type 
(Document Type)

You can select the document type to make copies 
at the most suitable quality for your needs.

1 Press the  to enter the [Change 
Settings] menu.

OK

Settable Values for Printing Method:

OFF (Simplex)*
Simplex document  Duplex  LE
Simplex document  Duplex  SE
Duplex documentDuplex printing
Duplex  LE  Simplex printing
Duplex  SE  Simplex printing

*indicates the factory default.

Settable Density Values:

+3    +2    +1    0*    -1    -2    -3
*indicates the factory default.

OK

OK

OK

OK
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2 Press the  to select [Image Settings] 
and then press .

3 Press the  to select [Document Type] 
and then press .

4 Press the  to select a document type 
and then press .

Memo

 [Text]: Set when copying a text document.

 [Text&Photo]: Set when copying a document having 
texts and photos.
Images are reproduced with a balance between texts 
and photos.

 [Photo]: Set when copying photos and graphic 
documents.
This reproduces grayscale for images in which it is 
important.

 [Photo (Glossy)]: Set when copying photo 
documents printed on a glossy sliver halide 
photography or glossy inkjet paper.
Images are reproduced by focusing on the gray level 
in consideration of the glossy.
If Photo or Photo (Glossy) is selected, Scan Resolution 
is fixed to Normal.

5 Press the  until the start screen is 
displayed.

Note

 When selecting [Text], the gray level may be reduced on 
some document.

 When selecting [Photo], [Photo (Glossy)], fine texts or 
lines may be blurred on some documents.

 When selecting [Photo(Glossy)], images may be bright.

Adjusting the Background 
Removal

You can turn off the background erasing for 
documents or adjust the background density 
from 6 levels.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 
and then press .

3 Check that [Background Removal] is 
selected and then press .

4 Press the  or  to select the desired 
value and then press .

Memo

 [3] is the standard value. To lighten the background 
(base) for the document, select [4], [5] or [6]. 
Conversely, to darken, select [2], [1] or [OFF] (not 
removal).

5 Press the  until the start screen is 
displayed.

Note

 When lightening the setting of the background removal 
fine lines, texts or light color may not be reproduced on 
some documents.

Changing Scan Resolution 
You can change the scan resolution of a 
document.

1 Press the  to enter the [Change 
Settings] menu.

2 Press the  to select [Image Settings] 
and then press .

3 Check that [Resolution] is selected and 
then press .

4 Press the  or  to select the desired 
value and then press .

Memo

 [High Speed] provides quick copy. By selecting 
[Normal] or [High Quality], the reproduction and 
gray level of fine lines or texts can be improved.

Note

 If you select the scan size of less than or equal to 
177.8mm (7 inches) wide, and make copies from ADF, 
Scan Resolution is changed to High Quality automatically.

5 Press the  until the start screen is 
displayed.

Settable Types:

Text   Text&Photo*   Photo   Photo (Glossy)
*indicates the factory default.

OK

OK

OK

OK

OK

Settable Values:

OFF    1    2    3*    4    5    6
*indicates the factory default.

Settable Resolution:

High Speed*  Normal   High Quality
*indicates the factory default.

OK

OK

OK

OK
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Resetting Copy Settings

Auto Reset

All settings you configured for your copy job 
return to their default values if no operation is 
made for a set period of time. The auto reset 
time is set to 3 minutes as the factory default 
setting.

Reference

 You can change the auto reset time by configuring [Admin 
Setup] from the <SETTING> key. For details, refer to the 
User's Manual Advanced.

Using the <RESET/LOG OUT> key

By pressing the <RESET/LOG OUT> key, the 
settings you configured for your copy job return 
to their default values.

After copying, press the <RESET/LOG OUT> 
key to reset the default settings for the next 
user.
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3. Faxing (for MB451, MB451w, MB471, MB471w, 
MB491, MB491+, MB491+LP, ES4191 MFP, 
MPS4200mb, MPS4700mb only)

This chapter explains basic settings and operations for faxing, scanning to fax server and Internet faxing  
and operations on managing the phone book.

Basic Procedure for Faxing
This section explains basic operations for transmitting faxes. You need to configure the initial settings 
before using the fax function.

Memo

 You can load only A4, letter or legal size documents in the ADF, and only A4, letter or legal (MB491+LP/MPS4700mb only) size 
documents on the document glass.

 You cannot load mixed size documents for faxing.

Reference

 For details on initial settings for the fax function, refer to "Basic Settings for Faxing (for MB451, MB451w, MB471, MB471w, 
MB491, MB491+, MB491+LP, ES4191 MFP, MPS4200mb, MPS4700mb only)" P. 40.

Sending a Fax

Memo

 The machine puts priority on the ADF when scanning 
documents. Be sure not to place documents on the ADF 
when you use the document glass.

1 Press the <FAX/HOOK> key on the 
operator panel.

2 Place your document with text face up in the 
ADF or face down on the document glass.

3 Check that [Fax] is selected and press 
 to open the fax start screen.

4 Check that [Add Destination] is 
selected on the start screen and then 
press .

5 Specify a destination.
You can specify a destination from the ten-key pad, the 
speed dial list, the group list, the transmission histories, 
the reception histories, or the one-touch key pad.

Reference

 For details on each procedure, refer to "Specifying a 
Destination" P. 87.

6 Configure the advanced functions if 
necessary.

Reference

 "Configuring Fax Settings" P. 90

7 Press  to start transmission.
When you want to scan multiple documents as a 
single fax job using the document glass, enable 
the continuous scan mode. 

Reference

 For details on the continuous scan mode, refer to "Enabling 
Continuous Scan Mode (Continuous Scan)" P. 82.

Note

 You cannot use the  button.

 If <STATUS> is pressed and  is pressed twice, the 
information is displayed on the display screen.

Reference

 For details on how to load your documents in the ADF or on 
the document glass, refer to "Loading Documents" P. 38.

 When you want to specify multiple destinations, refer to 
the User's Manual Advanced.

OK

OK

MONO

COLOR



Basic Procedure for Faxing

- 87 -

Faxin
g
 (fo

r M
B
4
5
1
, M

B
4
5
1
w

, M
B
4
7
1
, M

B
4
7
1
w

, M
B
4
9
1
, M

B
4
9
1
+

, 
M

B
4
9
1
+

LP, E
S
4
1
9
1
 M

FP, M
P
S
4
2
0
0
m

b
, M

P
S
4
7
0
0
m

b
 o

n
ly)

3

Note

 When you take a copy with the document glass, do not 
apply an excessive load to the document glass.

Specifying a Destination
You can specify a destination in the following six 
ways:

 Using the ten-key pad

 Using a speed dial

 Using a group

 Using the transmission histories

 Using the reception histories

 Using the one-touch key pad

Perform the following procedures at step 5 of 
"Sending a Fax" P. 86 described above.

Direct Input

You can enter a destination fax number directly 
by using the ten-key pad. You can enter up to 40 
digits.

1 Press the  to select [Direct Input] and 
then press .

2 Enter a destination fax number using the 
ten-key pad on the operator panel.

3 Select [Enter] and then press .

Memo

 You can use the ten-key pad to enter a destination also on 
the screen that is displayed after pressing the <FAX/
HOOK> key. In this case, the fax start screen appears 
after entering a destination.

Dialing Functions
You can use the following functions when 
entering a destination fax number. 
Select the function you want and then press on 
the fax number entry screen.

 -(Hyphen)

Inserts a hyphen to the entered fax number.

 PreFix

Inserts a prefix number registered in advance. 
"N" is inserted when entering.

 Flash

Orders your PBX(Private Branch Exchange) to 
connect you with PSTN(Public Switched 
Telephone Network). When inputting, enter "F".

OK

OK
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Enter "Pause" and "#" by pressing <#> on the 
ten-key pad. When you press <#>, you toggle 
between "P" and "#".

 Pause

Pauses a few seconds when dialing. You can use 
multiple pauses. "P" is inserted when entering.

 # (Hash symbol)

When the tone dial is set, "#" sends through a 
circuit. When inputting, enter "#".

Enter "Tone" and "*" by pressing <*> on the 
ten-key pad. When you press <*>, you toggle 
between "T" and "*".

 Tone

Switches to tone dialing if pulse dialing is set. "T" 
is inserted when entering.

 * (Asterisk)

When the tone dial is set, "*" sends through a 
circuit. When inputting, enter "*".

Reference

 For details on prefix numbers, refer to the User's Manual 
Advanced.

Using Speed Dial List and Group List

You can select a destination from numbers 
registered in the speed dial list or the group list. 
You must register them in advance.

Reference

 For details on how to register numbers to Speed Dial List 
and Group List, refer to "Phone Book" P. 95.

1 Press the  to select [Speed Dial List] 
or [Group List] and then press .

2 Press the  to select a destination or 
group and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

Using Transmission and Reception 
History

You can select a destination from the 50 most 
recent transmissions or receptions.

1 Press the  to select [Tx History] or 
[Rx History] and then press .

2 Press the  to select an entry and then 
press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

Using One-Touch Key Pad

The one-touch key pad can hold fax numbers 
registered in Speed Dial List.

The speed dials no.1 to 16 are automatically 
registered to the one-touch key pad.

1 Press the desired one-touch key on the 
start screen.

Press the <SHIFT> key to select the speed dials 
no.9 to 16 assigned to the one-touch key pad.

Memo

 You can use the one-touch key pad also on the screen that 
is displayed after pressing the <FAX/HOOK> key. In this 
case, the fax standby screen appears after pressing a one-
touch key so that you can configure other advanced 
settings for fax functions.

OK

OK

OK

OK

OK

OK
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Deleting Specified Destinations

1 Select the specified destination on the 
fax start screen by pressing  and then 
press .

2 Press the  to select a destination you 
want to delete and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations to be deleted, press .

4 Check that [Delete The Address] is 
selected and then press .

- If all recipients have been deleted, you will be 
taken back automatically to the start screen.

- If not all recipients have been deleted, press  to 
go back to the start screen.

OK

OK

OK
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Configuring Fax Settings
You can configure the fax settings to alter the output to suit your needs. Each setting can be configured 
from the [Fax Functions] menu on the fax start screen.

Perform the following procedures at step 6 of "Sending a Fax" P. 86 described above.

Changing Scan Size (Scan Size)
You can select the appropriate scan size for your 
document.

1 Press the  to select [Fax Functions] 
on the fax start screen and then press 

.

2 Check that [Scan Size] is selected and 
then press .

3 Press the  to select a size and then 
press .

4 Press the  until the fax standby screen 
appears.

Changing Resolution 
(Resolution)

You can select an appropriate resolution to scan 
your fax document to get optimum image quality.

1 Press the  to select [Fax Functions] 
on the fax standby screen and then 
press .

2 Press the  to select [Resolution] and 
then press .

3 Press the  to select a resolution and 
then press .

Memo

 [Extra-Fine] may be unavailable depending on the 
recipient machine.

 In the [Fine], [Extra-Fine], or [Photo] mode, 
scanning takes longer.

4 Press the  until the fax standby screen 
appears.

Adjusting Density (Density)
You can adjust the scan density from 7 levels.

1 Press  to select [Fax Functions] on the 
fax standby screen and then press .

2 Press the  to select [Density] and 
then press .

3 Press the  or  to select a density and 
then press .

Memo

 [0] is the standard value. To darken the document 
image, select [+1], [+2] or [+3] (most dense). 
Conversely, to lighten the document image, select 
[- 1], [-2] or [-3] (least dense).

4 Press the  until the fax standby screen 
appears.

Printing the Sender Name
You can set the machine to print a sender name 
on faxes you send. By default, the name you 
specified in [Sender ID] is printed.

Reference

 For details on [Sender ID], refer to "Specifying Sender 
Information" P. 44.

1 Press the  to select [Fax Functions] 
on the fax standby screen and then 
press .

2 Press the  to select [TTI] and then 
press .

3 Press the  to select [ON] and then 
press .

4 Press the  until the fax start screen 
appears.

Reference

 For details on how to register a sender name and change 
the sender name to be used, refer to the Use's Manual 
Advanced.

Settable Size Values:

A4*    Letter    Legal 13    Legal 13.5    
Legal 14

*indicates the factory default.

Settable Resolution:

Normal*    Fine    Extra-Fine    Photo
*indicates the factory default.

OK

OK

OK

OK

OK

OK

Values:

+3    +2    +1    0*    -1    -2    -3
*indicates the factory default.

OK

OK

OK

OK

OK

OK
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Checking and Canceling Fax Transmission
This section explains how to check or cancel fax jobs.

Canceling Fax Transmission
You can cancel a job that is being transmitted as 
long as the message indicating the job has been 
completed has not appeared.

1 Press the <STOP> key on the operator 
panel.

Canceling a Reserved Job
You can cancel reserved jobs.

1 Press the <FAX/HOOK> key on the 
operator panel.

2 Check that [Fax] is selected and then 
press  to open the fax start screen.

3 Press the  to select [Fax Job View/
Cancel] and then press .

4 Press the  to select the job you want to 
cancel and then press .

5 Check the job contents and then press 
the .

6 Press the  to select [Delete Reserved 
Tx] and then press .

7 Press the  or  select [Yes] and then 
press .

Note

 When you select a broadcast job, the job itself is cancelled.

Memo

 The job that is being transmitted is displayed at the top of 
the list.

Checking Transmission and 
Reception History

You can check transmission and reception history 
and results.

Memo

 If a fax is being transmitted, you can check the 
transmission on the [Fax Job View/Cancel] screen.

1 Press the <FAX/HOOK> key on the 
operator panel.

2 Check that [Fax] is selected and then 
press to  the fax start screen.

3 Press the  to select [Fax History] and 
then press .

4 Press the  to select [Tx History] or 
[Rx History] and then press .

5 Press the  to select the history you 
want to check and then press .

6 Check the history contents and then 
press .

Note

 The received message history displayed on the panel is 
only for messages received with F code polling. 

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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Machine Behavior in Fax Reception
This section explains how your machine behaves when receiving and printing faxes.

Reception Behavior
The machine behavior differs depending on the 
specified reception mode.

Your machine is set by factory default to [Fax 
Ready Mode] so that it automatically receives 
faxes. If you have changed the fax reception 
mode, see the following descriptions for the 
machine behavior.

When the machine is receiving faxes, the <DATA 
IN MEMORY> indicator is lit. If <STATUS> is 
pressed and  is pressed twice, the information 
is displayed on the display screen. Even if the 
reception is finished, the indicator remains lit 
while the data is stored in memory.

Memo

 If the memory overflows while the machine is receiving 
data, the reception is cancelled. If this happens, ask the 
sender to resend the fax.

When Receiving Calls and Faxes
(Tel/Fax Ready Mode)

When the machine is set to [Tel/Fax Ready 
Mode], you can receive calls and faxes. You 
must connect an external telephone in advance 
to receive calls.

Reference

 For details on how to connect an external telephone, refer 
to "Connecting a Telephone Line" P. 41.

Receiving Faxes
The machine automatically starts fax reception.

Receiving Calls
The telephone starts ringing when it receives calls.

1 Pick up the handset when the machine rings.
You can talk with someone on it.

2 If you want to receive a fax, press .
If you keep picking up the handset, you can talk to 
the sender after receiving faxes.

Memo

 If you often receive calls, it is recommended that you 
activate [Tel Priority Mode]. For more detailed 
information on [Tel Priority Mode], please refer to User's 
Manual Advanced.

 If connecting to a telephone unit that is far away, you can 
receive faxes by dialing the remote switchover number. 
Please dial the remote switchover number within three 
seconds. For more details on the remote switch over 
number, please refer to User's Manual Advanced.

When Connecting An Answering
Machine (Ans/Fax Ready Mode)

When the machine is set to [Ans/Fax Ready 
Mode], you can use an answering machine and 
receive faxes automatically. Be sure to connect 
an external answering machine in advance.

Memo

 Depending on the answering machine and the sender 
machine, [Ans/Fax Ready Mode] may not operate 
correctly.

Reference

 For details on how to connect an answering machine, refer 
to "Connecting a Telephone Line" P. 41.

Receiving Faxes
The answering machine rings, the reply message 
starts, and the machine automatically starts fax 
reception.

Receiving Calls
The answering machine rings, the reply message 
starts, and then it starts recording a message.

When Often Using Telephone (Tel 
Ready Mode)

[Tel Ready Mode] is recommended if you often use 
the external telephone connected to the machine.

Receiving Calls
The telephone starts ringing when it receives 
calls.

Receiving Faxes
The telephone starts ringing when it receives a 
signal.

1 Pick up the handset when the machine rings.

2 Press .
To restart a conversation after receiving a fax, just 
pick up the receiver. After the fax has been 
received, you can talk on the phone.

MONO

MONO
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When using two numbers with distinct rings(DRD)

This mode is programmed for the fax to answer only on a distinctive ring. You can have a signal phone line to have 
two numbers with distinct rings, one for regular phone calls and one for fax. If the phone line is in use, and there is 
an incoming fax, the sender will receive a busy signal.

There are several type of DRD ring pattern. The length of ring ON time and ring OFF time is different.

It depends on the Country Code.

Please set the Country Code and DRD Type for your suitable DRD ring pattern.

 Country Code : except New Zealand, Australia and Hong Kong  (This pattern is to apply to USA's DRD.)

 Country Code : New Zealand  (This pattern is to apply to New Zealand's DRD.)

 Country Code : Australia  (This pattern is to apply to Australia's DRD.)

 Country Code : Hong Kong  (This pattern is to apply to Hong Kong's DRD.)

Setting method to change the DRD 
pattern

1 Press the <SETTING> key.

2 Press the  to select [Admin Setup] 
and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [User Install] and 
then press .

6 Press the  to select [DRD Type] and 
then press .

7 Press the  to select DRD Type and then 
press .

8 Press the  until the top screen appears.

DRD Type The length of ring ON time and ring OFF time

Type1 2 sec ON - 4 sec OFF repeat

Type2 0.8 sec ON - 0.4 sec OFF - 0.8 sec ON - 4 sec OFF repeat

Type3 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 0.2 sec OFF - 0.8 sec ON - 4 sec OFF repeat

Type4 0.3 sec ON - 0.2 sec OFF - 1 sec ON - 0.2 sec OFF - 0.3 sec ON - 4 sec OFF repeat

DRD Type The length of ring ON time and ring OFF time

Type1 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 2 sec OFF repeat

Type2 0.4 sec ON - 2.6 sec OFF repeat

Type3 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 1.4 sec OFF repeat

Type4 0.4 sec ON - 0.8 sec OFF - 0.4 sec ON - 1.4 sec OFF repeat

DRD Type The length of ring ON time and ring OFF time

Type1 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 2 sec OFF repeat

Type2 0.2 sec ON - 0.4 sec OFF - 0.2 sec ON - 0.4 sec OFF - 0.2 sec ON - 1.6 sec OFF repeat

DRD Type The length of ring ON time and ring OFF time

Type1 1.2 sec ON - 3 sec OFF repeat

Type2 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 0.2 sec OFF - 0.8 sec ON - 0.4 sec OFF repeat

Type3 0.5 sec ON - 0.5 sec OFF - 1 sec ON - 0.5 sec OFF - 0.5 sec ON - 3 sec OFF repeat

OK

OK

OK

OK

OK
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Printing Received Faxes
The machine automatically prints out the received 
fax. You can specify the paper tray to use.

Note

 Do not pull out the paper trays when the machine is 
printing.

Memo

 Use only standard or recycled paper.

 Available paper sizes are A4, letter, or legal.

Reference

 Images larger than the specified paper are reduced, 
discarded, or printed onto multiple sheets of paper 
depending on the reception print settings. For details, refer 
to the User's Manual Advanced.

Selecting the Tray to Use

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Paper Setup] and 
then press .

3 Press the  to select [Select Tray] and 
then press .

4 Check that [Fax] is selected and then 
press .

5 Press the  to select a paper tray and 
then press .

6 Press the  to select a value and then 
press .

- When you select [ON (Prior)] for a paper tray, 
the tray is used in priority to other trays 
containing the same size paper.

- The MP tray is set to [OFF] by factory default.

7 Press the  until the top screen is 
displayed.

When Unable to Print Received 
Faxes

When the machine cannot print received faxes 
due to a lack of paper or paper jams, it stores 
the received fax data temporarily in memory. 
When the problem is resolved, it starts printing 
automatically.

Reference

 For details on how to load paper, refer to "Loading Paper" 
P. 32.

 For details on how to clear paper jams, refer to "Paper 
Jams" P. 135.

 To check the reception history, refer to "Checking 
Transmission and Reception History" P. 91.

Settable Values:

ON*    OFF    ON (Prior)
*indicates the factory default.

OK

OK

OK

OK

OK
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Phone Book
This section explains how to register fax numbers in the phone book, and how to edit or delete 
registered numbers. In the phone book, you can set frequently used numbers to speed dial and also 
create groups of numbers to which you can broadcast faxes.

Speed Dial
You can register up to 100 favorite destinations 
to speed dial.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 
then press .

3 Check that [Speed Dial] is selected and 
then press .

4 Press the  to select a speed dial 
number and then press .
You cannot select a speed dial which is specified as 
a reserved fax job or for the auto delivery function.

5 Check that [Register] is selected and 
then press .
When editing a registered speed dial number, 
select [Edit].

6 If necessary, specify an entry name.

a) Check that [Name] is selected and then 

press the .

b) Enter a name.
Enter a name up to 24 characters.

c) Select [Enter] and then press .

7 Press the  to select [Fax Number] and 
then press .

8 Enter a phone number.
Enter a phone number up to 40 digits.

9 Select [Enter] and then press .

10 If necessary, specify a group number.

a) Press the  to select [Group No] and 
then press the .

b) Press the  to select a group number 
(1 to 20).
The check box is selected. You can select 
multiple entries.

c) When you have selected all the groups, 
press the .

d) Check that [Group Selection Completed] 
is selected and then press .

11 Press .

Memo

 Numbers registered to groups from the [Speed Dial] 
function are synchronized with the numbers that are 
registered to groups using the [Group No] function.

Registering From History

You can register phone numbers as speed dial 
numbers from fax transmission and reception 
histories.

1 Press the <FAX/HOOK> key on the 
operator panel.

2 Check that [Fax] is selected and then 
press  to open the fax start screen.

3 Press the  to select [Fax History] and 
then press .

4 Press the  to select [Tx History] or 
[Rx History] and then press .

5 Press the  to select an entry and then 
press .

6 Check the entry contents and then press 
the .

7 Check that [Register To Speed Dial] is 
selected and then press .

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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8 Repeat steps 4 to 11 in "Registering and 
Editing" P. 95.
The fax number is automatically entered. You do 
not have to enter it manually.

Deleting

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 
then press .

3 Check that [Speed Dial] is selected and 
then press .

4 Press the  to select an entry number 
and then press .

5 Press the  to select [Delete] and then 
press .

6 Press the  or  to select [Yes] and 
then press .

Note

 You cannot delete an entry which is specified as a reserved 
fax job or for the auto delivery function.

Group Dial (Group Number)
You can create up to 20 groups and register the 
entire group as a speed dial number.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 
then press .

3 Press the  to select [Group No] and 
then press .

4 Press the  to select a group number 
and then press .

5 Check that [Register] is selected and 
then press .
When editing registered group numbers, select 
[Edit].

6 Check that [Name] is selected and then 
press .

7 Enter a name.
Enter a name up to 16 characters.

8 Select [Enter] and then press .

9 Press the  to select [Speed Dial] and 
then press the .

10 Press the  to select a speed dial 
number (1 to 100) and then press .
The check box is selected. You can select multiple 
entries.

11 When you have selected all the numbers, 
press the .

12 Check that [Complete] is selected and 
then press .

13 Press .

Memo

 Numbers registered to groups from the [Speed Dial] 
function are synchronized with the numbers that are 
registered to groups using the [Group No.] function.

Deleting

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Phone Book] and 
then press .

3 Press the  to select [Group No] and 
then press .

4 Press the  to select a group number 
and then press .

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK



Phone Book

- 97 -

Faxin
g
 (fo

r M
B
4
5
1
, M

B
4
5
1
w

, M
B
4
7
1
, M

B
4
7
1
w

, M
B
4
9
1
, M

B
4
9
1
+

, 
M

B
4
9
1
+

LP, E
S
4
1
9
1
 M

FP, M
P
S
4
2
0
0
m

b
, M

P
S
4
7
0
0
m

b
 o

n
ly)

3

5 Press the  to select [Delete] and then 
press .

6 Press the  or  to select [Yes] and 
then press .

Memo

 You cannot delete an entry which is specified as a reserved 
fax job or for the auto delivery function.

One-Touch Key Pad
The speed dials no.1 to 16 are automatically 
registered to the one-touch key pad.

Register all telephone numbers
All contents of Phone Book can be registered by 
using Configuration Tool. For setting up of 
Configuration Tool, see User's Manual (Advanced), 
"7. Useful Software".

Registering the Machine

When using the Configuration Tool or introducing
a new machine, register the machine in the 
Configuration Tool.

1 Select [Start], [All Programs]> 
[Okidata]>[Configuration Tool]> 
[Configuration Tool].

2 Select [Register Device] from the 
[Tools] menu. Search results are 
displayed.

3 Select the machine and click on 
[Register].

4 On the confirmation screen, click on 
[Yes].

 Importing Addresses from a File.

1 Select from which device to import, from 
[Registered Device Table].

2 Select the [User Setting] tab.

3 Click on [Speed Dial Manager].

4 Enter the administrator password and 
click [OK].

5 Click .

6 Select [Open] from [Select CSV File].

7 Select the file you want to import and 
click on [Open].

8 Click on [Next].

9 Select the settings to import and click 
[Import].

10 Click .

Memo

 CSV files exported by Outlook Express (Windows email and 
Windows Live email) can also be restored.

OK

OK
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Basic Procedure for Scan To Fax Server
This section explains basic operations for data transmission to the fax server.

The FaxServer function allows you to transmit fax data as a file attached to an e-mail. A document is 
scanned and converted to a TIFF file. The data is transmitted immediately after scanning without being 
saved in memory. You can specify only e-mail addresses for the destination.

The Scan To Fax Server function must be enabled by Admin Setup (see the Advanced manual). Once the 
Scan To Fax Server function is enabled, the analog fax is disabled to send and receive messages.

Memo

 You can load only A4, letter or legal size documents in the ADF, and only A4, letter or legal (MB491+LP/MPS4700mb only) size 
documents on the document glass. You cannot load mixed size documents for fax transmission.

 Depending on the recipient's machine, the document data sent by the FaxServer function may not be printed correctly.

 The detailed settings on the FaxServer function are the same as in the scan to e-mail function. For details, refer to the "User's 
Manual Advanced".

Reference

 Before using the FaxServer function, you must set up the server. For the server setup, refer to "Setting Up Scan To E-mail and 
Internet Fax" P. 66.

Transmitting Data to Fax Server

1 Press the <FAX/HOOK> key on the 
operator panel.

2 The original can be set by an automatic 
document feeder or the document glass.

3 Select [FAX], and then press .

4 Set the scan options as required.

Reference

 "User's Manual Advanced".

5 Check that [Add Destination] is 
selected, and then press .

6 Specify the destination fax number.
You can specify the destination using either the 
Speed Dial List, Group List, Direct Input, or Tx 
History.

7 Press the Start button to start fax 
transmission.
When you scan multiple documents on the 
document glass, enable the Continuous Scan 
mode.

Reference

 "Enabling Continuous Scan Mode (Continuous Scan)" 
P. 82.

Specifying the destination
You can specify fax destination in any of the following 
four ways:

• Using the Speed Dial List

• Using the Group List

• Using the Direct Input

• Using the Tx History

Use any of the following operations in the procedure of 
"Transmitting Data to Fax Server" P. 98.

Using the Speed Dial List or Group List

You can quickly select fax destinations from the 
Speed Dial List or Group List. You need to 
register recipients on the Speed Dial List or 
Group List in advance.

Reference

 For fax number entry on the Speed Dial List or Group List, 
refer to the "Phone Book" P. 95.

1 Press the  to select [Speed Dial List] 
or [Group List], and then press .

2 Press the  to select the destination or 
group, and then press .

OK

OK

OK

OK
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The box is checked. You can select multiple entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected, and 
then press .

Direct Input

This is the same as the fax function.

Using the Tx History

You can select a destination from the recently 
called 50 recipients listed on the transmission 
history.

1 Press the  to select [Transmission 
History], and then press .

2 Press the  to select an entry, and then 
press .
The box is checked. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected, and 
then press .

Using the one-touch keys

This is the same as the fax function. Enter the 
text in the similar way.

Deleting the specified destination
This is the same as the fax function. Enter the 
text in the similar way.

Stopping the fax transmission
This is the same as the Internet fax function. 
Enter the text in the similar way.

OK

OK

OK

OK
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Basic Procedure for Internet Faxing
This section explains basic operations for transmitting Internet faxes.

The Internet fax function allows you to transmit fax data as a file attached to an e-mail. A document is 
scanned and converted to a TIFF file. The data is transmitted immediately after scanning without being 
saved in memory. You can specify only e-mail addresses for the destination.

Memo

 You can load only A4, letter or legal size documents in the ADF, and only A4, letter or legal (MB491+LP/MPS4700mb only) size 
documents on the document glass. You cannot load mixed size documents for Internet faxing.

 Depending on the recipient's machine, the document data sent by the Internet fax function may not be printed correctly.

 The detailed settings on the Internet fax function are the same as in the scan to e-mail function. For details, refer to the User's 
Manual Advanced.

Reference

 Before using the Internet fax function, you need to configure the server settings. For details, refer to "Setting Up Scan To E-mail 
and Internet Fax" P. 66.

Sending an Internet Fax

1 Press the <FAX/HOOK> key on the 
operator panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Internet Fax] 
and then press .

4 Configure the Internet fax settings if 
necessary.

Reference

 For details on the Internet fax settings, refer to the 
User's Manual Advanced.

5 Check that [Add Destination] is 
selected and then press .

Memo

 Here you can add addressees by using one-touch keys. You 
can add addresses with [To]. Thereafter, you can add 
multiple addresses using the one-touch keys.

6 Check that [To] is selected and then 
press .

Press to  select [Cc] or [Bcc] if necessary.

7 Specify a destination.
- You can set the recipient by directly entering them 

or by using the address book, group list, sending 
history, LDAP search or one-touch key.

Reference

 Refer to "Specifying a Destination" P. 101.

8 Press  to start transmission.
If you want to scan multiple documents with the 
document glass, enable the continuous scan 
mode.

Reference

 "Enabling Continuous Scan Mode (Continuous Scan)" 
P. 82

Reference

 For details on how to load your documents in the ADF or on 
the document glass, refer to "Loading Documents" P. 38.

OK

OK

OK

MONO
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Specifying a Destination
You can specify a destination in the following five 
ways:

 Using the address book

 Using a group

 Using the transmission histories

 Direct input

 Using LDAP search 

Perform one of the following procedures at step 7 
of "Sending an Internet Fax" P. 100 described 
above.

Using the Address Book and Group 
List

You can select a destination from the address 
book or groups. You need to register them in 
advance.

Reference

 For details on how to add e-mail addresses to the address 
book and groups, refer to "Registering Address Book" P. 119.

1 Press the  to select [Address Book] or 
[Group list] and then press .

2 Press the  to select the destination or 
group you want and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

5 Press the  to return to the Internet fax 
start screen.

Using the Transmission History

You can select a destination from transmission 
histories.

Note

 The sending history only shows those recipients which had 
their addresses directly entered.

1 Press the  to select [Tx History] and 
then press .

2 Press the  to select the entry you want 
and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

5 Press the  to return to the Internet fax 
start screen.

Direct Input

You can enter a destination directly.

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the  to select [Direct Input] and 
then press .

2 Enter an e-mail address.
An e-mail address up to 80 characters.

3 Select [Enter] and then press .

4 Press the  to return to the Internet fax 
start screen.

OK

OK

OK

OK

OK

OK

OK

OK
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Using LDAP Search

You can search for a destination that is on the 
LDAP server.

You can select either [Simple Search] or 
[Advanced Search] for the method of 
searching.

[Simple Search] only searches for a single 
keyword as a username. Also, with Simple 
Search you can only search for character strings 
included in usernames. You cannot search for 
character strings in e-mail addresses.

When you select [Advanced Search], you can 
search for a user name or e-mail address. You 
can also select search conditions to retrieve only 
results that contain all the specified keywords.

Reference

 For details on the LDAP server settings, refer to the User's 
Manual Advanced.

 For Simple Search

1 Press the  to select [LDAP] and then 
press .

2 Check that [Simple Search] is selected 
and press .

3 Enter a keyword to search for a user 
name in the LDAP server.

4 Select [Enter] and then press  to start 
searching.

5 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
addresses.

6 When you have selected all the 
destinations, press the .

7 Check that [Complete] is selected and 
then press .

8 Press the  to return to the Internet fax 
start screen.

 For Advanced Search

1 Press the  to select [LDAP] and then 
press .

2 Press the  to select [Advanced 
Search] and then press .

3 Check that [Search Method] is selected 
and press .

4 Select either [OR] or [AND] and press .

5 Press , select [User name], and then 
press .

6 Enter the keyword to search for.

7 Select [Enter] and then press .

8 Press , select [E-mail Address], and 
then press .

9 Enter the keyword to search for.

10 Select [Enter] and then press .

11 Press  to start searching.

12 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
addresses.

13 When you have selected all the 
destinations, press the .

14 Check that [Complete] is selected and 
then press .

15 Press the  to return to the Internet fax 
start screen.

Checking, Deleting, and 
Changing Destinations

Checking a Destination

1 Press the  on the start screen to select 
the specified destination and then 
press .

2 Press the  to select the destination 
type you want to check and then 
press .
The destination type includes To, Cc, and Bcc.

3 When you have checked the destination, 
press the .

OK
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4 Check that [Close the list] is selected 
and then press .

Deleting a Destination

1 Press the  on the start screen to select 
the specified destination and then press 

.

2 Press the  to select the destination 
type in which the destination you want to 
delete is included and then press .
The destination type includes To, Cc, and Bcc.

3 Press the  to select the destination you 
want to delete and then press .
The check box is selected. You can select multiple 
addresses.

4 When you have selected all the 
destinations to be deleted, press the .

5 Press the  select [Delete The 
Address] and then press .

Changing the Destination Type

1 Press the  on the start screen to select 
the specified destination and then press 

.

2 Press the  to select the destination 
type in which the destination you want to 
change is included and then press .
The destination type includes To, Cc, and Bcc.

3 Press the  to select the destination you 
want to change and then press .
The check box is selected. You can select multiple 
addresses.

4 When you have selected all the 
destinations to be changed, press the .

5 Check that [Edit Destination Type] is 
selected and then press .

6 Press the  to select the destination 
type you want from [To], [Cc], or [Bcc] 
and then press .

Canceling Transmission
While the "Scanning" screen is displayed, you 
can cancel the job.

1 Press the <STOP> key on the operator 
panel to cancel transmission.

Receiving Internet Faxes
The machine automatically prints the Internet 
faxes it receives. If the document is larger than 
A4 size, the machine automatically reduces it to 
the size of the paper in the specified paper tray.

Reference

 If you want to forward an Internet fax, you can use the 
auto delivery function (MB491, MB491+LP, ES4191 MFP, 
MPS4200mb, MPS4700mb only). For details, refer to the 
User's Manual Advanced.

 The Auto Delivery function does not operate on machines 
that do not have an SD card inserted.

 In order to receive Internet faxes, it is necessary to 
configure e-mail receiving settings beforehand. For details, 
please refer to the User's Manual Advanced.

OK

OK
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OK
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4. Scanning
This chapter explains the basic operation and settings for your machine's scanning functions.

 Installing Scanner Drivers (TWAIN/WIA/ICA Driver)
This section explains the procedure to install the scanner driver. Before using scan function, install the 
scanner driver. You can install TWAIN driver and WIA (Windows only) driver at the same time. Install the 
TWAIN driver and ICA driver (dedicate to the Mac OS X) separately.

If you want to use the network scan function, follow the installation procedure below and register the 
information of your computer and then install the scanner driver.

Memo

 When using the network scan function in Windows, please install the ActKey utility.

Reference

 Before installing the scanner driver manual, do the network settings.For details on how to do network settings, refer to 
"Network Connection" P. 47.

Note

 When using a scanner with a network connection in Windows, if the equipment IP address is changed, please change the 
settings in Network Configuration. For Mac OS X, please change settings in network scanner setting tools. For details, refer to 
User's Manual Advanced.

 The Twain driver for Mac OS X supports the Mac OS X 10.4 to 10.7.

Installation Procedure

Memo

 When using the network scan function in Windows, please 
install the Network Configuration. For Mac OS X, the 
network scanner setting tools will be installed 
automatically.

For Windows

1 Ensure that your machine and the 
computer are turned on and connected, 
and then insert the "Software DVD-ROM" 
into the computer.

2 Click [Run setup.exe] after [Auto 
Play] is displayed.
If the [User Account Control] dialog box 
appears, click [Yes].

3 Select the language and then click 
[Next].

4 Select the device of your machine, and 
then click [Next].

5 Read the license agreement and then 
click [I Agree].

6 Select the proper driver under 
[Software], and then click the install 
icon.
If the scanner driver has been installed, the setup 
maintenance program of the scanner driver is 
displayed. Check the checkbox of [Add] and then 
click [Next] to proceed to step 8.

7 Click [Next].
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8 Check the checkbox of [Network 
scanner] and click [Next].

9 Select [IP Address] or [Search MFP] 
check box to enter the address of the 
machine and then click [Next].
If you want to set the [IP Address], follow 
procedure 10.

10 If [Search MFP] is selected, select the 
machine and click [Next].

11 Set the scanner driver name and click 
[Next].

12 Enter the host name, IP address and port 
number and then click [Configure].

13 Click [Next].

14 Click [Next].

15 Click [Finish].

For Mac OS X

1 Make sure that the machine is connected to 
the PC and the power switch of the machine 
is turned ON. Then, load the "Software 
DVD-ROM" on the drive of the PC.

2 Double-click the [OKI] icon on the desktop.

3 Double-click [Drivers] > [Scanner] >  
[Installer for OS X 10.8] (For Mac OS 
X 10.8) or [Installer for OS X 10.4-
10.7] (For Mac OS X 10.4 to 10.7).
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4 Click [Continue].

5 Click [Continue].

6 Check the display and click [Continue] if 
OK.

7 Read the license agreement and click 
[Continue].

8 Click [Agree] if you agree.

9 Click [Install].
To change the installation location of the 
driver, click [Change Install Location].

10 Enter the administrator name and 
password, and click [OK].

11 Click [Continue Installation].

12 Click [Restart].
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Using ActKey Software
Using the ActKey, you can start a scan job in 
specified settings with a click a button.

Memo

 ActKey does not support Mac OS X.

 Using WSD Scanning, Actkey does not work.

 When ActKey is installed, Network Configuration is also 
installed simultaneously. 

Reference

 For details on how to start a scan job, refer to the User's 
Manual Advanced.

Installing the Software

1 Insert the "Software DVD-ROM" into your 
computer.
A window opens.

2 Select [ActKey] from [Software].

3 Install the software as instructed.

4 Click [Finish].

Starting the Software

1 Click [Start] to select [All Programs] > 
[Okidata] > [ActKey] > [ActKey].
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Setup to use the WSD Scan
The following explains how to set up the PC to use the WSD Scan function. In order to use the WSD 
Scan function, install this device on the PC.

WSD Scan can be used from Scan To Local PC and Scan To Remote PC via Network.

To use WSD Scan, the machine has to be connected with the computer which Windows Vista/ 
Windows7/ Windows8/ Windows Server 2008/ Windows Server 2008R2/ Windows Server 2012 was 
installed via Network.

Reference

 Before starting the following procedure, be sure to check the network connection. For details, see "Network 
Connection" P. 47.

Note

 If a scanner is used via WSD Scan connection and if the device IP address is changed, select [Uninstall] in step 2 of 
Installation procedure and uninstall the scanner, and then execute the install procedure again.

Installation procedure

Memo

 When you follow the procedure below, the WIA is installed 
automatically as the scanner driver.

Note

 Before starting the installation, select [Network and 
Sharing Center] from the Control Panel and make sure 
that Network Search is enabled.

1 From the [Start] menu, select 
[Network]. The devices connected to 
the network are displayed.

2 Right-click the MB491 icon under 
[Multifunction Devices] and select 
[Install].
If the [User Account Control] dialog box is 
displayed, click [Yes].

3 When the balloon message saying that 
the installation is complete is displayed 
on the task bar, click the balloon to check 
the details, and click [Close].

Check the device installation on the machine as 
follows.

4 Press the <SCAN> key on the operator 
panel.

5 Press the  to select [Local PC] and 
then press .

6 Check that [Select A Connecting PC] is 
selected, and press .

7 Press the  to select [From WSD 
Scan], and press .

8 Make sure that the device installation PC 
is displayed as the destination PC.

Memo

 A maximum of 50 PCs can be registered.

OK

OK

OK
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Scanning Methods
This section explains the basic operation of the scan function. In scan mode, you can use five scan 
functions, scan to e-mail, scan to USB memory, scan to network computer, scan to local computer and 
PC scan. You can select these functions after pressing <SCAN> key.

Reference

 The scan function supports the Continuous Scan mode. For details on the [Continuous Scan] functions, refer to 
"Enabling Continuous Scan Mode (Continuous Scan)" P. 82.

Scan to E-mail
You can scan a document and attach it to an 
e-mail.

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Make sure [E-mail] is selected and then 
press .

Memo

 Here you can add addressees by using one-touch keys.  
You can add addresses with [To]. Thereafter, you can add 
multiple addresses using the one-touch keys.

4 Make sure [Add Destination] is 
selected and then press .

5 Make sure [To] is selected and then 
press .

Press the  to select [Cc] or [Bcc] and 
then press .

6 Specify a destination.
You can specify a destination by direct input or 
from the address book, groups, e-mail histories, 
LDAP or one-touch key.

7 Press  or .

Specifying a Destination

You can specify a destination in the following six 
ways:

 Using the address book
 Using a group list
 Using the e-mail history
 Direct input
 Using LDAP search
 Using the one-touch key pad

Perform any of the following operations at step 6 
of "Scan to E-mail" stated above.

Using the Address Book or Group 
List

You can select a destination from the address 
book or group list. Be sure to register them in 
advance.

Reference

 For how to register destinations in the address book or 
group list, refer to "Registering Address Book" P. 119.

1 Press the   to select [Address book] 
or [Group list] and then press .

2 Press the  to select the destination or 
group you want and then press .
The check box is selected. You can select multiple 
entries.

3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

5 Press the  to return to start screen.

Using E-mail History
You can select a destination from transmission 
histories.

1 Press the  to select [Tx History] and 
then press .

2 Press the  to select a destination and 
then press .
The check box is selected. You can select multiple 
entries.

OK

OK

OK

OK
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OK

OK
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OK

OK
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3 When you have selected all the 
destinations, press the .

4 Check that [Complete] is selected and 
then press .

5 Press the  to return to start screen.

Direct Input
You can enter a destination directly using the 
onscreen keyboard.

1 Press the  to select [Direct Input] and 
then press .

2 Enter a destination e-mail address up to 
80 characters.

Reference

 For how to enter texts, refer to "Entering Text Using the 
Operator Panel" P. 27.

3 Select [Enter] and then press .

4 Press the  to return to start screen.

Using LDAP Search
You can search for a destination from the list on 
the LDAP server.

You can select either [Simple Search] or 
[Advanced Search] for the method of searching.

[Simple Search] only searches for a single 
keyword as a username. Also, with Simple 
Search you can only search for character strings 
included in usernames. You cannot search for 
character strings in e-mail addresses.

When you select [Advanced Search], you can 
search for a user name or e-mail address. You 
can also select search conditions to retrieve only 
results that contain all the specified keywords.

Reference

 For the LDAP server setting, refer to User's Manual 
Advanced.

For Simple Search

1 Press the  to select [LDAP] and then 
press .

2 Check that [Simple Search] is selected 
and press .

3 Enter a keyword to search for a user 
name on the LDAP server.

4 Select [Enter] and then press  to start 
searching.

5 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
entries.

6 When you have selected all the 
destinations, press the .

7 Check that [Complete] is selected and 
then press .

8 Press the  to return to start screen.

For Advanced Search 

1 Press the  to select [LDAP] and then 
press .

2 Press  to select [Advanced Search] 
and then press . 

3 Check that [Simple Search] is selected 
and press .

4 Select either [OR] or [AND] and 
press .

5 Press , select [User Name], and then 
press .

6 Enter the keyword to search for.

7 Select [Enter] and then press .

8 Press , select [E-mail Address], and 
then press .

9 Enter the keyword to search for.

10 Select [Enter] and then press .

11 Press  to start searching.

12 When the search results appear, press 
the  to select the destination you want 
and then press .
The check box is selected. You can select multiple 
addresses.

13 When you have selected all the 
destinations, press the .

14 Check that [Complete] is selected and 
then press .

15 Press the  to return to start screen.
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Scan to Network PC
You can send a scanned document to a server on 
the network. 
The document is scanned and converted to a 
PDF, JPEG, TIFF, or XPS file. The factory default 
setting is PDF.

Note

 Check that the machine is connected to the network.

 It is necessary to set up Scan To Network PC in advance.

Reference

 For the Scan To Network PC setup, please refer to "Setting 
Up Scan To Network PC" P. 68.

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Network PC] and 
then press .

4 Check that [Select Profile] is selected 
and then press .

5 Press the  to select a profile and then 
press .

6 Press  or .

Scan to USB Memory
You can save the scanned document in a USB 
memory.

Reference

 For the specifications of USB memory that you can use, please 
refer to "Print From USB Memory Specifications" P. 188.

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Insert the USB memory into the USB 
memory interface of the machine.

Note

 Insert the USB memory into the USB port straight. If it 
is not inserted with the correct angle, the USB port 
may be damaged.

4 Press the  to select [USB Memory] 
and then press .

5 Press the  to scanning settings if 
necessary.

6 Press  or .

7 Remove the USB memory from the port 
after the message is displayed indicating 
that it is OK to remove the USB memory.

OK

OK
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Scan to Local PC
You can save the scanned data into your local computer. 

When you press the  or , the scan 
job starts and the ActKey utility and the TWAIN 
driver start automatically. You can send the 
scanned document to a specified application, 
save it in a specified folder, or send it by fax.

In the WSD Scan connection, you can set an 
application to start and a location where you 
send or store documents for each recipient.

The machine can be connected to USB interface 
or network, but only a computer can be 
connected at the same time.

If the Mac OS X is running, the image capture 
and the ICA driver start up automatically.

You can select a folder and save the scanned 
documents in it.

Note

 Connect the machine to a computer via USB or a network.

 Install ActKey and scanner driver before scanning to a 
local computer.

 If you connect the machine to network, follow these 
instructions.

- Set [TCP/IP] setting to [Enable].

- Conform the IP version of the machine to that of your 
computer.

- Set up the DNS server.

- Enable the network TWAIN setting.

 If the Mac OS X is running, you can scan a document in 
the fixed A4 size only on the document glass.

 If the Mac OS X 10.7 to 10.8 is running and if you scan 
documents through network connection, you need to start the 
image capture first. Then, you need to select the machine 
from the list displayed at the left of image capture screen.

 To use the MFP in WSD Scan connection, set the followings.

- Set the [TCP/IP] setting of the MFP to [Enable].

- Match the IP version between the MFP and the PC.

- Enable the WSD Scan.

- Install the MFP on the PC.

Reference

 For details on how to enable the network TWAIN setting, 
refer to the User's Manual Advanced.

 For details on how to install the ActKey utility, refer to the 
User's Manual Advanced.

 For the procedure to enable WSD Scan, see the "User's 
Manual, Applications."

 For the procedure to install the MFP on the PC, see "Setup 
to use the WSD Scan" P. 108.

Connecting via USB

1 Press the <SCAN> key on the operator panel.

2 Place your document with text face up in the 
ADF or face down on the document glass.

3 Press the  to select [Local PC] and 
then press .
If the Network TWAIN setting is set to [Disable], 
proceed to step 6.

4 Check that [Select A Connecting PC] is 
selected and then press .

5 Press the  to select [From USB 
Interface] and then press .

6 Press the  to select [Select An 
Application] and then press .

7 Press the  to select where to send the 
scanned document and then press .

Note

 If the Mac OS X is running, you can select Folder only.

8 Press  or .

Memo

 If you select [Application], the specified application starts 
and the scanned image is displayed on the application.

 If you select [Folder], the scanned image is saved in the 
specified folder. 

 If you select [PC-FAX], the application for fax 
transmission starts. After sending the scanned image, 
send a fax with the fax transmission software on your 
computer.

Connecting via Network

1 Press the <SCAN> key on the operator panel.

2 Place your document with text face up in the 
ADF or face down on the document glass.

3 Press the  to select [Local PC] and 
then press .

4 Check that select [Select A Connecting 
PC] is selected and then press .

5 Check that [From Network] is selected 
and then press .

6 Press the  to select the computer you 
want and then press .

MONO COLOR
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 Application    Folder     PC-FAX
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7 Press the  to select [Select An 
Application] and then press .

8 Press the  to select where to send the 
scanned document and then press .

9 Press  or .

Memo

 If you select [Application], the specified application starts 
and the scanned image is displayed on the application. 

 If you select [Folder], the scanned image is saved in the 
specified folder. 

 If you select [PC-FAX], the application for fax transmission 
starts. After sending the scanned image, send your fax with 
the fax transmission software on your computer.

WSD Scan connection

1 Press the <SCAN> key on the Operation 
Panel.

2 Place the original on the automatic 
document feeder or on the scanner glass.

3 Press the  to select [Local PC] and  
then press .

4 Check that the [Select A Connecting 
PC] is selected, and press .

5 Press the  to select [From WSD Scan] 
and then press .

6 Press the  to select the destination PC 
and then press .

7 Press the  to select [Duplex Scan] 
and then press .

8 Press the  or  to select [ON] or 
[OFF] and then press .

9 Press  or .

Memo

 To start the dual-sided scan, turn its setting On and place 
the original on the automatic document feeder. If you turn 
the dual-sided scan On but place the document on the 
scanner glass, you cannot scan the dual sides of document.

 When using the scanner application on PC, it will be 
scanned by the scanner type of scan profile setup on PC, 
regardless of where the document is set or the setting of 
[Duplex Scan].

Scan to Remote PC
This will launch the Scanner driver from a utility 
installed on the PC (ActKey, PaperPort, Image, 
Adobe Photoshop CS3, etc.) and will begin scanning.
Connect the machine to a computer via USB or a 
network.
TWAIN (USB connection and Network 
connection) and WSD Scan are supported.

There are 3 Modes of Operation:
Simple Scan Mode, Manual Scan Mode, and 
Secure Scan Mode.

In Simple Scan Mode, the scanning can be 
started from all computers via USB, Network and 
WSD Scan connection, without special operation 
on the operator panel.
In Manual Scan Mode, the scanning can be 
started from all computers via USB, Network and 
WSD Scan connection.
In Secure Scan Mode, scanning can only be 
performed by a machine among the already 
registered computers in the network via USB, 
Network and WSD Scan connection.

Only one computer can be connected at the 
same time.

Memo

 For the following procedure, ActKey will be used as an 
example for Windows, and Adobe Photoshop CS3 for Mac 
OS X. The items in this manual may differ depending on 
the application you are using.

Note

 Connect the machine to a computer via USB or a network.
 Install an application (ActKey, PaperPort, etc.) and a 

scanner driver before starting a scan job. This installation 
is NOT required for WSD Scan connection.

 If you connect the machine to network, follow these 
instructions.
- Set [TCP/IP] setting to [Enable].
- Conform the IP version of the machine to that of your 

computer.
- Set up the DNS server.
- Enable the network TWAIN setting.

 When in Secure Scan Mode, the administrator needs to 
register the computer information for carrying out security 
scans from the control panel or the web site beforehand.

 For Mac OS X, when carrying out a network scan for the 
first time, you need to set the connection target when 
using a driver. When you use the driver for the first time, 
the connection target selection tool will launch. 
You do not need to set the connection target after the first 
time.

 To operate the MFP in the WSD Scan connection, set the 
followings.
- Set the [TCP/IP] setting of the MFP to [Enable].
- Match the IP version between the MFP and the PC.
- Enable the WSD Scan.
- Install the MFP on the PC.

Reference

 For details on how to install a scanner driver, refer to 
"Installing Scanner Drivers (TWAIN/WIA/ICA Driver)" P. 104.
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Simple Scan Mode

 For Windows

1 Start ActKey on your computer.

2 Click the scan button you want.
The scan job starts.

Memo

 If you select [Application1] or [Application2], the 
specified application starts and the scanned document is 
displayed on the application. 

 If you select [Folder], the scanned document is saved in 
the specified folder. 

 If you select [PC-FAX], the application for fax 
transmission starts and the scanned document is sent to 
the application. Send your fax with the fax transmission 
software on your computer.

 For Mac OS X (MB441, MB451, 
MB451w, MB461, MB471, MB471w, 
MB491, MB491+, ES4161 MFP, 
ES4191 MFP, MPS4200mb)

1 Start Adobe Photoshop CS3 on your 
computer.

2 Select [Import] from [File] to select 
[OKI MB4x1_ES41x1_MPS42x USB] 
or [OKI MB4x1_ES41x1_MPS42x 
Network]. 

- If you select [OKI MB4x1_ES41x1_MPS42x 
USB], proceed to step 10.

- If you select [OKI MB4x1_ES41x1_MPS42x 
Network] and the network scan is the second or 
more scanning, proceed to step 10.

3 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

4 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

5 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MB4x1_ES41x1_MPS42x Network].
The window appears.

6 Click a scan button.

Scanning starts.

7 Select [Quit Photoshop] from 
[Photoshop].

 For Mac OS X (MB461+LP, 
MB491+LP, MPS4700mb)

1 Start Adobe Photoshop CS3 on your 
computer.

2 Select [Import] from [File] to select 
[OKI MB4x1+LP_MPS47x USB] or 
[OKI MB4x1+LP_MPS47x Network]. 

- If you select [OKI MB4x1+LP_MPS47x USB], 
proceed to step 10.

- If you select [OKI MB4x1+LP_MPS47x 
Network] and the network scan is the second or 
more scanning, proceed to step 10.

3 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

4 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

5 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MB4x1+LP_MPS47x Network].
The window appears.

6 Click a scan button.

Scanning starts.

7 Select [Quit Photoshop] from 
[Photoshop].

 For WSD Scan

1 Start any scan program on the PC.

2 Click a scan button. The document scan 
starts.

Note

 If the machine failed to scan, please check to see if the 
panel is in operation.

Scan Button Name:
Application1, Application2, Folder, PC-
Fax
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Manual Scan Mode

 For Windows

1 Press the <SCAN> key on the operator panel.

2 Place your document with text face up in the 
ADF or face down on the document glass.

3 Press the  to select [Remote PC] and 
then press .

4 Check that the [TWAIN] is selected, and 
press .

5 Start ActKey on your computer.

6 Click the scan button you want.
The scan job starts.

Memo

 If you select [Application1] or [Application2], the 
specified application starts and the scanned document is 
displayed on the application. 

 If you select [Folder], the scanned document is saved in 
the specified folder. 

 If you select [PC-FAX], the application for fax 
transmission starts and the scanned document is sent to 
the application. Send your fax with the fax transmission 
software on your computer.

 For Mac OS X (MB441, MB451, 
MB451w, MB461, MB471, MB471w, 
MB491, MB491+, ES4161 MFP, 
ES4191 MFP, MPS4200mb)

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
then press .

4 Check that the [TWAIN] is selected, and 
press .

5 Start Adobe Photoshop CS3 on your 
computer.

6 Select [Import] from [File] to select 
[OKI MB4x1_ES41x1_MPS42x USB] 

or [OKI MB4x1_ES41x1_MPS42x 
Network]. 

- If you select [OKI MB4x1_ES41x1_MPS42x 
USB], proceed to step 10.

- If you select [OKI MB4x1_ES41x1_MPS42x 
Network] and the network scan is the second or 
more scanning, proceed to step 10.

7 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

8 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

9 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MB4x1_ES41x1_MPS42x Network].
The window appears.

10 Click a scan button.

Scanning starts.

11 Select [Quit Photoshop] from 
[Photoshop].

 For Mac OS X (MB461+LP, 
MB491+LP, MPS4700mb)

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
then press .

4 Check that the [TWAIN] is selected, and 
press .

5 Start Adobe Photoshop CS3 on your 
computer.

6 Select [Import] from [File] to select 
[OKI MB4x1+LP_MPS47x USB] or 
[OKI MB4x1+LP_MPS47x Network]. 

- If you select [OKI MB4x1+LP_MPS47x USB], 
proceed to step 10.

- If you select [OKI MB4x1+LP_MPS47x 
Network] and the network scan is the second or 
more scanning, proceed to step 10.

7 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

Scan Button Name:
Application1, Application2, Folder, PC-
Fax
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8 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

9 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MB4x1+LP_MPS47x Network].
The window appears.

10 Click a scan button.

Scanning starts.

11 Select [Quit Photoshop] from 
[Photoshop].

 For WSD Scan

1 Press the <SCAN> key on the Operation 
Panel.

2 Place the original on the automatic 
document feeder or on the scanner glass.

3 Press the  to select [Remote PC] and 
then press .

4 Press the  to select [WSD Scan] and 
then press .

5 Start any scan program on the PC.

6 Click a scan button. The document scan 
starts.

Secure Scan Mode (For Network 
Connection)

 For Windows

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that the [TWAIN] is selected, and 
press .

5 Check that [Select a connecting PC] is 
selected and then press .

6 Check that [From Network] is selected 
and then press .

7 Press the  to select the destination you 
want and then press .

8 Press  or .

9 Start the ActKey on your computer.

10 Click a scan button.

 For Mac OS X (MB441, MB451, 
MB451w, MB461, MB471, MB471w, 
MB491, MB491+, ES4161 MFP, 
ES4191 MFP, MPS4200mb)

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that the [TWAIN] is selected, and 
press .

5 Check that [Select a Connecting PC] is 
selected and then press .

6 Check that [From Network] is selected 
and then press .

7 Press the  to select the destination you 
want and then press .

8 Press  or .

9 Start the Adobe Photoshop CS3 on your 
computer.

10 Select [Import] from [File] to select 
[OKI MB4x1_ES41x1_MPS42x 
Network].
If you select [OKI MB4x1_ES41x1_MPS42x 
Network] and the network scan is the second or 
more scanning, proceed to step 13.

11 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

12 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

13 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MB4x1_ES41x1_MPS42x Network].
The window appears.
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14 Click a scan button.
Scanning starts.

15 Select [Quit Photoshop] from 
[Photoshop].

 For Mac OS X (MB461+LP, 
MB491+LP, MPS4700mb)

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that the [TWAIN] is selected, and 
press .

5 Check that [Select a Connecting PC] is 
selected and then press .

6 Check that [From Network] is selected 
and then press .

7 Press the  to select the destination you 
want and then press .

8 Press  or .

9 Start the Adobe Photoshop CS3 on your 
computer.

10 Select [Import] from [File] to select 
[OKI MB4x1+LP_MPS47x Network].
If you select [OKI MB4x1+LP_MPS47x 
Network] and the network scan is the second or 
more scanning, proceed to step 13.

11 For the first network scan, the dialog box 
indicating that the tool of connection 
destination selection is started is 
displayed, and then click [OK].

12 Select a connection destination in the 
[Scan Settings] dialog box, and register 
the host information if necessary. Then, 
click [OK]. 

13 Select [Import] from [File] of Adobe 
Photoshop CS3 to select [OKI 
MB4x1+LP_MPS47x Network].
The window appears.

14 Click a scan button.
Scanning starts.

15 Select [Quit Photoshop] from 
[Photoshop].

 For WSD Scan 

1 Press the <SCAN> key on the Operation 
Panel.

2 Place the original on the automatic 
document feeder or on the scanner glass.

3 Press the  to select [Remote PC] and 
then press .

4 Press the  to select [WSD Scan] and 
then press .

5 Start any scan program on the PC.

6 Click a scan button. The document scan 
starts.

Secure Scan Mode (For USB 
Connection)

 For Windows

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in 
the ADF or face down on the document 
glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that the [TWAIN] is selected, and 
press .

5 Check that [Select a connecting PC] is 
selected and then press .

6 Press the  to select [From USB 
interface] and then press .

7 Press  or .

8 ActKey start on the computer.

9 Click the Scan button.

 For Mac OS X (MB441, MB451, 
MB451w, MB461, MB471, MB471w, 
MB491, MB491+, ES4161 MFP, 
ES4191 MFP, MPS4200mb)

1 Press the <SCAN> key on the operator 
panel.
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2 Place your document with text face up in the 
ADF or face down on the document glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that the [TWAIN] is selected, and 
press .

5 Check that [Select a connecting PC] is 
selected and then press .

6 Press the  to select [From USB 
Interface] and then press .

7 Press  or .

8 Start Adobe Photoshop CS3 on your 
computer.

9 Select [Import] from [File] to select 
[MB4x1_ES41x1_MPS42x USB]. 

10 Click a scan button.
Scanning starts.

11 Select [Quit Photoshop] from 
[Photoshop].

 For Mac OS X (MB461+LP, 
MB491+LP, MPS4700mb)

1 Press the <SCAN> key on the operator 
panel.

2 Place your document with text face up in the 
ADF or face down on the document glass.

3 Press the  to select [Remote PC] and 
the press .

4 Check that the [TWAIN] is selected, and 
press .

5 Check that [Select a connecting PC] is 
selected and then press .

6 Press the  to select [From USB 
Interface] and then press .

7 Press  or .

8 Start Adobe Photoshop CS3 on your 
computer.

9 Select [Import] from [File] to select 
[OKI MB4x1+LP_MPS47x USB]. 

10 Click a scan button.
Scanning starts.

11 Select [Quit Photoshop] from 
[Photoshop].

Canceling the Current Scan Job
Scanning will stop while the message saying that 
the document is being read is displayed.

1 Press the <STOP> key on the operator panel.

Note

 You cannot cancel with Scan to Local PC and Scan to 
Remote PC.
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Registering Address Book
This section explains how to register and delete the address book and group list.

You can register e-mails to the address book and create groups for broadcasting messages. The Address 
Book and the Group List can be used to specify the destination in Scan to e-mail and Internet fax 
functions.

Address Book
You can register up to 100 e-mail addresses to 
the address book.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Address Book] 
and then press  .

3 Check that [E-mail Address] is selected 
and then press .

4 Press the  to select a number and then 
press .
You cannot select a number which is specified in 
Auto Delivery function.

5 Check that [Register] is selected and 
then press .
If editing registered addresses, select [Edit].

6 If necessary, specify a name.

a) Check that [Name] is selected and then 

press the .

b) Enter a name up to 16 characters.

c) Select [Enter] and then press .

7 Press the  to select [E-mail Address] 
and then press .

8 Enter an e-mail address up to 80 
characters and then press .

9 Press .

Registering From Transmission 
History

You can add e-mail addresses to the address 
book from e-mail transmission histories.

Note

 The sending history only displays recipient addresses to 
which an e-mail was sent by directly entering the 
recipient's address.

1 Press the <SCAN> key on the operator 
panel.

2 Check that [E-mail] is selected and then 
press .

3 Press the  to select [E-mail Tx 
History] and then press .

4 Press the  to select the entry you want 
and then press .

5 Check the entry and then press the .

6 Make sure [Register To Address Book] 
is selected and then press .

7 Repeat step 4 to 9 in "Registering and 
Editing".
The e-mail address is automatically entered. You 
do not have to enter it manually.

Deleting

1 Press the <SETTING> key.

2 Press the  to select [Address Book] 
and then press .

3 Check that [E-mail Address] is selected 
and then press .

4 Press the  to select an entry number 
and then press .

5 Press the  to select [Delete] and then 
press .

6 Press the  or  to select [Yes] on the 
confirmation screen and then press .

Note

 You cannot delete an e-mail address which is specified in 
Auto Delivery function.
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Group List
You can create up to 20 groups of e-mail addresses.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key.

2 Press the  to select [Address Book] 
and then press .

3 Press the  to select [E-mail Group] 
and then press .

4 Press the  to select a group number 
and then press .

5 Check that [Register] is selected and 
then press .
If editing registered group numbers, select [Edit].

6 Check that [Name] is selected and then 
press the .

7 Enter a name up to 16 characters.

8 Select [Enter] and then press .

9 Press the  to select [Address 
Number] and then press .

10 Press the  to select the desired e-mail address 
from the address book and then press .
The check box is selected. You can select multiple entries.

11 When you have selected all the desired 
e-mail addresses, press the .

12 Check that [Complete] is selected and 
then press .

13 Press .

Memo

 You can also register the e-mail group from [Group 
No] in [E-mail Address].

Deleting

1 Press the <SETTING> key.

2 Press the  to select [Address Book] 
and then press .

3 Press the  to select [E-mail Group] 
and then press .

4 Press the  to select a group number 
and then press .

5 Press the  to select [Delete] and then 
press .

6 Press the  or  to select [Yes] on the 
confirmation screen and then press .

Register all E-mail addresses
All contents of the E-mail Address Book can be 
registered by using Configuration Tool. For setting 
up of Configuration Tool, see User's Manual 
(Advanced), "7. Useful Software".

Registering the Machine

When using the Configuration Tool or introducing a new 
machine, register the machine in the Configuration Tool. 

1 Select [Start], [All Programs]> 
[Okidata]>[Configuration Tool]> 
[Configuration Tool].

2 Select [Register Device] from the [Tools] menu.
Search results are displayed.

3 Select the machine and click on [Register].

4 On the confirmation screen, click on [Yes].

Importing Addresses from a File

1 Select from which device to import, from 
[Registered Device Table].

2 Select the [User Setting] tab.

3 Click on [E-mail Address Manager].

4 Enter the administrator password and click [OK].

5 Click .

6 Select [Open] from [Select CSV File].

7 Select the file you want to import and click on [Open].

8 Click on [Next].

9 Select the settings to import and click [Import].

10 Click .

Memo

 CSV files exported by Outlook Express (Windows email and 
Windows Live  email) can also be restored.

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK



Registering Network Scan Destinations

- 121 -

S
can

n
in

g

4

Registering Network Scan Destinations
This section explains how to register a PC connected to the Network.

You can register locations on a network to which you can scan documents.

Memo

 You can also register network-connected PCs with ActKey in Network Configuration. You can register or delete network-
connected PCs with Network Configuration; however, you cannot edit them. For details, refer to User's Manual Advanced.

Registering and Editing

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" P. 27.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Network Scan 
Destination] and then press .

3 Press the  to select an IP address or 
domain name and then press .

4 Check that [Register] is selected and 
then press .
If editing registered numbers, select [Edit].

5 Check that [Destination] is selected 
and then press .

6 Enter a destination.
A destination up to 16 characters. 

7 Select [Enter] and then press .

8 Press the  to select [Destination 
Address] and then press .

9 Enter an IP address or a Host PC name.
An IP address or a name up to 64 characters. 

10 Select [Enter] and then press .

11 Press the  to select [Port No.] and 
then press .

12 Enter a port number and then press .

13 Press .

14 Press the  until the top screen is 
displayed.

Deleting

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Network Scan 
Destination] and then press .

3 Press the  to select a number and then 
press .

4 Press the  to select [Delete] and then 
press .

5 Press the  or  to select [Yes] on the 
confirmation screen and then press .

6 Press the  until the top screen is 
displayed.
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5. Using as a Printer
This chapter describes how to print documents from a computer or USB memory.

Printing from a Computer
This section explains how to print from a computer.

Memo

 This section uses Wordpad in Windows and TextEdit in Mac OS X as examples. The display and procedure may differ according 
to the operating system, the applications, and the version of the printer driver you are using.

 For additional information on the setting items on the printer driver, refer to its online help.

Printing

1 Open the file you want to print from an 
application.

2 Configure the print settings on the 
printer driver screen and start printing.
The following explains how to configure the paper 
size, the paper source, and the media weight on 
each printer driver you are using. For how to set 
by each printer driver, refer to the following 
instructions.

For Windows PCL/PCL XPS Printer 
Driver

1 From the [File] menu of an application, 
select [Print].

2 Select the printer driver you want to use.

3 Click [Preferences].

4 On the [Setup] tab, select a paper size 
from [Size].

5 Select a tray from [Source].

6 Select a media weight from [Weight].

7 Click [OK].

8 Click [Print].

For Windows PS Printer Driver

1 From the [File] menu, select [Print] to 
open the print dialog.

2 Select the printer driver you want to use.

3 Click [Preferences].
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4 Select the [Paper/Quality] tab.

5 Select a tray from [Paper Source].

6 Click [Advanced].

7 Click [Paper Size] and select a paper 
size from the drop-down list.

8 Click [Media Type] and select the media 
type from the drop-down list.

9 Click [OK].

10 Click [OK].

11 Click [Print].

For Mac OS X PS Printer Driver

1 From the [File] menu, select [Page 
Setup].

2 Select the printer you want to use from 
[Format For].

3 Select a paper size from [Paper Size] 
and then click [OK].

4 From the [File] menu, select [Print].

5 Select [Paper Feed] from the panel 
menu.

Memo

 If the print dialog contains only two menus and does 
not contain the options you expect to see, click the 
[Show Details] button for Mac OS X 10.7 and 10.8, 
or click the disclosure triangle beside the [Printer] 
menu for Mac OS X 10.5 and 10.6.

6 Select a tray on the [Paper Feed] panel.

7 Select [Printer Features] from the 
panel menu.

8 Select [Insert Options] from [Features 
Sets].

9 Select a media type from [Media Type].
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10 Click [Print].

For Mac OS X PCL Printer Driver

1 From the [File] menu, select [Page Setup].

2 Select the printer you want to use from 
[Format For].

3 Select a paper size from [Paper Size] 
and then click [OK].

4 From the [File] menu, select [Print].

5 Select [Setup] from the panel menu.

Memo

 If the print dialog contains only two menus and does not 
contain the options you expect to see, click the [Show 
Details] button for Mac OS X 10.7 and 10.8, or click the 
disclosure triangle beside the [Printer] menu for Mac OS 
X 10.5 and 10.6.

6 Select a tray from the [Paper Source].

7 Select a media type from the [Media 
Weight] .

8 Click [Print].

Memo

 For general use, [Printer Setting] suffices for a paper 
weight. When you select [Printer Setting], the paper 
weight setting configured on the equipment setting menu 
at the operator panel of the machine is applied.

Reference

 If you select [Auto] for a paper source, the tray with the 
designated paper type is automatically selected. For 
details on the automatic selection of trays, refer to the 
User's Manual Advanced.

 If you select the MP tray for a paper source, the paper must 
be loaded in the MP tray. For details on how to load paper in 
the MP tray, refer to "Loading Paper on the MP Tray (MB451/
MB451w/MB471/MB471w/MB491/MB491+/MB491+LP/
ES4191 MFP/MPS4200mb/MPS4700mb)" on P. 34.

Canceling a Print Job
You can cancel a print job from a computer by 
deleting the job in the job list from the operator 
panel.

1 Press the <PRINT> key on the operator 
panel to open the print menu.

2 Make sure [Job Lists] is selected and 
then press .

3 Press the  to select the job you want to 
cancel and then press .

4 Make sure [Cancel] is selected and then 
press .

5 Press the  or  on the confirmation 
screen to select [Yes] and then press .

Note

 Pages that are ready to be printed on the machine are 
printed without change.

 If the display indicating that data is being printed on the 
operator panel remains for a long time, delete the print job 
on the computer.
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Printing From USB Memory
This section explains how to print from the USB memory. Inserting the USB memory into the machine, 
you can print documents stored in it directly.

Note

 Not all USB memory products are guaranteed to work. (USB memory with security functions is not supported.)

 USB hubs and external USB HDDs are not supported.

 Encrypted PDF is not supported.

Memo

 The following file systems are supported: FAT12, FAT16, FAT32.

 The following file formats are supported: JPEG, PDF (v1.7), M-TIFF (v6 Baseline), PRN (PCL, PS).

 Up to 32 GB capacity of USB memory is supported.

 Up to 100 files in supported file formats stored in USB memory are displayed on the file list.

- If more files are stored in USB memory, the list of the stored files may not be displayed properly.

- USB memory with a directory structure of 20 or more levels may not be read properly.

- Files path exceeding 240 characters may not be read correctly.

 You can select and print one file in your USB memory at a time.

Starting a Print Job

1 Insert the USB memory into the USB 
port on the machine.

Note

 Insert the USB memory straight into the USB port. If 
the USB memory is inserted at an angle, it may 
damage the USB port.

2 Press the <PRINT> key on the operator 
panel to open the print menu.

3 Press the  to select the [Print From 
USB Memory] and then press .

4 Check that [Select Print File] is 
selected and then press .
If a file to be printed is not stored in the folder, 
proceed to step 7.

5 Press the  to select the folder with the 
file to print in it and then press .

6 Press the  to select [Open folder.] and 
then press .
Repeat step 5 and 6 until the file to print is 
displayed.

Memo

 If [Folder Property] is selected, you can check the 
folder information.

7 Press the  to print a file and then 
press .

8 Press the  to select [Select a file] and 
then press .

Memo

 If [File Property] is selected, you can check the file 
information.

9 Perform print settings if necessary.

Reference

 "Configuring Print Settings" on P. 126 

10 Press  to start printing.

OK

OK

OK

OK

OK

OK

MONO
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11 Remove the USB memory from the port 
after a message is displayed indicating 
that it is OK to remove the USB memory.

Configuring Print Settings
You can configure the settings for printing from 
USB memory on the [Print Setup] menu. 
Perform the following procedure at step 9 of 
"Printing From USB Memory" on P. 125 in 
"Starting a Print Job".

Changing the Paper Type (Paper 
Feed)

You can select the paper source.

Note

 When printing a PRN file, the setting of the paper tray 
follows the driver settings at the time of file creation.

1 Press the  to select [Print Setup] and 
then press .

2 Check that [Paper Feed] is selected and 
then press .

3 Press the  to select the desired value 
and then press .

4 Press the  to return to the start screen.

Memo

 [Tray 2] is displayed only when the second tray unit is 
installed as an option.

Changing the Number of Copies 
(Copies)

You can set the number of copies to print.

1 Press the  to select [Print Setup] and 
then press .

2 Press the  to select [Copies] and then 
press .

3 Enter a number of copies and then press .
You can enter 1 to 999.

4 Press the  to return to the start screen.

Doing Duplex Printing (Duplex)

You can make 1-sided (simplex) or 2-sided 
(duplex) printouts.

Note

 When printing a PRN file, setting of double-sided printing 
follows the driver settings at the time of file creation.

1 Press the  to select [Print Setup] and 
then press .

2 Press the  to select [Duplex] and then 
press .

3 Press the  to select [ON] for duplex 
printing or [OFF] for simplex printing 
and then press .

4 Press the  to return to the start screen.

Setting the Binding Position (Binding)

You can select the binding position of duplex 
printouts.

1 Press the  to select [Print Setup] and 
then press .

2 Press the  to select [Binding] and 
then press .

3 Press the  to select [Long edge bind] 
to bind at the long edge of the paper or 
[Short edge bind] to bind at the short 
edge of the paper and then press .

4 Press the  to return to the start screen.

Reference

 For details on long edge binding and short edge binding, 
refer to "Making Duplex Copies (Duplex Copy)" on P. 83.

Fitting Pages (Fit)

You can match the page size to the paper size 
when printing.

If the page size of a file to print is larger or 
smaller than the effective print area, the page 
size is resized to fit the paper size.

Note

 When printing a PRN file, these settings do not work.

Memo

 This function is set to [ON] by default.

1 Press the  to select [Print Setup] and 
then press .

Selectable Paper Tray Values:
Tray 1*    Tray 2    MP Tray

*indicates the factory default.

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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2 Press the  to select [Fit] and then 
press .

3 Press the  to select [ON] for matching 
the paper size or [OFF] for not resizing 
the page size and then press .

4 Press the  to return to the start screen.

Canceling a Print Job
You can cancel a print job from the USB memory 
by pressing the <STOP> key on the operator 
panel.

Printing will stop while a message is displayed 
saying that printing is finished.

1 Press the <STOP> key on the operator 
panel.

Note

 Pages that are ready to be printed on the machine are 
printed without change.

OK

OK
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6. User Authentication and Access 
Control

This chapter explains the user authentication and access control functions.

About User Authentication and Access Control
The user authentication and access control functions allow you to limit the functions available to each 
user. If the access control is enabled, the user authentication is required before using the machine. If 
the authentication succeeds, only functions specified in advanced can be used.

Your machine has the following two methods of user authentication:

 PIN (personal identification number)

 User name and password

To control access to the machine, register a PIN (personal identification number) or a user name and 
password to each user in advance. You can register up to 100 PINs and 100 sets of user name and 
password.

If the access control is enabled, according to the setting, the user must enter the PIN or the user name 
and password to log into the machine or to print from a computer.

Access control can be applied to the following functions:

 Copying

 Faxing

 Scanning to e-mail

 Scanning to USB memory

 Scanning to network PC

 Printing

 Printing from USB Memory

 Scanning to internetFax

 Scanning to FaxServer

Note

 Settings for sending faxes also apply to sending faxes from a computer.

The following conditions are required to enable the user authentication and access control functions:

 Configuration Tool on Network/USB connected computers (PIN/Username and password)

 Website (PIN)

Reference

 For details on Configuration Tool, refer to the User's Manual Advanced.
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Authentication by PIN
This section explains how to enable the access control using the authentication by PIN and how to 
operate when the access control is enabled.

Registering a PIN
Before enabling the user authentication and 
access control, be sure to register a PIN for each 
user. You must be the administrator to register 
PINs.

To register a PIN, launch PIN Manager from 
Configuration Tool.

Reference

 For details on how to register a PIN from Configuration 
Tool, refer to the User's Manual Advanced.

Memo

 You can also register a PIN from a web browser or Print 
Job Accounting.

Enabling Access Control
You must be the administrator to control access 
to the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup] 
and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [Management] 
and then press .

6 Press  to select [System Setup] and 
then press .

7 Check that [Access Control] is selected 
and then press .

8 Press the  to select [PIN] and then 
press .

9 Press the  until the message of "Access 
Control has been enabled." is displayed.

Operation When PIN 
Authentication Is Enabled

Logging Into the Machine

 For General Users

1 Enter your PIN No. using the ten-key pad 
on the operator panel.

2 Press .
If authentication succeeds, the top screen 
appears.

 For the Administrator

1 Enter "000000" using the ten-key pad on 
the operator panel.
The PIN No. of the administrator is "000000". You 
cannot change the value.

2 Press .

3 When the password entry screen 
appears, enter the administrator 
password.
The default password is "aaaaaa".

4 Select [Enter] and then press .
If authentication succeeds, the top screen 
appears.

Logging Out of the Machine

When you have finished operations, be sure to 
log out of the machine.

1 Press the  until the top screen appears.

2 Press the <RESET/LOG OUT> key on 
the operator panel.

OK

OK

OK

OK

OK

OK

OK

OK

OK
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3 Press the  or  on the confirmation 
screen to select [Yes] and then press .

Memo

 After a certain period of time, the machine automatically 
logs out users.

Operation From a Computer

To control access to operations from a computer, 
you need to install Print Job Accounting Client on 
the computer in advance.

Memo

 The authentication type specified on the computer 
overrides the one specified on the machine.

Reference

 For details on Print Job Accounting, refer to the User's 
Manual Advanced.

Printing (for Windows)
Memo

 This procedure uses NotePad and PCL driver as an 
example. The procedures and menus may differ depending 
on the OS you use.

1 Click [Start] > [All Programs] > 
[Okidata] > [Print Job Accounting 
Client] > [Change Job Accounting 
Mode].
On the [User Account Control] window, click 
[Yes]. (Click [Continue] for Windows Vista.)

2 Select the printer driver you want in 
[Driver].

3 Select the [Tab] check box and then 
click [Change].

4 Click [OK].

5 From the [File] menu, select [Close].

6 Click [Start] and select [Devices and 
Printers].

7 Right-click the OKI MB491 icon and 
select [Printer properties] > [OKI 
MB491(*)].
* Select the type of driver you want.

8 Select the [Job Accounting] tab.

9 Enter the user name in [User Name] 
and the PIN in [Job Account ID].

10 Click [OK].

11 Open the file you want to print.

12 From the [File] menu, select [Print].

13 Select the printer driver you selected in 
step 7 and then click [Print].

Printing (For Mac OS X PS Driver)
Memo

 This procedure uses Text Edit as an example. The 
procedures and menus may differ depending on the OS 
you use.

1 Put the Software DVD-ROM into the 
computer.

2 Double click on the [OKI] icon on your 
desktop.

3 Double-click on [Utilities].

4 Copy the [Print Job Accounting 
Client] folder by dragging and dropping 
to your Applications folder.

5 Open the [Print Job Accounting 
Client] folder you opened, and double 
click on [Print Job Accounting Client].

6 Click [New].

7 Enter the username into [UserName] 
and enter the PIN into 
[JobAccountingID].

8 Click [Save].

OK
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9 Click [Save].

10 If a message is displayed asking you to 
input the user password, enter the 
password and click [OK].

11 Open the file to print.

12 Select [Print] from the [File] menu.

13 Select your machine and click [Print].

Printing (for Max OS X PCL Driver)

1 From the [File] menu of an application, 
select [Print].

2 Select the [Job Options] panel.

3 Press the [Advanced] button.

4 Enter the user name into [User Name], 
and enter the PIN into [Job Account ID].

5 Click [OK].

6 Click [Print].

Sending Faxes from Your Computer 
(Windows only)
Memo

 In the following procedure, Notepad is used as an 
example. The items here may differ depending on the 
application you are using.

1 Click [Start] > [All Programs] 
[Okidata] > [Print Job Accounting 
Client] > [Change Job Accounting 
Mode].
On the [User Account Control] window, click 
[Yes].

2 Select the printer driver you want in 
[Driver].

3 Select the [Tab] check box and then 
click [Change].

4 Click [OK].

5 From the [File] menu, select [Close].

6 Click [Start] and select [Devices and 
Printers].

7 Right-click the OKI MB491 icon and 
select [Printer properties] > [OKI 
MB491(*)].

8 Select the [Job Accounting] tab.

9 Enter the user name in [User Name] 
and the PIN in [Job Account ID].

10 Click [OK].

11 Open the file you want to fax.

12 From the [File] menu, select [Print].

13 Select the printer driver you selected in 
step 7 and then click [Print].

Reference

 For details on how to send a fax from a computer, 
refer to the User's Manual Advanced.
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Authentication by User Name and Password
This section explains how to enable the access control using the authentication by the user name and 
password and how to operate when the access control is enabled.

Registering User Name and 
Password

Before enabling user authentication and access 
control, be sure to register a user name and a 
password for each user. You must be the 
administrator to register user names and 
passwords.

To register a user name and password, launch 
PIN Manager from Configuration Tool.

Reference

 For details on how to register a user name and password 
from Configuration Tool, refer to the User's Manual 
Advanced.

Enabling Access Control
You must be the administrator to control access 
to the machine.

1 Press the <SETTING> key on the 
operator panel.

2 Press the  to select [Admin Setup] 
and then press .

3 Enter the administrator password.
The default password is "aaaaaa".

4 Select [Enter] and then press .

5 Press the  to select [Management] 
and then press .

6 Press the  to select [System Setup] 
and then press .

7 Check that [Access Control] is selected 
and then press .

8 Press the  to select [User/Password] 
and then press .

9 Press the  to select [User 
Authentication Method] and then 
press .

10 Check that [Local] is selected and then 
press .

Reference

 When you select [LDAP] or [Secure Protocol], the 
server settings are necessary. For details, refer to the 
User's Manual Advanced.

11 Press the  until the message of "Access 
Control has been enabled." is displayed.

Operation When User Name and 
Password Authentication is Enabled

Logging Into the Machine

1 Check that [User Name] is selected and 
then press the .

2 Enter your name.

3 Select [Enter] and then press .

4 Check that [Password] is selected and 
then press the .

5 Enter your password.

6 Select [Enter] and then press .

7 Press on the [Login] screen, press .
If authentication succeeds, the top screen 
appears.

Reference

 For details on how to enter text, refer to "Entering Text 
Using the Operator Panel" on P. 27.

Logging Out of the Machine

When you have finished operations, be sure to 
log out of the machine.

1 Press the  until the top screen appears.

2 Press the <RESET/LOG OUT> key on 
the operator panel.

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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3 Press the  or  on the confirmation 
screen to select [Yes] and then press .

Memo

 After a certain period of time, the machine automatically 
logs out users.

Operation From the Computer

Memo

 The authentication type specified on the computer 
overrides the one specified on the machine.

Printing (for Windows)
Note

 You cannot use the PCL XPS printer driver for this function.

Memo

 This procedure uses NotePad and PCL driver as an 
example. The procedures and menus may differ depending 
on the OS you use.

1 Open the file you want to print.

2 From the [File] menu, select [Print].

3 Select the printer driver you want in 
[Select Printer] and click [Preferences].

4 Select the [Job Options] tab.

5 Click [User Auth].

6 Select the [Use User Authentication] 
check box.

7 Enter the user name in [Username] and 
the password in [Password].
Clicking [Use Windows Login] automatically 
enters your login name on Windows.

8 Click [OK].

9 Click [OK] and then click [Print].

Printing (for Mac OS X)
Memo

 This procedure uses Text Edit as an example. The 
procedures and menus may differ depending on the OS 
you use.

1 Open the file you want to print.

2 From the [File] menu, select [Print].

3 Select your machine's printer driver.

4 Select [User Authentication] from the 
panel menu.

5 Select the [Use User Authentication] 
check box.

6 Enter the user name in [User Name] 
and the password in [Password].

7 Click [Print].

OK
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 Faxing From a Computer
(For Windows Only)
Memo

 This procedure uses NotePad as an example. The 
procedures and menus may differ depending on the OS 
you use.

1 Open the file you want to fax.

2 From the [File] menu, select [Print].

3 Select your machine's fax driver in 
[Select Printer] and click [Preferences].

4 On the [Setup] tab, click [User 
Authentication].

5 Select the [Use User Authentication] 
check box.

6 Enter the user name in [Username] and 
the password in [Password].
Clicking [Use Windows Login] automatically 
enters your login name on Windows.

7 Click [OK].

8 Click [OK] and then click [Print].

Reference

 For details on how to send a fax from a computer, 
refer to the User's Manual Advanced.
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7. Troubleshooting
This chapter provides solutions to the problems you may encounter while operating your machine.

Paper Jams
This section explains how to clear paper jams.

Reference

 For details on the location of each component of the machine, refer to "Cleaning Your Machine" on P. 176.

 For details on the location of each component of the machine, refer to "Names of Components" on P. 15.

Checking Error Messages
When a paper jam occurs, the [Paper jam] or 
[Document jam] message appears on the 
display screen and the <STATUS> key on the 
operator panel blinks. The error code and 
description differ according to where the paper 
jam occurs.

Check the error code that appears from the list 
below and refer to the relevant procedure to 
clear paper jams.

Clearing Paper Jams

Note

 Check that there is no paper remaining inside the 
machine.

 Remove the paper carefully so that it does not tear. If the 
paper tears, be sure to remove all of the pieces.

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

Error Code 370, 371, 372 (Duplex 
paper jam)

1 Remove any documents from the 
document tray.

2 Open the scanner unit.

3 Press the top cover open button(1) and 
open the top cover.

Error 
code Message Reference 

page

370 Paper Jam Occurs: 3##
Open the scanner unit and top 
cover, and check.

Please see Help for details.

P.135

371 P.135

372 P.135

380 P.137

381 P.137

382 P.137

389 P.137

390 P.138

391 Paper Jam Occurs: 3##
Pull out the paper cassette of the 
indicated tray and check.

Please see Help for details.

P.139

392 P.139

Document Jam Occurs.
Please open the scanner unit and ADF 
cover, and check.

Please see Help for details.

P.140

Possible to get burned. 

 Since the fuser unit right is extremely hot, 
perform the operation with care. 

CAUTION

1
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4 Carefully lift out the image drum, complete 
with the toner cartridge. Be careful not to 
touch or scratch the green drum surface.

5 Remove the Image Drum as described in 
step 3, then, remove the Duplex unit (1) 
by raising the coloured handles (2) on 
each side, and then by holding the 
handles and gently lifting it out.

6 Remove any paper and replace the duplex unit.

Note

 Check that there is no paper remaining inside the machine.

 Remove the paper carefully so that it does not tear. If the 
paper tears, be sure to remove all of the pieces.

7 When you return the transcription unit 
into the printer, insert both projections 
(A) of the front end of transcription unit 
into holders of the printer.

8 Insert rear projections , located close 
to both handles of the transcription unit, 
into both mounting holes of the printer.

9 Secure the transcription unit to the 
printer by rotating both handles of the 
transcription unit in the direction of the 
arrow of .

Note

 Do not touch the sponge roller of the transcription unit by 
your hand.

10 Re-install the image drum complete with 
toner cartridge, ensuring that the pegs 
(1 & 2) correctly locate into the slots on 
each side of the printer (3).

Note

 Check that there is no paper remaining inside the machine.

 Remove the paper carefully so that it does not tear. If the 
paper tears, be sure to remove all of the pieces.

11 Close the top cover.

12 Close the scanner unit.
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Error Code 380, 381, 382, 389 
(Paper feed jam)

1 Remove any documents from the 
document tray.

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

4 Carefully lift out the image drum, 
complete with the toner cartridge. Be 
careful not to touch or scratch the green 
drum surface.

5 If the top end of paper is visible at the 
rear side of transparent resist guide, 
rotate the resist guide toward the fuser 
unit and hold the paper top end and 
carefully pull out the paper.

If neither the top or bottom end of paper 
is visible, move the jammed paper in the 
arrow direction as shown. Hold the top 
end of paper with your hands and 
carefully pull out the paper.

If the bottom end of paper is visible, hold 
the paper by your hands and carefully 
pull out the paper.

Note

 Check that there is no paper remaining inside the machine.

 Remove the paper carefully so that it does not tear. If the 
paper tears, be sure to remove all of the pieces.

Paper discharge unit (Paper jammed)

 If the bottom end of paper is visible in the 
printer, hold and pull out the paper 
carefully.

Note

 If paper jams at the paper discharge unit and if the paper 
is visible inside of the top cover, pull out the paper toward 
the inside of the printer.

 If the bottom end of paper is not visible 
but its top end is visible at the paper 
discharge unit, hold the top end of paper 
and pull out the paper carefully. If you 
cannot remove the paper by following 

1
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Steps (A)1 and (A)2, pull out the paper by 
following Steps (B).

 If you have failed to remove jammed 
paper, do not force to pull out the paper 
but follow the steps below.

 Return the image drum cartridge into the 
printer, and close the top cover.

 Turn the printer Power switch OFF (O) first, 
and then turn it ON (I) again. When the motor 
starts to rotate, hold the top end of paper and 
pull out the paper.

Note

 If paper jams when you load it, check to see that no paper 
has been left in the paper feed units. Remember that you 
can release the alarm display only after you have opened 
the top cover first and then closed it again.

6 Re-install the image drum complete with 
toner cartridge, ensuring that the pegs 
(1 & 2) correctly locate into the slots on 
each side of the printer (3).

Note

 Check that there is no paper remaining inside the machine.

 Remove the paper carefully so that it does not tear. If the 
paper tears, be sure to remove all of the pieces.

7 Close the top cover.

8 Close the scanner unit.

Error Code 390 (Paper feed jam 
(Multipurpose tray))

1 Remove any documents from the 
document tray.

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

4 Carefully lift out the image drum, 
complete with the toner cartridge. Be 
careful not to touch or scratch the green 
drum surface.

5 If the top end of paper is visible at the 
rear side of transparent resist guide, 
rotate the resist guide toward the fuser 
unit and hold the paper top end and 
carefully pull out the paper.

(B)1 (B)2

(A)1 (A)2
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If neither the top or bottom end of paper 
is visible, move the jammed paper in the 
arrow direction as shown. Hold the top 
end of paper by your hands and carefully 
pull out the paper.

If the bottom end of paper is visible, hold 
the paper with your hands and carefully 
pull out the paper.

Note

 Check that there is no paper remaining inside the machine.

 Remove the paper carefully so that it does not tear. If the 
paper tears, be sure to remove all of the pieces.

6 Re-install the image drum complete with 
toner cartridge, ensuring that the pegs 
(1 & 2) correctly locate into the slots on 
each side of the printer (3).

7 Close the top cover.

8 Close the scanner unit.

Error Code 391, 392 (Paper feed jam)

Error Code 391 indicates an error in Tray1 and 
Error Code 392 indicates a paper jam in Tray2.

Memo

 The following procedure uses tray 1 as an example.

1 Pull out and remove the paper cassette 
of the indicated tray.

2 Remove jammed paper.

3 Return the tray into the machine.

4 Open the scanner unit.

5 Press the top cover open button (1) and 
open the top cover.

6 Close the top cover.

7 Close the scanner unit.

1
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Document Jam

When you can see the document In 
the Duplex Paper Path

1 Open the ADF cover, and pull the 
document out upward.

When you can see the document 
Inside the ADF

1 Remove any documents from the 
document tray.

2 Open the ADF cover.

3 Hold the jammed document by the top 
edge, and gently pull it out.

If the edge of the document can been seen under 
the paper guide (1), lift the paper guide and then 
pull out the document.

If the edge of the document cannot be seen in the 
ADF, lift the document tray (2) and then pull out 
the document.

Pull down the document tray.

4 Close the ADF cover.

1

2
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Error Messages
This section explains the causes and remedies for the error messages displayed on the display screen 
and the function of the <STATUS> key.

Error Messages Displayed on the Screen

Memo

 In the following lists:

- "%COLOR%" indicates K (black)

- "%TRAY%" indicates tray 1, tray 2 or the MP tray

- "%ERRCODE%" indicates an error code

- "%FS_ERR%", "%CODE%", and "%FATALSTRING1%" indicate detailed information on errors

- "%MEDIA_SIZE%" indicates paper size

- "%MEDIA_TYPE%" indicates a paper type

- "%COVER%" indicates Top Cover or Rear Cover.

 If the displayed message includes "Please see Help for details", you can check countermeasures for the error by pressing the 
<?HELP> key on the operator panel.

 If in the displayed message there is "  to Close", press  on the control plan to remove the error.

Reference

 For details on the function of the <STATUS> key, refer to "Checking the Machine's Status From the <STATUS> Key" on P. 152.

General Error Messages for All Functions

Error 
code Message <Status> 

key Cause/Remedy

Inspection is required.
PU Flash Error

Blinks Firmware error has occurred.
Contact your dealer.

Inspection is required.
PU Communication Error

Blinks Firmware error has occurred.
Contact your dealer.

%COLOR% Toner Low.

Please see Help for details.

Lights 
up*

The toner cartridge of the indicated color is low.
Prepare a new toner cartridge.

* If the <SETTING> key > [Admin Setup] > [Device Man-
agement] > [System setup] > [Near life LED] is set to 
[Disable], the <STATUS> key does not turn on.

Image Drum Unit Near Life.

Please see Help for details.

Lights up* The Image Drum Unit is near the end of its life.
Prepare a replacement image drum.

* If the <SETTING> key >[Admin Setup] > [Device Man-
agement] > [System setup] > [Near Life Status] is set to 
[Enable] and [Near life LED] is set to [Disable], the <STA-
TUS> key does not turn on.

If [Near Life Status] is set to [Disable], this message is not 
displayed and the <STATUS> key does not turn on.

413 %COLOR% Toner Empty
%ERRCODE%

Please see Help for details.

Blinks The toner cartridge of the indicated color is 
empty.
Replace it with a new toner cartridge.
413 : K

%COLOR% Toner Empty

Please see Help for details.

Lights up The toner cartridge of the indicated color is 
empty.
Replace it with a new toner cartridge.

OK OK
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613 %COLOR% Toner cartridge not 
installed. : %ERRCODE%

Please see Help for details.

Blinks The toner cartridge of the indicated color is not 
properly installed.
Reinstall it properly.
613 : K

%COLOR% Toner cartridge not installed.

Please see Help for details.

Lights up The toner cartridge of the indicated color is not 
properly installed.
Reinstall it properly.

%TRAY% Empty.

Please see Help for details.

Lights up The indicated tray is empty.
Load paper in the tray.

File System is full.

Please see Help for details.

Lights up The file system is full.

File System is write protected.

Please see Help for details.

Lights up The file system to which you tried to write is 
write-protected.

Memory Overflow.

Please see Help for details.

 to Close

Blinks The memory has overflowed.
If you are performing other tasks simultaneously, 
finish them and try again. If this does not work, 
reduce the print resolution.

420 Memory Overflow. : 420

Please see Help for details.

 to Close

Blinks The memory has overflowed.
Reduce the print resolution. If this does not 
work, reduce the size of the print data.

Access Limitation Error
Deleted unauthorized user data.

Please see Help for details.

 to Close

Lights up The machine deleted a job of an unauthorized 
user.

Accounting Log Buffer is near full.

Please see Help for details.

Lights up The job accounting log buffer is nearly full.

Accounting Log Buffer Full (Delete old logs) Lights up Delete old accounting logs because the account-
ing log buffer is full.

Accounting Log Writing Error

Please see Help for details.

 to Close

Lights up A job accounting log writing error has occurred.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK
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Disk Use Failed %FS_ERR%

Please see Help for details.

 to Close

Blinks A disk operation error has occurred.

Please check data.
Message Data Write Error : %CODE%.

Lights up Failure to write message data to be uploaded.
Contact your dealer.

Please check %COLOR% Toner Cartridge.

Please see Help for details.

Lights up Something is wrong with the toner sensor of the 
indicated color during printing.
Check that the toner cartridge of the indicated 
color is installed properly.

543 Please check %COLOR% Toner Cartridge. :
%ERRCODE%

Please see Help for details.

Blinks Something is wrong with the toner sensor of the 
indicated color.
Check that the toner cartridge of the indicated 
color is installed properly.
543 : K

547 Please check %COLOR% Toner Cartridge. :
%ERRCODE%

Please see Help for details.

Blinks The toner cartridge of the indicated color is not 
locked properly.
Check that the lock lever is properly slid to the 
left.
547 : K

372
380
381
382
389
390

Paper Jam: %ERRCODE%
Please open the scanner unit and the top 
cover.

Please see Help for details.

Blinks Paper jam has occurred.
Remove the jammed paper.
Error 372 : Misfeed from Duplex
Error 380 : Paper Feed
Error 381 : Transport
Error 382 : Exit
Error 389 : Printing Page Lost
Error 390 : MP Tray
Error 390 : MANUAL

391
392

Paper Jam: %ERRCODE%
Please pull out the paper cassette of the 
indicated tray.

Please see Help for details.

Blinks Paper jam occurred while feeding paper from the 
indicated tray.
Remove the jammed paper.
391 : Tray1
392 : Tray2

310
587

Please check the %COVER%.: %ERRCODE%

Please close the %COVER%.

Please see Help for details.

Blinks The top cover is open.
Close the top cover.
310 : Top Cover
587 : Rear Cover

ADF Cover Open

Please see Help for details.

Blinks The ADF cover is open.
Close the ADF cover.

Power OFF/ON
%ERRCODE%: Error

Blinks An error has occurred in the device.
Turn the machine off and then on again.
If the error is not resolved, contact your dealer.

Inspection is required.
%ERRCODE: Error

Blinks An error has occurred in the device.
Contact your dealer.

Error 
code Message <Status> 

key Cause/Remedy

OK
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Power OFF/ON
%ERRCODE%: Error %FATALSTRING1%

Blinks An error has occurred in the device.
Turn the machine off and then on again.
If the same error occurs, turn the machine off 
and then on again. If the error is not resolved, or 
the same error occurs again, contact your dealer.

Document Jam
Please open the scanner unit and the ADF 
cover.

Please see Help for details.

Blinks A document jam has occurred.
Open the ADF cover, and then remove the 
jammed paper.

Lamp Error. Please call service. 
<%CODE%>

Please see Help for details.

Blinks Indicates that a lamp error has occurred.
This message is displayed because of the light 
intensity of the lamp is weak.
Contact your dealer.

%TRAY% missing.

Please see Help for details.

Lights up A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated tray.
If the cassette is already inserted in the machine, 
pull out the cassette and set it again to correctly 
locate it.

430
440

Please close %TRAY%.: 430,440
To cancel, select [Cancel]

Blinks A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated tray.
If the cassette is already inserted in the machine, 
pull out the cassette and set it again to correctly 
locate it.

Inspection is required.
%ERRCODE%: SIP Error

Blinks Processing of scanned image has failed.
Turn the machine off and then on again.
If the error is not resolved, contact your dealer.

Please call service.
Scanner unit failed to detect printer unit.

Blinks An error has occurred between the scanner and 
printer units.
Turn the machine off and then on again.
If the error is not resolved, contact your dealer.

SIP Firmware Missing Blinks A board failure has been detected.
Turn the machine off and then on again.
If the error is not resolved, contact your dealer.

Wait a moment.
Network initializing ...

Lights up Changed network settings are being stored.

085 Please change SD Memory Card.
Error Code: 085

Lights up The contents of the SD memory card cannot be 
read normally.
If the same card is used further, the same error 
may occur. Replace the SD memory card.

Power OFF/ON
Carriage Error <1>

Please see Help for details.

Blinks Indicates that a carriage error has ocurred.
This message is displayed because of the 
scanner carriage is not working normally.
If the error is not resolved, contact your dealer.

Power OFF/ON
Carriage Error <%CODE%>

Blinks Indicates that the following carriage error has 
occurred.  
 2 : Home position error (carriage connection 
error)
 3 : Scanning start position detection error
If the error is not resolved, contact your dealer.

581 Please close faceup stacker.
581:Cannot print with duplex.

Blinks Although Duplex printing was attempted, the 
FaceUp stacker is open and Duplex printing is 
disabled.

500 Please install paper on
Manual Feeder. Please set paper
(%MEDIA_SIZE%).
To cancel, select [Cancel]

Blinks Manual paper feed is required. Manually insert 
the paper shown by %MEDIA_SIZE%.

Error 
code Message <Status> 

key Cause/Remedy
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Error Messages for Copying

The following messages are displayed on the display screen of the operator panel while using the copy 
function.

Error Messages for Faxing

The following messages are displayed on the display screen of the operator panel while using the fax 
function.

400 Paper Size Error
Please open the scanner unit and the top 
cover
and check paper size.

Please see Help for details.

Blinks Paper of an improper size is being used.
Check the paper in the tray or check for Multiple-
feed. Open and close the cover to perform 
recovery printing, and continue.

347 Please install new Image Drum Unit.

Please see Help for details.

Blinks The Image Drum Unit is at the end of its life.

Decode error occurred.
Please check image data.

 to Close

Lights up An error has occurred during analysis of image 
data entered from outside of the MFP.
For PrintFromUSBMemory or InternetFAX/
E-mailPrint/FaxToPrint (with communication data 
saving), an error has occurred in the TIFF or 
JPEG data analysis.

409 Please open the top cover.
409:Faceup Stacker Error

Blinks Because the Face Up stacker was operated during 
printing, the printing was stopped and an error 
was output.

- Firmware Update Error
Please try again.
If network doesn't work, please try firmware 
update over USB.

Lights up This message indicates that the remote FW 
update failed. 
Scanning function and print function is prohibited. 
However, the process of MJL / PJL command is 
possible.

Error 
code Message <Status> 

key Cause/Remedy

Offline Mode Lights up The machine is off line and cannot start a copy job.
Press the <PRINT> key on the operator panel 
and then select [Online/Offline] on the print 
menu screen.

Do you wish to resume scanning? Lights up Scanning for a copy job was suspended because 
an error occurred, but now the error is resolved.
To restart scanning the remaining documents, 
set the documents in the ADF and then select 
[Yes].

Error 
code Message <Status> 

key Cause/Remedy

Received invalid data.

Please see Help for details.

 to close

Lights up The machine received and deleted unauthorized 
PC fax data. While the machine received the PC 
fax data, the connection with the computer might 
be unstable.
Check the connection between the machine and 
the computer.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK
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Error Messages for Scanning

The following messages are displayed on the display screen while using the scan function.

Communication Error

 to close

Blinks Fax transmission and reception have been 
canceled due to errors. 

Telephone

Please see Help for details.

Lights up The telephone is being used.
Wait for the call on the telephone lines to end.

Memory Overflow.

Please see Help for details.

 to close

Blinks The memory overflowed while receiving PC fax 
data.
Ensure the memory capacity by any of the 
following operations.
 if the time specification for fax transmission is 

set, cancel it.
Delete documents stored in F-code box.
Or this message may be displayed when an error 
occurs in the machine. Release the error.
If the error is not resolved, reduce the data to be 
transmitted as PC Fax.

Offline Mode Lights up The machine is off line and cannot print received 
fax data.
Press the <PRINT> key on the operator panel 
and then select [Online/Offline] on the print 
menu screen.

Memory Overflow has occurred 
during Fax Tx reservation.

 to Close

Blinks A memory overflow occurred during fax memory 
transmission.

Error 
code Message <Status> 

key Cause/Remedy

Cancelling ... Lights up A ScanTo job is being cancelled.

Cancelling sending ... Lights up An e-mail or file transmission is being cancelled.

Memory Overflow

Please see Help for details.

 to close

Blinks The memory overflowed while scanning data.

USB Memory Full

Please see Help for details.

 to close

Blinks The USB memory is full and cannot store data.
Delete unnecessary files from the USB memory, 
or use a USB memory with enough available 
space.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK
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Writing Failed

Please see Help for details.

 to close

Blinks Writing to the USB memory has failed.
Remove the write-protection of the connected
USB memory.

USB Memory disconnected.

Please see Help for details.

 to close

Blinks USB memory is not connected to the machine 
and the machine cannot store data.
Be sure that the USB memory is connected to 
the machine properly.

Connect to PC failed.

Please see Help for details.

 to close

Blinks The machine has failed to connect to a PC.
Be sure that the machine is connected to the PC 
properly.

File Transmission Error

Please see Help for details.

 to close

Blinks A file transmission error has occurred.
Check the network configuration, cable 
connection and status, and the server status.

E-mail Transmission Error

Please see Help for details.

 to close

Blinks An e-mail transmission error has occurred.
Check the network configuration, cable 
connection and status, and the server status.

Please check SMTP settings.

Please see Help for details.

 to close

Blinks An error has occurred while connecting to an 
SMTP server.
Check the network configuration, cable 

connection and status, and the server status.
Check the SMTP settings.

Please check POP3 settings.

Please see Help for details.

 to close

Blinks An error has occurred while connecting to a POP3 
server.
Check the network configuration, cable 

connection and status, and the server status.
Check the POP3 settings.

SMTP Login failed.

Please see Help for details.

 to close

Blinks Login to an SMTP server has failed.
Check the login name and password for the 
server.

SMTP Auth. Unsupported

Please see Help for details.

 to close

Blinks The SMTP server does not support authentica-
tion.

POP3 Login failed.

Please see Help for details.

 to close

Blinks Login to a POP3 server has failed.
Check the login name and password for the 
server.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK

OK

OK

OK

OK
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Getting target IP failed.
Please check DHCP Settings.

Please see Help for details.

Blinks The machine could not get IP address from DHCP 
server.
Check the network configuration, cable 
connection and status, and the server status.

Please check DNS settings.

Please see Help for details.

 to close

Blinks An error has occurred while connecting to a DNS
server, or the machine has failed to obtain IP 
address.
Check the network configuration, cable
 connection and status, and the server status.
Check the DNS settings.
Check the [Target URL] in the profile, and 

check that the computer name has been 
correctly set.

 If there is no DNS server on the network, set 
the IP address, not the computer name, in the 
profile [Target URL].

 If the username is managed from the domain, 
input "Username @ Domainname" on 
[Username] settings.

Please check Server setting.

Please see Help for details.

 to close

Blinks An error has occurred while connecting to a file 
server.
Check the network configuration, cable 

connection and status, and the server status.
Check the server settings.
 If the username is managed from the domain, 

input "Username @ Domainname" on 
[Username] settings.

Server Login failed.

Please see Help for details.

 to close

Blinks Login to file server has failed.
Check the ID and password for the server.

Entering directory failed.

Please see Help for details.

 to close

Blinks The machine failed to access the FTP server 
directory.

Changing data Transfer Type failed.

Please see Help for details.

 to close

Blinks The machine failed to transmit a file to an FTP 
server.
Change the data transfer type for the file.

Not authorized to write file.

Please see Help for details.

 to close

Blinks The machine failed to write to a file.
Check that the username set on the computer 

and the [Username] set on the profile match 
one another.

 It is possible that the settings are configured to 
not allow writing to common folders. Check the 
folder shared settings.

Storage Space Full

Please see Help for details.

 to close

Blinks The storage space of the server is full. The 
machine failed to write to a file.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK

OK
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Please change File Name.

Please see Help for details.

 to close

Blinks A file name was not authorized by the server.
Change the file name.
 If using an FTP server to save data with Scan 

to Network PC, there are some machines that 
cannot be connected correctly due to 
mismatching character codes. Change [Host 
side Japanese Kanji code]. If using a Mac for 
the FTP server, change [Host side Japanese 
Kanji code] to [UTF-8].

Device communication protocol not 
supported.

Please see Help for details.

 to close

Blinks The machine does not support the specified 
server.
If using NAS to save data with Scan to Network 
PC, in rare cases there are machines that cannot 
connect correctly with CIFS. Change the profile 
[CIFS Character Set] to [Shift-JIS] from 
[UTF-16].

Please check Network Share Name.

Please see Help for details.

 to close

Blinks The name of a network shared folder is invalid.
 The machine failed to establish a CIFS 

connection.
Change the name of the shared folder.

Please remove the connected USB 
device.

Unsupported USB device is 
connected.

Blinks Indicates that an unsupported USB device has 
been connected.
This message will be displayed until the 
unsupported USB device disconnected.

Please remove the USB Hub.

USB Hub is connected.

Blinks A USB hub has been connected. This machine 
does not support the USB hub.
Disconnect the USB hub.

Access denied to PC.
Please check PC.

 to Close

Lights up The PushScan request has been rejected by the 
PC.

Wireless startup failed.

Please see Help for details.

Blinks Wireless startup failed.
Restart the device.
 If this does not solve the problem, contact your 

dealer.

This wireless firmware version does 
not operate on this device.

Please see Help for details.

Blinks This wireless firmware version does not work on 
this device.
Contact your dealer.

Wireless settings are incomplete.

Please see Help for details.

Blinks Wireless is not operating because the settings 
are incomplete.
 Try the Wireless Network Selection or 

automatic settings again.
 If this does not solve the problem, initialize the 

network settings, and then try the manual 
settings or automatic settings again.

Not connected to wireless access 
point.

Please see Help for details.

Blinks Not connected to a wireless access point.
Check that the wireless access point power is 

switched on.
Check the wireless access point settings, and 

then try the Wireless Network Selection or 
automatic settings.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK
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Error Messages for Printing

Error 
code Message <Status> 

key Cause/Remedy

Offline Mode Lights up The machine is off line and cannot start a print 
job.
Press the <PRINT> key on the operator panel 
and then select [Online/Offline] on the print 
menu screen.

Error Postscript

 to close

Lights up A Postscript error has occurred.

PDF Cache Write Error

 to close

Lights up Writing failed while caching a PDF, as there was 
no space on the SD card or memory.
 Increase the amount of free capacity on the SD 

memory card. (MB491/MB491+LP/ES4191 
MFP/MPS4200mb/MPS4700mb only).

 Increase the amount of memory (for cases 
other than MB491/MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb).

Error PDF

 to close

Lights up A methodology error has been detected in a PDF.
Please check whether the PDF file opened 
correctly.

Invalid Password

 to close

Lights up This is a PDF file with the encryption function 
enabled.
When printing an encrypted PDF file, open it in 
your computer and then print it.

This document restricts printing to a 
valid owner password.

 to close

Lights up This is a PDF file with the encryption function 
enabled.
When printing an encrypted PDF file, open it in 
your computer and then print it.

Deleting data. Lights up Cancelling received data.

Lights up If a paper jam occurs while the <SETTING> key > 
[Admin Setup] > [Print Setup] > [Print menu] > 
[Printer Adjust] > [Jam Recovery] is set to 
[Disable], the remaining print job is cancelled.

Lights up Cancelling data sent by a user who is not 
authorized by Print Job Accounting to print.

Deleting encrypted job. Lights up Deleting an encrypted job.

File erasing ... Lights up Erasing a secret file.

Erased Data Full

Please see Help for details.

Blinks Secret files to be erased are full.

Expired Secure Job

Please see Help for details.

 to close

Lights up The machine deleted an expired secure job.

OK

OK

OK

OK

OK

OK
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Received invalid data.

Please see Help for details.

 to close

Lights up The machine deleted an expired secure Job.

500 Please install paper on MP Tray. : 490
Please set paper (%MEDIA_SIZE%)
To cancel, select [Cancel]

Blinks The MP tray is empty.
Load the indicated size paper.

460
461
462

Tray Media Mismatch: %ERRCODE%
Please install paper (%MEDIA_SIZE% 
%MEDIA_TYPE%) on %TRAY%.

Blinks The paper size or type in the indicated tray 
differs from that specified for the tray.
Load the indicated size or type of paper.

490
491
492

Please install paper on %TRAY%.
: %ERRCODE% Please set paper
(%MEDIA_SIZE%).
To cancel, select [Cancel]

Blinks The indicated tray is empty.
Load the indicated size paper.

430
440

Please close %TRAY%.: 430,440

To cancel, select [Cancel]

Blinks A paper cassette of the indicated tray is not in 
the machine.
Install the paper cassette.

Access Limitation Error
Data was deleted due
to the printing limitation.
Please see Help for details.

 to close

Lights up A print job sent by a user who is not authorized 
for printing is deleted.

Warming up. Lights up The machine is warming up, or cooling down.
Wait for a while without turning off the machine.
This is not a malfunction of the machine.

Preparing. Lights up The printer unit is not prepared for printing.
Wait until this message disappears.

Access Limitation Error
Deleted unauthorized user data.

Please see Help for details.

 to Close

Lights up Notifies users that jobs have been cancelled 
because they are not permitted for printing. 
(Related to JobAccount).

Notifies users that jobs have been cancelled 
because they are not permitted for PC-Fax. 
(Related to JobAccount).  

USB Memory disconnected.

Please see Help for details.

 to Close

Blinks Indicates that the USB memory has been 
extracted. 
When a USB memory is extracted all over 
ScanToMemory execution, the file saving of 
image file is stopped.

Cannot read the file.

 to Close

Lights up The PrintFromUSBMemory function has failed to 
process due to the failure of destination device or 
others.

Cannot open the file.

 to Close

Lights up The PrintFromUSBMemory function has failed to 
open the specified file.

Error 
code Message <Status> 

key Cause/Remedy

OK

OK

OK

OK

OK

OK
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Checking the Machine's Status From the <STATUS> Key
From the <STATUS> key on the operator panel, you can check the status of your machine.

Checking the Trouble Status

The <STATUS> key blinks or lights up when any trouble is occurring in your machine. Press it to check the 
trouble status.

1 Press the <STATUS> key on the 
operator panel to open the status menu.

2 Be sure that [System Status] is 
selected and then press .

3 Press the  to select the item you want 
to check and then press .

Checking the Device and Job Status

You can check the device status, such as the residual life of the consumable items, and job lists from the 
<STATUS> key.

1 Press the <STATUS> key on the 
operator panel to open the status menu.

2 Press the  to select [Device 
Information] and then press .

3 Press the  to select the item you want 
to check and then press .

OK

OK

OK

OK
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Other Issues
This section explains the issues you may encounter while operating your machine and how to solve them.

Unable to Print from a Computer

Memo

 If the following information does not solve the trouble, contact your dealer.
 For troubles caused by an application, contact the manufacturer of the application.

General Causes

Common to Windows and Mac OS X

 For Windows

Cause Remedy Reference

The machine is in sleep mode. Press the <POWER SAVE> key on the operator panel to 
enter the standby mode.
If the sleep mode is not used, disable it from the <SET-
TING> key > [Admin Setup] > [User Install] > 
[Power Save] > [Sleep].

P.20

The machine is turned off. Hold down the power switch for about a second to turn 
on the power.

P.20

An Ethernet or USB cable is unplugged. Check that the cable is plugged into the machine and 
computer properly.

-

Something is wrong with a cable. Replace it with a new cable. -

The machine is off line. Press the <PRINT> key on the operator panel, and then 
select [On-Line].

-

An error message is displayed on the 
display screen of the operator panel.

"Error Messages Displayed on the Screen" on P. 141 or 
press the <?HELP> key on the operator panel.

P.141

The interface setting is disabled. Check the setting of the interface being used from the 
operator panel.

Advanced

Something is wrong with the print 
function.

Check if you can perform configuration print. P.78

The LED indicator in the power 
switch is blinking at high speed per 
about 0.3 second.

The machine may be malfunctioning.  Unplug the AC 
cord immediately. Contact your dealer.

-

Cause Remedy Reference

The machine is not set as the default printer. Set the machine as the default printer. -

The output port for the printer driver is 
incorrect.

Select the output port to which the Ethernet or USB 
cable is connected.

-

A print job from another interface is in 
progress.

Wait until the print job is done. -

[Received invalid data] is displayed on 
the display screen and printing cannot be 
done.

Press the <SETTING> key and select [Admin Setup] >
[Print Setup] > [Print menu] > [Printer Adjust] > 
[Wait Timeout], and then select a longer time. The 
default setting is 40 seconds.

-

A print job is automatically canceled. If using Print Job Control, the print job is not authorized
to print, or the Job Accounting log buffer may be full.

Advanced
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Network Connection Problems

Common to Windows and Mac OS X

 For Windows

Cause Remedy Reference

The Job Type of "Secure Print", "Store to 
HDD" and "Encrypted Secure Print" are 
unselectable on the MB491.

For Windows PCL Driver
1.Click [Start] > [Devices and Printers].
2.Right-click the [OKI MB491(PCL)] icon and select 
[Printer properties]. (If you have installed multiple 
printer drivers, select [Printer properties] > [OKI 
MB491(PCL)]).
3.Select the [Device Options] tab.
4.For the network connection, select [Get Printer 
Settings].
For the USB connection, add a check to [SD Memory Card].
5.Click [OK].

For Windows PS Driver
1.Click [Start] > [Devices and Printers].
2.Right-click the [OKI MB491(PS)] icon and then select 
[Printer properties]. (If you have installed multiple 
printer drivers, select [Printer properties] > [OKI 
MB491(PS)].)
3.Select the [Device Settings] tab.
4.For the network connection, select [Get installed 
options automatically] under [Installable Options], 
and then click [Setup].
For the USB connection, select [Installed] for [SD 
Memory Card] under [Installable Options].
5.Click [OK].

Advanced

Cause Remedy Reference

Using a crossover cable. Use a straight cable. -

The machine is turned on before a cable 
was connected.

Connect cables before turning on the machine. P.47

The hub and the machine are incompatible 
or have some problem.

Press the <SETTING> key and select [Admin Setup] > 
[Network Menu] > [Network Setup] > [HUB Link 
Setting], and then select [10BASE-T HALF].

-

The network connection setting is wrong. This product cannot connect to a wired LAN and wireless 
LAN at the same time. To connect to a wired network, 
set the network connection to wired. To connect to a 
wireless network, set the network connection to 
wireless.

-

Not connected to a wireless access point. Check that the wireless access point power is switched 
on.

Check the wireless access point settings, and then try 
the manual settings or automatic settings.

Restart the wireless LAN function.
 Press the <SETTING> key and select [Admin Setup] > 

[Network Menu] > [Network Setup] > [Wireless 
Setting], and then select [Reconnect Wireless].

-

Cause Remedy Reference

IP address is incorrect. Check that the same IP address is set for the machine 
and the machine's port setting on the computer.

 If using OKI LPR Utility, check the IP address setting in 
OKI LPR Utility.

P.65
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USB Connection Problems

Common to Windows and Mac OS X

 For Windows

Unable to Install a Printer Driver Successfully

Memo

 If the following information does not solve the trouble, contact your dealer.

 For troubles caused by an application, contact the manufacturer of the application.

USB Connection Problems

 For Windows

All pages are not printed. If you are using the WSD port, change it to the standard 
TCP/IP port.

Cause Remedy Reference

Unsupported USB cable is being used. Use a USB2.0 cable. -

A USB hub is being used. Directly connect the machine to the computer. P.60

Printer driver is not installed correctly. Reinstall printer driver. P.60

Cause Remedy Reference

Cause Remedy Reference

The machine is off line. Right-click the OKI MB491 icon and then select [See 
print jobs] (> [OKI MB491(*)] when multiple drivers 
are installed). In the dialog box, select the [Printer] 
menu and then clear the check of [Use Printer Offline].

*  Select the type of driver you want.

-

A switch, buffer, extension cable or USB 
hub is being used.

Directly connect the machine to the computer. P.60

A printer driver which uses a USB 
connection has been installed.

Remove the other printer driver from the computer. -

Cause Remedy Reference

An icon for the machine is not created 
on the [Devices and Printers] folder.

The printer driver is not installed correctly.
Reinstall the printer driver correctly.

P.60

Only the first printer driver is installed 
even if multiple printer drivers are 
selected to install.

Follow the procedure below to install a second and 
subsequent printer drivers:
1.Insert the "Software DVD-ROM" into the computer.
2.Click [Run setup.exe] and follow the on-screen 
instructions.
3. Select [Custom Installation (Printer)] from 
[Driver Installation].
4. Click [Next].
5. Select [Local Printer] and then click [Next].
6. On the [Select printer port] screen, select [FILE] 
and then click [Next].
7. Complete the setup following the on-screen 

instructions.

-
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Restrictions on Each OS

Restrictions on Windows 8/Windows 7/Windows Vista/Windows Server 
2012/Windows Server 2008 R2/Windows Server 2008

Only the first printer driver is installed 
even if multiple printer drivers are 
selected to install.

8. On the [Devices and Printers], right-click the icon 
of the second or later driver and select [Printer
properties] ( [OKI MB491(*)] when multiple driv-
ers are installed).

*Select the type of driver you want.

9. From the [Ports] tab, select [USBxxx] from the list.
10. Click [OK].

-

The [Unable to install printer driver] 
error message is displayed.

Use Plug-and-Play. Follow the procedure below:
1. Ensure that the machine and computer are turned off.
2. Connect a USB cable.
3. Hold down the power switch for about a second to 
turn on the power.
4. Turn on the computer.
5. When the Found New Hardware Wizard is displayed, 
follow the on-screen instructions to complete the setup.
For details, refer to [README.TXT] in the "Software 
DVD-ROM".

-

Item Symptom Cause/Remedy

Printer drivers [Help] is not displayed. The [Help] function is not supported on PS printer drivers.

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

Network Extension [Help] is not displayed. The [Help] function is not supported.

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start. 

The [Program Capability
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears after 
an installation (including if you stop an installation before it is 
completed), make sure to click [This program installed 
correctly].

PS Gamma Adjuster The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears after 
an installation (including if you stop an installation before it is 
completed), make sure to click [This program installed 
correctly].

Cause Remedy Reference
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Restrictions on Windows Server 2003 Service Pack 1 and Windows XP Service 
Pack 2

Restrictions on Windows Firewall
On Windows Server 2003 Service Pack 1 and Windows XP Service Pack 2, the Windows firewall 
functionality is enhanced. The following restrictions may apply to printer drivers and utilities.

Memo

 The following procedures are explained using Windows XP Service Pack 2 as an example. The procedure and menu names may 
differ on Windows Server 2003 Service Pack 1.

Item Symptom Cause/Remedy

Printer driver You cannot print a file when using the 
machine as a shared printer on a network.

On the server, click [start] and then select 
[Operator panel] > [Security Center] > 
[Windows Firewall].
Select the [Exceptions] tab and select the 
[File and Printer Sharing] check box. Click 
[OK].

OKI LPR Utility Unable to find a machine. If the [Don't allow exceptions] check box is 
selected on the [General] tab of the Windows 
firewall, you cannot search for a machine in a 
segment that is connected to another router. 
Only machines within the same segment as 
the machine are the search target.
When you cannot find a machine, specify the IP
address of the machine in the [Add Printer] or
[Confirm Connections] screen.

Print Super Vision Unable to access the machine from a remote 
computer.

Click [start] and then select [Operator 
panel] > [Security Center] > [Windows 
Firewall].
Select the [Exception] tab and click [Add 
Program]. Select the following files and then 
click [Open] > [OK] > [OK].
 "(J2EE location)\jdk\bin\java.exe"
 "(J2EE location)\jdk\bin\javaw.exe"
 "(J2EE location)\jdk\jre\bin\java.exe"
 "(J2EE location)\jdk\jre\bin\javaw.exe"

Pop-up windows are blocked. If you are using Internet Explorer, pop-up win-
dows may be blocked.
On Internet Explorer, select [Internet 
Options] from the [Tools] menu.
Select the [Privacy] tab and click [Settings] 
on the [Pop-up Blocker] area. On the 
[Popup Blocker Settings] window, enter the 
URL of Print Super Vision in [Address of Web 
site to allow] and then click [Add]. Click 
[Close] > [OK].

Web Driver 
Installer

Unable to find a machine. If the [Don't allow exceptions] check box is
selected on the [General] tab of Windows
Firewall, you cannot search for a machine in a 
segment that is connected to another router.
Only machines within the same segment as 
the machine are the search target.
Enter "*" in the fourth digit of the IP address 
range to search.
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Restrictions on Mac OS X 10.6

Restrictions on Mac OS X 10.5

Restrictions on Mac OS X 10.4

Web Driver 
Installer

Unable to access the machine from a remote 
computer.

Click [start] and then select [Operator 
panel] > [Security Center] > [Windows 
Firewall].
Select the [Exception] tab and click [Add 
Port]. Add the port number of the web site on 
which Driver Installer is installed.
Click [start] and then select [Operator 
panel] > [Performance and Maintenance] 
> [Administrative Tools].
Double-click [Component Services] and 
change the access authority of the component 
for Driver Installer.
For details on how to configure the settings, 
refer to the readme file stored in [start] > [All 
Programs] > [Okidata] > [Driver Installer] 
> [Readme].

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture.  Scan is available only when the computer is 
connected by USB.

 In the image capture, the user interface of 
the TWAIN driver is not displayed. Use the 
user interface of the image capture and 
then scan data.

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture. In the image capture, if the computer is con-
nected to the network, display the user inter-
face of the TWAIN driver before using. 
To display the user interface of the TWAIN 
driver, after starting the image capture, select 
[Browse Devices] from the [Devices] menu 
of the image capture and then open the 
device browser. Select a driver and click use 
[Use TWAIN UI].

Item Symptom Cause/Remedy

TWAIN driver Unable to scan by image capture In the image capture, if the computer is con-
nected to the network, display the user inter-
face of the TWAIN driver before using. 
To display the user interface of the TWAIN 
driver, after starting the image capture, select 
[Browse Devices] from the [Devices] menu 
of the image capture. Select a driver in 
[TWAIN devices] and then check the check-
box of [Use TWAIN software] shown in the 
lower right screen.

Item Symptom Cause/Remedy
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Copying Issues

Memo

 If the following information does not solve your trouble, contact your dealer.

Unable to Copy

Symptom Point to check Remedy Reference

Unable to copy. Is the machine turned on? Hold down the power switch for 
about a second to turn on the 
power.

P.20

Is the machine initializing? Wait until initializing is done. -

Is your document properly loaded 
on the machine?

Load the document properly on the 
machine.

P.38

Is there paper in the tray? Load paper in the tray.
Or, check that the paper cassette is 
installed on the machine.

P.32

Is the proper size of paper for your 
document loaded in the tray?

Load the proper size of paper for 
your document.

P.32

Is the paper tray selectable when 
[Paper Feed] is set to [Auto]?

Press the <SETTING> key and 
select [Paper Setup] > [Select 
Tray] > [Copy] > the paper tray 
on which the paper you use is 
loaded, and then select [ON] or 
[ON(Prior)].

-

Is the loaded paper compatible 
with duplex printing?

Duplex copying cannot be done 
without the proper paper size, 
document type, or document 
weight.
Load the right paper for duplex 
printing and configure the paper 
size, document type, and 
document weight correctly.

P.32

Is the media type of the paper tray 
set to [Plain] or [Recycled]?

When setting [Paper feed] to 
[Auto], set the media type for the 
paper tray to [Plain] or 
[Recycled].

P.36

Is there a paper jam? Check the error message and 
remove any jammed paper.

P.135

Is there an empty toner cartridge? Replace it with a new toner 
cartridge.

P.172

Is the image drum at the end of its 
life?

Replace it with a new image drum. P.173

Are any covers on the machine 
open?

Close all the covers. P.15

Is an error occurring? Clear the error. P.141

Is another job in progress? Start copying after the other job is 
complete.

-

Is a print job from a computer or 
other device in progress?

Wait until printing is complete. -

Is a fax being transmitted in real 
time?

Wait until the transmission is 
complete.

-
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The Copied Output is Different from the Original Document

Troubles after Starting to Copy

Unable to copy. Is the Continuous Scan mode on? Select [Scan completed] on the 
display screen.

P.82

Is the machine off line? Press the <PRINT> key on the 
operator panel, and then select 
[On-Line/Off-Line].

-

Do you have access to make 
copies?

Enter your authorized PIN or user 
name and password.

P.128

Unable to copy mixed 
size documents.

Is [Mixed Size] set to [OFF]? Set [Mixed Size] to [ON]. Advanced

Is the size of your document 
compatible for making mixed size 
copies?

Use documents sizes supported for 
mixed size copying.

Advanced

Is paper of all the sizes of your 
original loaded?

Load paper of the required sizes on 
each paper tray. The paper trays 
need to be set to [ON] or [ON 
(Prior)] from the <SETTING> 
key > [Paper Setup] > [Select 
Tray] > [Copy].

-

Unable to sort copies. Is [Sort] set to [OFF]? Set [Sort] to [ON]. Advanced

Symptom Point to check Remedy Reference

The copied output is 
different from the 
original document.

Is [DuplexCopy] enabled? Set [DuplexCopy] to [OFF]. P.83

Is [Mixed Size] set to [ON]? Set [Mixed Size] to [OFF]. Advanced

The size of the copied 
output is different from 
the size of the original 
document.

Is the proper size paper for the 
document loaded on the paper 
tray?

Load the proper size paper for the 
document.

P.32

Is the zoom ratio properly set? Set the proper zoom ratio. P.81

Is [Repeat] set to [ON]? Set [Repeat] to [OFF]. Advanced

A part of the document 
image is missing on the 
copied output.

Is [Edge Erase] set to [ON]? Set [Edge Erase] to [OFF]. Advanced

Is [Margin] set to [ON]? Set [Margin] to [OFF]. Advanced

Is [N-in-1] set to [ON]? Set [N-in-1] to [OFF]. Advanced

Symptom Point to check Remedy Reference

The machine is slow to 
start copying.

Is [Warming Up] or [Preparing] 
displayed on the display screen?

The machine is preparing.
Wait until it starts copying.

-

A copy job is cancelled. Is any error occurring? A copy job is cancelled when 
specific errors occur while copying.
Clear the error and start the copy 
job again.

P.141

Is there paper in the MP tray? When copying using paper from 
the MP tray, check if enough paper 
is loaded in the MP tray before 
starting to copy. And, press the 
<SETTING> key and select 
[Paper Setup] > [Select Tray] > 
[Copy] > [MP tray], and then 
check that [ON] or [ON (Prior)] is 
selected.

-

Symptom Point to check Remedy Reference
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Faxing Issues

Memo

 If the following information does not solve the trouble, contact your dealer.

Unable to Send a Fax

Unable to Receive a Fax

Symptom Point to check Remedy Reference

Unable to send a fax. Did you perform the correct 
procedure?

Check the appropriate procedure 
and try again.

P.86

Did you specify the correct 
number?

If you use speed dial, print the 
speed dial list and check the entry.

P.87
Advanced

Did you specify the appropriate 
dial line type?

Specify the appropriate dial line 
type for your region.

P.43

Is it due to the recipient machine? Contact and ask the recipient to 
check machine status.

-

The machine does not 
continuously send a 
document.

Did you load the document 
correctly on the ADF?

Keep the leading edges of the 
pages in the document even.

P.38

Did you load a document other 
than A4, letter or legal 13/13.5/14 
on the ADF?

Only A4, letter, and legal 13/13.5/ 
14 size documents can be sent 
from the ADF.

-

The machine does not 
send a fax even though 
you dialed the number 

and pressed .

Did you specify the appropriate 
dial line type?

Specify the appropriate dial line 
type for your region.

P.43

Did you load the document 
correctly?

Load the document correctly. P.38

Did you dial the correct number? Dial the correct number. -

Is the recipient's line busy? Wait until the line is open and try 
again.

-

Unable to transmit a fax 
manually.

Did you put down the handset 

before pressing ?
Press  first and then put 
down the handset.

Advanced

The machine does not 
start scanning (during 
memory transmission).

Did you load the document 
correctly?

Load the document correctly. P.38

Is there enough memory? Check the available memory. Advanced

Symptom Point to check Remedy Reference

Unable to receive a fax. Did you specify the appropriate 
reception mode?

Check the reception mode P.92

Is there paper in the tray? Load the paper. P.32

Is there a paper jam? Check the error message and 
remove the jammed paper.

P.135

Is the telephone cable correctly 
connected to the machine?

Connect the telephone cable 
correctly.

P.41

Is there enough memory? Check the available memory. Advanced

Unable to receive a fax 
manually. 

Did you put down the handset 

before pressing ?
Press  first and then put 
down the handset.

P.92

F code polling fails and 
an error message is 
printed out.

Did the sender store a document in
a bulletin box?

Contact and ask the sender to 
store the polling document.

-

MONO

MONO

MONO

MONO

MONO
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Unable to Send or Receive a Fax

The Machine does not Select the Appropriate Paper for the Received Fax

Scanning Issues

Memo

 If the following information does not solve the trouble, contact your dealer.

Symptom Point to check Remedy Reference

Unable to send or 
receive a fax.

Is the telephone cable connected 
properly?

Check the connection of the 
telephone cable.

P.41

Did you install an IP phone on the 
machine in a broadband 
environment?

Press the <SETTING> key and 
select [Admin Setup] > [User 
Install] > [Super G3] > [OFF].

-

Did you change the telephone 
network?

Specify the appropriate dial line 
type for your region.

-

Is the [Country Code] setting is 
correct?

Please set the correct country 
code.

P.40

Symptom Point to check Remedy Reference

The machine does not 
select the appropriate 
size paper for the 
received fax.

Did you specify other than [Plain] 
or [Recycled] in [Media Type] 
for the paper tray used for fax 
reception?

Specify [Plain] or [Recycled] in 
[Media Type] for the paper tray 
used for fax reception.

Advanced

Symptom Point to check Remedy Reference

Cannot start scan job. Is the machine turned on? Hold down the power switch for 
about a second to turn on the power. 

P.20

Is the cable connected to the 
machine?

Check the cable connections and 
connect them properly.

P.46

Is there any damage to the cable? Change the cable. P.46

Is the network setting proper? Correct the network setting. P.65

Is an error occurring? Follow the instructions displayed on 
the display screen of the machine.

P.141

Transmission and 
reception of e-mail 
not possible.

Did you connect the Ethernet cable 
after turning on the machine?

Hold down the power switch for 
about a second to turn on the power. 
Connect the Ethernet cable and then 
hold down the power switch for 
about a second to turn on the power.

P.47

The network connection setting is 
wrong.

This product cannot connect to a 
wired LAN and wireless LAN at the 
same time. To connect to a wired 
network, set the network connection 
to wired. To connect to a wireless 
network, set the network connection 
to wireless.

-
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Memo

 If the following information does not solve your trouble, contact your dealer.

Transmission and 
reception of e-mail 
not possible.

Not connected to a wireless access 
point.

Check that the wireless access 
point power is switched on.

Check the wireless access point 
settings, and then try the manual 
settings or automatic settings.

Restart the wireless LAN function.
 Press the <SETTING> key and 

select [Admin Setup] > 
[Network Menu] > [Network 
Setup] > [Wireless Setting], 
and then select [Reconnect 
Wireless].

-

Is the e-mail address of the machine 
set?

Set the e-mail address of the 
machine.

P.66

Did you enter the wrong e-mail 
address?

Enter the correct e-mail address. P.66

Is the SMTP server address setting 
correct?

Check the SMTP server setting. P.66

Is the POP3 server address setting 
correct?

Check the POP3 server setting. P.66

Is the DNS server address setting 
correct?

Check the DNS server address 
setting.

P.66

Is another job running? Wait until the other job finishes. -

Is an error occurring? Follow the instructions displayed on 
the display screen of the machine.

P.141

Files cannot be saved in 
a network file folder.

Is the FTP/CIFS setting right? Check the profile settings. P.77

Is an error occurring? Follow the instructions displayed on 
the display screen of the machine.

P.141

Symptom Point to check Remedy Reference

Vertical white lines 
appear.

The LED heads are dirty. Wipe the LED heads with a soft 
tissue paper.

P.178

The toner is low. Replace the toner cartridge. P.172

Foreign material may be present 
on the image drum.

Replace the image drum. P.173

The image drum is not installed 
properly.

Install the image drum properly. P.173

The ADF document glass is dirty. Clean the ADF document glass. P.176

Printed images are 
fading vertically.

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

P.178

The toner is low. Replace the toner cartridge. P.172

The paper is unsuitable. Use supported paper. -

Symptom Point to check Remedy Reference
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Printed images are light. The toner cartridge is not installed 
properly.

Install the toner cartridge properly. P.172

The toner is low. Replace the toner cartridge. P.172

The paper is moist. Use paper stored under proper 
temperature and humidity 
conditions.

P.31

The paper is unsuitable. Use supported paper. -

The paper is unsuitable.
The settings of media type and 
width are incorrect.

Press the <SETTING> key and
select [Paper Setup] > the paper 
tray you are using, and then select 
the proper values for [Media 
Type] and [Media Weight]. Or, 
select the thicker values for 
[Media Weight].

P.36

The paper is recycled. Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the thicker values for [Media 
Weight].

P.36

Yellow and green are used in the 
original document.

If the original data was 
transmitted, ask the sender to 
change the color of the original 
document to black and white. 

-

Printed images are 
partially faded. White 
spots and lines appear.

The paper is too moist or dry. Use paper stored under proper 
temperature and humidity 
conditions.

P.31

Vertical lines appear. The image drum is damaged. Replace the image drum. P.173

The toner is low. Replace the toner cartridge. P.172

The document glass and paper 
feed roller of the ADF are dirty.

Clean the document glass and 
paper feed roller.

P.176

Horizontal lines and 
spots appear 
periodically.

If the interval of lines or spots is 
about 94 mm (3.7 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with 
soft tissue paper.
Replace the image drum if it is 
damaged.

P.173

If the interval of lines or spots is 
about 40 mm (1.6 inches), foreign 
materials may be present on the 
image drum.

Open and close the top cover, and 
print again.

-

The image drum has been exposed 
to light.

Place the image drum back into 
the machine and leave it for a few 
hours. If it does not solve the 
problem, replace the image drum.

P.173

The paper feed path is dirty. Print a few test copies. -

White area of paper is 
lightly stained.

The paper contains static 
electricity.

Use paper stored under proper 
temperature and humidity 
conditions.

P.31

The paper is too thick. Use thinner paper. -

The toner is low. Replace the toner cartridge. P.172

Periphery of letters is 
smudged.

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

P.178

The paper is unsuitable. Use recommended paper. -

The paper is moist. Replace it with new paper. P.32

The entire paper area is 
lightly stained when 
printing on envelopes or 
coated paper.

The toner may be sticking to the 
whole area of the envelope or 
coated paper.

This is not a malfunction of the 
machine.
Coated paper is not recommended.

-

Symptom Point to check Remedy Reference
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Toner comes off when it 
is rubbed.

The settings of media type and 
width are incorrect.

Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the proper values for [Media 
Type] and [Media Weight]. Or, 
select the thicker values for 
[Media Weight].

P.36

The paper is recycled. Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the thicker values for [Media 
Weight].

P.36

Glossiness is not 
uniform.

The settings of media type and 
width are incorrect.

Press the <SETTING> key and 
select [Paper Setup] > the paper 
tray you are using, and then select 
the proper values for [Media 
Type] and [Media Weight]. Or, 
select the thicker values for 
[Media Weight].

P.36

Black or white dots 
appear.

The paper is unsuitable. Use supported paper. -

When the interval of the dots is 
about 94 mm (3.7 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with a 
soft tissue paper.
Replace the image drum when it is 
damaged.

P.173

The document glass or the 
document holding pad is dirty.

Clean the document glass and the 
document holding pad.

P.176

Dirt is printed. The paper is moist. Replace it with new paper. P.32

The paper is unsuitable. Use supported paper. -

The document glass or the 
document holding pad is dirty.

Clean the document glass and the 
document holding pad.

P.176

The entire page is 
printed black.

The machine may be 
malfunctioning.

Contact your dealer. -

Nothing is printed. Two or more sheets of paper are 
fed simultaneously.

Fan the paper well and load it 
again.

P.32

The machine may be 
malfunctioning.

Contact your dealer. -

The back side of the document is 
being scanned.

Load the document properly. P.38

White patches appear. The paper is moist. Replace it with new paper. P.32

The paper is unsuitable. Use supported paper. -

The document glass is dirty. Clean the document glass. P.176

The entire page is dirty. The document glass is dirty. Clean the document glass. P.176

When the document is double 
sided, the image on the back side 
is printed through.

When the document is thin, the 
back side image may be printed 
through. Lighten the density.

-

The peripheral area of 
the page is dirty.

The paper holding roller or the 
document holding pad is dirty.

Clean the paper holding roller and 
the document holding pad.

P.176

The paper size is bigger than the 
size of the document (when the 
zoom ratio is set to 100%).

Use paper of the same size as the 
document.

-

The orientation of the document 
and paper are different.

Set the proper orientation of the 
document.

-

The zoom ratio is set improperly. Set the zoom ratio properly 
according to the paper size.

-

Symptom Point to check Remedy Reference
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Feeding Issues

Memo

 If the following information does not solve the trouble, contact your dealer.

The printed image is 
skewed.

The document is loaded 
improperly.

Load the document properly. P.38

An unsuitable document is loaded 
in the ADF.

Load a suitable document in the 
ADF.

P.38

Foreign materials may be present 
on the ADF document glass.

Clean the ADF document glass. P.176

Symptom Point to check Remedy Reference

Symptom Point to check Remedy Reference

The document is not 
ejected from the 
machine.

The document jammed. Remove the jammed document 
and re-load it.

P.135

The document often 
jams.

The document is not appropriate 
for the machine.

Use an appropriate document. P.37

The document guides are not 
correctly adjusted.

Adjust the document guides to the 
document.

P.38

There is a piece of paper inside the 
ADF.

Open the document cover and 
remove any paper.

P.135

The rollers in the ADF are not 
clean.

Clean the rollers in the ADF. P.176

 The paper often jams.
Multiple sheets are fed 

at once.
 The paper is fed at an 

angle.

The machine is inclined. Place the machine on a flat surface. -
The paper is too light or too heavy. Use the appropriate paper for the 

machine.
P.29

The paper is moist or has a static 
charge.

Use paper stored under proper 
temperature and humidity 
conditions.

P.31

The paper is wrinkled, folded or 
curled.

Use appropriate paper for the machine. 
Fix the re-flexed paper.

P.29

Something is already printed on 
the back side of the paper.

You cannot use paper that has been 
printed on for tray 1 and tray 2.
Load it in the MP tray or Manual 
Feeder for printing.

P.34

The edges of the paper are not 
kept even.

Fan the paper and even up the 
edges.

P.32

There is only one sheet of paper in 
the tray.

Load several sheets of paper. P.32

You have added new paper onto 
the paper already loaded in the 
tray.

Remove the already loaded paper, 
stack it onto the new paper, even 
up the edges and load the paper 
with the old paper on top.

P.32

The paper is loaded at an angle. For tray 1 and tray 2, adjust the 
paper width guide and stopper to 
the paper.
For the MP tray or Manual Feeder, 
adjust the paper width guide to the 
paper.

P.32

Envelopes are not correctly loaded. Load envelopes correctly. P.34
Paper, envelopes or labels whose 
weight is between 123 and 163 g/m2 
(33 and 43 lb) is loaded on the tray 1 
and tray 2.

Load the paper, envelopes or labels 
whose weight is between 123 and 
163 g/m2 (33 and 43 lb) in the MP 
tray (MB451/MB451w/MB471/
MB471w/MB491/MB491+/
MB491+LP/ES4191 MFP/
MPS4200mb/MPS4700mb) or 
Manual Feeder (MB441/MB461/
MB461+LP/ES4161 MFP).

P.34
P.37
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Machine Issues

Memo

 If the following information does not solve the trouble, contact your dealer.

Paper does not feed into 
the machine.

The setting of [Paper Feeding 
Source] on the printer driver is 
not correctly specified.

Check the paper tray and select 
the correct tray in [Paper 
Feeding Source] on the printer 
driver.

-

You have specified manual feeding 
on the printer driver.

Load the paper in the MP tray.
Then, on the operator panel, select 
[Restart].
Or, on the printer driver, clear the 
[Use MP tray as manual feed] 
check box on [Paper feed options].

P.34
Advanced

The machine does not 
start processing even 
though you have 
removed the jammed 
paper.

- Open and close the top cover. -

The paper gets folded or 
wrinkled.

The paper is moist or has a static 
charge.

Use paper stored under proper 
temperature and humidity conditions.

P.31

The paper is light. Press the <SETTING> key and then 
select [Paper Setup] > [(tray 
name)] > [Media Weight].
Then, specify a lighter weight.

P.36

The paper twists around 
the rollers in the fuser 
unit.

The settings of media weight and 
type are incorrect.

Press the <SETTING> key and 
then select [Paper Setup] > 
[(tray name)] > [Media Type]/ 
[Media Weight]. Then, specify 
the appropriate values.
Or, specify the heavier weight in 
[Media Weight].

P.36

The paper is light. Use heavier paper. -
There is an image or text on the 
leading edge of the paper.

Have a margin on the leading edge 
of the paper.
For duplex printing, leave a margin 
on the leading and bottom edges.

-

Symptom Point to check Remedy Reference

Turned on the machine, 
but it stays "Off-Line".

The AC cable is unplugged. Hold down the power switch for 
about a second to turn on the 
power and then plug in the AC 
cable firmly.

-

The power is out. Check if the power is being 
supplied to the electric outlet.

-

The machine does not 
operate.

The AC cable is not firmly plugged in. Plug in the AC code firmly. -

The machine is turned off. Hold down the power switch for 
about a second to turn on the 
power. 

P.20

The power turned off 
automatically because of 
the auto power off 
function, and does not 
respond.

The power turned off automatically 
because it has passed the auto 
power off time.

Please turn on the power. -

The printer does not 
respond.

The printer is in error status. Press the power switch for more 
than 5 seconds and turn off the 
power. And then turn on the power 
again.

-

Symptom Point to check Remedy Reference
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The machine does not 
start printing.

An error is displayed on the panel. Check the error code and follow 
the on-screen instructions.

P.141

The Ethernet or USB cable is 
unplugged.

Plug in the Ethernet or USB cable 
firmly.

P.47
P.60

Something is wrong with the 
Ethernet or USB cable.

Use another Ethernet or USB cable. -

The machine does not support your 
Ethernet or USB cable.

 Use a USB 2.0 compatible cable.

 Use an Ethernet 10BASE-T/
100BASE-TX compatible cable.

-

Something may be wrong with the 
printing function.

Press the <SETTING> key and 
select [Reports] > [Configura-
tion] and print out the configura-
tion list to check the printing 
performance.

P.78

The interface is disabled. Press the <SETTING> key and 
select [Admin Setup] > [Net-
work Menu] > [Network Setup] 
and enable the interface you are 
using.

-

The printer driver of the machine is 
not selected.

Set the printer driver of the 
machine as the default printer.

-

The specified port of the printer 
driver is wrong.

Specify the port the Ethernet or 
USB cable is connected to.

-

The display screen is 
blank.

The machine is in the sleep mode. Check if the <POWER SAVE> key 
lights up and press the <POWER 
SAVE> key to activate the 
machine.

P.20

Print data is not 
transmitted to the 
machine.

The Ethernet or USB cable is 
broken.

Connect a new cable. -

The time-out period set on the 
computer has passed.

Set a longer time-out period. -

There is an abnormal 
sound.

The machine is inclined. Place the machine on a flat 
surface.

-

There is a piece of paper or 
unknown object inside the 
machine.

Check the inside of the machine 
and remove any objects.

-

The top cover is open. Close the top cover. -

There is a buzzing 
sound.

The machine is printing on heavy 
or thin paper when the 
temperature inside is high.

This is not a malfunction. You can 
proceed with the operation.

-

It takes a while to start 
printing.

The machine is warming up from 
the power save or sleep mode.

Press the <SETTING> key and 
select [Admin Setup] > [User 
Install] > [Power Save Enable]/ 
[Sleep] and disable both modes.

P.20

The machine may be cleaning the 
image drum.

Wait for a while. -

The machine is adjusting the 
temperature of the fuser unit.

Wait for a while. -

The machine is processing data 
from another interface.

Wait until the process finishes. -

Symptom Point to check Remedy Reference



Other Issues

- 169 -

Tro
u
b
lesh

o
o
tin

g

7

A print job has stopped 
in the middle of the 
printing process.

As a result of processing print jobs 
continuously, the fuser unit has 
become hot. The fuser unit is 
cooling off.

Wait for a while.
When the fuser unit gets cooler, 
printing restarts automatically.

-

As a result of processing print jobs 
continuously for a long time, the 
temperature in the machine inside 
has become too high. The machine 
is cooling off.

Wait for a while.
When the machine gets cooler, 
printing restarts automatically.

-

The specified settings 
such as the time setting 
have been erased.

The machine was turned off for a 
long time or every day.

The life of the battery may have 
ended. Contact your dealer.

-

Memory is insufficient. You have launched Multiple 
applications.

Close the applications you are not 
using.

-

It takes a long time to 
finish printing.

The processing speed of the 
computer may be slowing down 
the print job.

Use a computer with faster 
processing speed.

-

You have selected [High Quality 
(Multiple tones)] on the [Print 
Job Options] tab of the printer 
driver.

Select [Fine / Detail 
(600x1200)] or [Normal 
(600x600)] on the [Job 
Options] tab of the printer driver.

-

The print data is complicated. Make the data simpler. -

The printer driver is not 
correctly displayed on 
Mac OS X.

The printer driver may not be 
operating correctly.

Uninstall the printer driver and 
install it again.

Advanced

The machine turns off 
automatically.

When your machine is not used for 
a certain period of time (factory 
default is 4 hours), the power turns 
off automatically. This function is 
called Auto Power Off.

Press the <SETTING> key and 
select [Admin Setup] > [User 
Install] > [Power Save] > [Auto 
Power Off] and disable the 
function.

P.19

Symptom Point to check Remedy Reference
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When the Power Goes Out

Machine Behavior

When the power goes out, the machine behaves in the following way:

Note

 We do not warrant operation when an uninterruptible power system (UPS) or inverter is used.

Stored Fax Data

Backing Up Data in Memory
Even if the power goes out or you turn off the machine, the data for fax transmissions and received 
faxes is retained in the memory.

Erased Report
The machine automatically prints out an erased report if the fax data in the memory is lost. The report 
shows what data is lost by listing the following information:

 F Code Box Document

 Documents Received at Alternate Recipients

The deletion notification will inform you of the next item after the deleted data.

 Document type

 F-code box number

 F-code box name

 Destination name

 F-code Confidential communication/F-code bulletin board communication

 Time communication started

 Received number of pages

Memo

 The communication type is printed for manual reception, F-code polling, F-code secure reception or F-code bulletin board 
reception.

Machine's Status Behavior

During a call You can continue talking.

During transmitting a fax The communication stops.
When the electricity supply is restored,
 The machine automatically starts transmitting the fax whose transmission stopped 

and the subsequent data if it was a memory transmission.
 The machine does not transmit the data if it was a real time transmission. Set the 

document and specify the destination again to start transmission.

Receiving a fax The transmission stops in the middle of the operation.
When the electricity supply is restored, the machine automatically prints out the data 
successfully received and stored in memory.

Copying or printing a list The printing process stops in the middle of the operation.
When the power is restored, start the job again.

Idle You cannot start another copy, fax, scan, or print job.
You also cannot receive another fax.
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8. Maintenance
This chapter explains how to replace consumables, clean the machine, and move or transport the 
machine.

Replacing Consumable Items
This section explains how to replace consumable items.

Note

 Use only genuine Oki Data consumable items to ensure optimum quality.

 Service for problems caused by the use of consumable items other than genuine OKI consumables is not covered under the 
warranty or in the maintenance contract.

WARNING
Do not throw the toner or 
toner cartridge into the fire. 
Doing so may cause toner 
splashes leading to burns.

Do not keep toner cartridges 
near fire. They may catch 
fire, which can spread and 
cause burns.

Do not vacuum spilled toner 
powder. If vacuuming, it may 
cause ignition due to the 
sparks from electric contacts. 
Toner spillage on the floor 
should be wiped up using a 
wet cloth.

CAUTION
There are high temperature 
parts in the device. Do not 
touch the periphery of the 
label "Caution High 
Temperature", which may 
cause burns.

Keep the toner cartridge out 
of reach of young children. If 
young children swallow toner 
powder, seek immediate 
medical attention.

If toner powder is inhaled, 
gargle with large amounts of 
water and move the person to 
the open area for fresh air. 
Seek medical attention if 
necessary.

If your skin is exposed to 
toner, wash thoroughly with 
soap.

If toner gets into your eyes, 
flush with large amounts of 
water immediately.

If you swallow toner powder, 
take large amounts of water 
to weaken the toner. Seek 
medical attention if 
necessary.

When handling a paper jam, 
or replacing the toner 
cartridge, make sure not to 
get your clothes and hands 
dirty. When toner powder 
stains on your clothes, wash 
with cold water. If you wash 
with hot water, the toner may 
be soaked into the cloth; it 
may be difficult to clean.

Do not disassemble the toner 
cartridge. Toner powder may 
fly upward, and you may 
inhale the toner powder or 
may get your clothes and 
hands dirty.

Keep used toner cartridges in 
a bag so that the toner 
powder cannot fly upward.
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Replacing Toner Cartridges

Note

 A toner selling is different by an area.

Procedure for Replacement

1 Open the top cover and remove the used 
toner cartridge.

Memo

 When disposing of used toner cartridges by necessity, 
poly-bag them, and be sure to follow instructions and 
regulations of your local government.

 Rotate the blue lever of the toner cartridge in 
the direction of the arrow of  on the toner 
cartridge until it stops.

 Remove the toner cartridge.

2 Install a new toner cartridge.

 Unpack the new toner cartridge.

 Hold the toner cartridge and gently shake it 
several times.

 Place the toner cartridge horizontally and 
partially remove the tape from it.

 Hold the toner cartridge with the tape face 
down and the blue lever on the right side.

 Insert the toner cartridge, while matching its 
left side with the protrusion on the left side of 
the image drum.

 Firmly press the grooves on the right side of 
the toner cartridge against the protrusion of 
the cartridge guide on the right side of the 
image drum.

 While holding down the toner cartridge top 
with your hand to prevent it from rising, 
rotate the blue release lever on the right side 
in the direction of the arrow of  on the 
toner cartridge until it stops.

Note

 When the toner cartridge is not fully fixed, a decline in 
print quality may occur.

3 Lightly wipe the whole LED head with a 
soft cloth or soft tissue paper.

Model Type

MB461/
MB461+LP/
MB471/
MB471w/
ES4161 
MFP

Starter toner cartridge

Toner cartridge

Toner cartridge
(Medium)

MB491/
MB491+/
MB491+LP/ 
ES4191 
MFP

Starter toner cartridge

Toner cartridge

Toner cartridge 
(Medium)

Toner cartridge (Large)
MB441/
MB451/
MB451w

Starter toner cartridge

Toner cartridge

Toner cartridge (Small)
MPS4200mb/
MPS4700mb

Toner cartridge (Large)

WARNING

Be sure not to throw used toner 
cartridges into fire; toner in the 
cartridges may scatter and ignite, 
causing burn injuries.

Toner cartridge

lever

Toner cartridge Tape

Protrusion of image drum

lever
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Note

 Do not use solvents, such as methyl alcohol or thinners. 
They damage the LED head.

4 Close the top cover.

5 Close the scanner unit.

Memo

 If you dispose of a toner cartridge by necessity, put it in a 
polyethylene bag or something and then dispose of it in 
accordance with your municipality's ordinances or guidelines.

Replacing the Image Drum (MB461, MB461+LP, 
MB471, MB471w, MB491, MB491+, MB491+LP, ES4161 
MFP, ES4191 MFP, MPS4200mb, MPS4700mb only)

Life Duration of Image Drum

When the [Image Drum Near Life] message 
appears on the display screen, prepare a 
replacement image drum.
If you continue printing, the message [Please 
Replace the Image Drum] will be displayed 
and printing will stop.
A guideline for replacing the image drum is every 
30,000 pages or so for A4 sized paper (with 
single-sided printing). However, this number of 
pages is for printing with general conditions (3 
pages at a time). Printing one page at a time 
reduces the drum life by about half.
The actual number of printed pages may be 
halved again relative to the above guideline, 
depending on the printing conditions.

Note

 The actual number of pages you can print with the image 
drum depends on how you use it. The above guideline may be 
reduced by more than half, depending on the conditions of 
printing.

Note

 The print quality may deteriorate after the toner cartridge 
has been unpacked for a year. Replace it with a new one.

Procedure for Replacement

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

 To ensure optimum performance, please use original Oki 
Data consumables.

 Service for problems caused by the use of consumable 
items other than genuine OKI consumables is not covered 
under the warranty or in the maintenance contract. (This 
does not apply to all faults occurring with non-original Oki 
Data products; however, please bear this in mind when 
using them.)

1 Open the top cover and remove the used 
image drum.
Remove the image drum upward slowly. 

If the image drum is removed, the toner 
cartridge is also removed.

2 Install a new image drum.
 Take the new image drum out of the wrapping 

bag. Remove the silica gel.

Note

 Always use a new image drum. An image drum that has 
been attached or used on another printer cannot be used.

LED head

WARNING

Be sure not to throw used  image 

drum and toner cartridges into 

fire; toner in the cartridges may 

scatter and ignite, causing burn 

injuries.

Silica gel
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 Align both guide posts of the image drum with 
their guide grooves on the printer, and gently 
set the image drum into the printer.

 Remove the toner cover (orange) from the 
image drum set in the printer by pushing the 
projection in the direction of the arrow.

Memo

 Dispose of the toner cover as non-burnable waste.

Note

 Some toner may remain on the reverse of the toner cover. 
Take care as it may stain other parts when removed.

 The image drum (the green cylinder) is very delicate. 
Handle it with extreme care.

 Do not expose the image drum to direct sunlight or bright 
interior light (approximately 1,500 lux or more). When 
leaving it under normal interior light for 5 minutes or 
more, cover it with black paper.

 Do not leave the image drum for more than 1 hour, even if 
it is covered with black paper.

3 Install a new toner cartridge.
For details, see "Procedure for Replacement" 
(P. 172).

4 Close the top cover.

Replacing the Image Drum 
(MB441, MB451, MB451w only)

Life Duration of Image Drum

When the [Image Drum Near Life] message 
appears on the display screen, prepare a 
replacement image drum.
If you continue printing, the message [Please 
Replace the Image Drum] will be displayed 
and printing will stop.
A guideline for replacing the image drum is every 
25,000 pages or so for A4 sized paper (with 
single-sided printing). However, this number of 
pages is for printing with general conditions (3 
pages at a time). Printing one page at a time 
reduces the drum life by about half.
The actual number of printed pages may be 
halved again relative to the above guideline, 
depending on the printing conditions.

Note

 The actual number of pages you can print with the image 
drum depends on how you use it. The above guideline may be 
reduced by more than half, depending on the conditions of 
printing.

Note

 The print quality may deteriorate after the toner cartridge 
has been unpacked for a year. Replace it with a new one.

Procedure for Replacement

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

 To ensure optimum performance, please use original Oki 
Data consumables.

 Service for problems caused by the use of consumable 
items other than genuine OKI consumables is not covered 
under the warranty or in the maintenance contract. (This 
does not apply to all faults occurring with non-original Oki 
Data products; however, please bear this in mind when 
using them.)

Guide Post

Guide Post

Guide Grooves

Protrusion

Toner cover
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1 Open the top cover and remove the used 
image drum.
Remove the image drum upward slowly. 

If the image drum is removed, the toner 
cartridge is also removed.

2 Install a new image drum.
 Take the new image drum out of the wrapping 

bag. Remove the silica gel.

Note

 Always use a new image drum. An image drum that has 
been attached or used on another printer cannot be used.

 Align both guide posts of the image drum with 
their guide grooves on the printer, and gently 
set the image drum into the printer.

 Turn the lever in the direction shown.

Note

 The image drum (the green cylinder) is very delicate. 
Handle it with extreme care.

 Do not expose the image drum to direct sunlight or bright 
interior light (approximately 1,500 lux or more). When 
leaving it under normal interior light for 5 minutes or 
more, cover it with black paper.

 Do not leave the image drum for more than 1 hour, even if 
it is covered with black paper.

3 Close the top cover.

WARNING

Be sure not to throw used  image 

drum and toner cartridges into 

fire; toner in the cartridges may 

scatter and ignite, causing burn 

injuries.

Silica gel

Guide Post

Guide Post

Guide Grooves
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Cleaning Your Machine
This section explains how to clean each part of your machine.

Cleaning the Surface of the 
Machine

Note

 Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of the machine.

 Do not lubricate your machine with oil.

1 Hold down the power switch for about a 
second to turn on the power.

Reference

 "Turning Off Your Machine" (P. 20) 

2 Wipe the surface of the machine with a 
soft cloth lightly moistened with water or 
neutral detergent.

3 Dry the surface of the machine with a 
dry soft cloth.

Cleaning the Document Glass
It is recommended to clean the document glass 
once a month to maintain image quality of the 
printouts.

Note

 Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of the machine.

1 Open the document glass cover.

2 Wipe the document holding pad (1), 
document glass (2) and ADF document 
glass (3) surface with a soft cloth lightly 
moistened with water.

3 Close the document glass cover.

Memo

 If the document glasses surface and the document holding 
pad get too dirty, wipe them with a soft cloth lightly 

moistened with neutral detergent, and then wipe it again 
with a soft cloth lightly moistened with water.

Cleaning Document Feeding 
Rollers in the ADF

If the document feeding rollers in the ADF are 
contaminated with ink, toner particles or paper 
dust, documents and outputs get dirty and a 
paper jam may occur. To prevent this, it is 
recommended to clean the rollers once a month.

Note

 Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of your 
machine.

1 Open the ADF cover.

2 Wipe the document feeding rollers (1), 
surface of the guide (2), rubber pad (3) 
and rubber sheet (4) with a soft cloth 
lightly moistened with water.
Wipe the whole surface of the roller while turning 
it with your hand.

3 Close the ADF cover.

Memo

 If the rollers get too dirty, wipe them with a soft cloth 
lightly moistened with neutral detergent, and then wipe it 
again with a soft cloth lightly moistened with water.

23

1

1

3

4

2
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Cleaning Paper Feed Rollers
Clean the paper feed rollers if paper jams occur 
frequently.

For Tray 1 and Tray 2

Memo

 The following images use tray 1 as an example, but the 
same procedure applies to tray 2.

1 Pull out the Tray.

2 Wipe the paper feed rollers (1) inside the 
machine with a soft cloth lightly 
moistened with water.

3 Wipe the paper feed roller (2) on the 
Tray.

4 Push the Tray back into the machine.

For MP Tray (MB451, MB451w, 
MB471, MB471w, MB491, MB491+, 
MB491+LP, ES4191 MFP, 
MPS4200mb, MPS4700mb only)

1 Open the MP tray.

2 While pressing the tab (1) of the paper feed 
roller cover to the right, open the cover.

3 Wipe the paper feed roller (2) with a soft 
cloth lightly moistened with water.

4 Close the cover of the paper feed roller.

5 Close the MP tray.

1

2

2

3

4

1

2
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Cleaning LED Heads
Clean the LED heads if vertical white lines 
appear, images are fading vertically, or the 
periphery of letters is smudged in the printouts. 
Dirt on the LED heads may also cause paper 
jams.

Note

 Do not use methyl alcohol or thinners as a cleaning agent. 
They may damage the LED heads.

 Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1 Hold down the power switch for about a 
second to turn on the power.

Reference

 "Turning Off Your Machine" (P. 20) 

2 Open the scanner unit.

3 Press the top cover open button (1) and 
open the top cover.

4 Lightly wipe the lenses (2) of the LED 
heads with soft tissue paper.

5 Close the top cover.

6 Close the scanner unit.

CAUTION Burn risk.

 The fuser unit is extremely hot. Do not touch it.

1

2
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Moving Your Machine
This section explains how to move or transport your machine.

Moving Your Machine

1 Hold down the power switch for about a 
second to turn on the power.

Reference

 "Turning Off Your Machine" (P. 20) 

2 Unplug all the cables.
 AC cable and ground wire

 Ethernet or USB cable

 Telephone cable(s)

3 Remove any paper from the paper trays.

4 lift your machine and move it to a new 
location.

Transporting Your Machine

Note

 The image drum (the green tube) is very delicate. Handle 
it carefully.

 Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1 Hold down the power switch for about a 
second to turn on the power.

Reference

 

 "Turning Off Your Machine" (P. 20) 

2 Unplug all the cables.
 AC cable and ground wire.

 Ethernet or USB cable.

 Telephone cable(s)

3 Remove any paper from the paper trays.

4 Open the scanner unit.

5 Press the top cover open button (1) and 
open the top cover.

6 Close the top cover.

7 Close the scanner unit.

8 Remove the optional second tray unit 
from the main unit if it is installed.
Remove the lock parts and lift your machine, and 
then remove the second tray unit.

CAUTION Possible to get 
burned.

 The fuser unit is extremely hot. Do not touch it.

1
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9 Protect your machine with packing 
materials.

10 Lift your machine and put it in a box.

Note

 Use the packing materials attached to your machine 
when purchased.

 Remove the vinyl tape to secure the image drum 
and toner cartridges after transporting or when 
reinstalling.
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9. Appendix
This chapter explains the specifications of your machine and information on consumables and optional 
components.

Specifications (MB461/MB461+LP/MB471/
MB471w/MB491/MB491+/MB491+LP/ES4161 
MFP/ES4191 MFP/MPS4200mb/MPS4700mb)

General Specifications

MFP Model Model Number

MB461/MB461+LP/
ES4161 MFP

N22205A, N22205B

MB471 N22206A, N22206B

MB471w N22207A, N22207B

MB491/MB491+/
MB491+LP/ES4191 
MFP/MPS4200mb/

MPS4700mb

N22208A, N22208B

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

CPU  Printer controller
PowerPC405 , 330 MHz
Scanner controller
ARM9 max 266 MHz

Memory Resident  Printer controller
256 MB
Scanner controller
128 MB

Flash 
ROM 

Printer
Controller

SPI ROM : 16MB x 2

Scanner
Controller

NAND : 64 MB
SPI : 2 MB

Storage Device - SD memory card
Resident
4 GB (Except 
MB491+.)

Weight 20 kg (including consumables)

Dimensions MB461/MB471/MB471w/MB491/MB491+/ES4161 MFP/ES4191 MFP/MPS4200mb:
427 (W) x 425 (D) x 455 (H)
MB461+LP/MB491+LP/MPS4700mb:
486 (W) x 425 (D) x 455 (H)

Power supply N22205A, N22206A, N22207A, N22208A: 120V AC ±10% , 50/60Hz ±2%
N22205B, N22206B, N22207B, N22208B: 220V AC ±10%,  50/60Hz ±2%
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Copier Specifications

Power consumption  Typical operation
MB461/ ES4161 MFP : 
540W
MB461+LP : 640W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
Less than 14 W
Off mode
Less than 0.5 W

 Typical operation
580 W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
Less than 14 W
Off mode
Less than 0.5 W

 Typical operation
580 W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
18 W
Off mode
Less than 0.5 W

 Typical operation
MB491/ ES4191 
MFP/ MPS4200mb : 
610W
MB491+/ 
MB491+LP/ 
MPS4700mb : 660W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
Less than 14 W
Off mode
Less than 0.5 W

Operating condition Operating
Temperature : 10 to 32°C, humidity : 20 to 80% RH
 Idle
Temperature : 0 to 43°C, humidity : 10 to 90% RH

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/
100BASE-TX

USB 2.0 (Hi-Speed), 
Ethernet 10BASE-T/
100BASE-TX, 
IEEE802.11 b/g/n 
Wireless LAN

USB 2.0 (Hi-Speed), 
Ethernet 10BASE-T/
100BASE-TX

Display Graphics panel 84.1(W) x 33.6(H) mm, 320 x 128 dots

Supported OS Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows Server 2008 
R2, Windows Server 2008, Windows XP, Windows Server 2003

Mac OS X 10.4.0-10.8
Please refer to "Product Requirements" (P.46)

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Document
size

ADF A6 , B5 , A5 , A4 , letter , legal 13/13.5/14, executive 

Document 
glass

A6 , B5 , A5 , A4 , letter , legal 13/13.5/14 (only MB461+LP/MB491+LP/
MPS4700mb), executive  

First copy 
Time

Mono Less than 11 
seconds (ADF, High 
Speed)

Less than 11 
seconds (ADF, High 
Speed)

Less than 11 
seconds (ADF, High 
Speed)

Less than 10 
seconds (ADF, High 
Speed)

Copies Up to 99

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb
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 Fax Specifications

PC Fax Specifications

 Internet Fax Specifications

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Compatibility - ITU-T G3/Super G3

Compression method - MH, MR, MMR, JBIG

Modem speed - Up to 33.6 Kbps

Lines - PSTN, PBX Line

Line interface - RJ11 x 2 (Line/TEL)

Document 
size

ADF - A4, letter, legal 13/13.5/14

Document 
glass

- A4, letter, legal 13/13.5/14 (only MB491+LP/MPS4700mb)

Transmission speed - Approx. 3 seconds/page (ITU-T, MMR, Normal)

Stored document 
memory size

- 4 MB

Storage document 
capacity

- Up to 200 pages (ITU-T no.1, MMR, Normal)

Resolution - Normal
8 dots x 3.85 line/mm
 Fine
8 dots x 7.7 line/mm
 Photo
8 dots x 7.7 line/mm
 Extra-Fine
8 dots x 15.4 line/mm

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Interface - USB 2.0 (Hi-Speed), 
Ethernet 10BASE-T/
100BASE-TX

USB 2.0 (Hi-Speed), 
Ethernet 10BASE-T/
100BASE-TX, 
IEEE802.11 b/g/n
Wireless LAN

USB 2.0 (Hi-Speed), 
Ethernet 10BASE-T/
100BASE-TX

Supported OS - Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows 
Server 2008 R2, Windows Server 2008, Windows XP, Windows Server 2003

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Communication 
protocol

- SMTP, POP3, MIME

File format TIFF - TIFF
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Scanner Specifications

Scan To E-mail Specifications

Scan To Network PC Specifications

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Scanner type Document Glass with ADF function

Image sensor Color CIS

Light source LED

Document 
thickness

ADF 60 to 105 g/m2 (16 to 28 lb)

Document 
glass

20 mm

ADF document 
capacity

50 sheets (80 g/m2)

Scanning 
area

ADF 105 x 148 - 215.9 x 355.6 mm (4.13 x 5.8 - 8.5 x 14 inches)

Document 
glass

105 x 148 - 215.9 x 296.9 mm (4.13 x 5.8 - 8.5 x 11.69 inches)
105 x 148 - 215.9 x 355.6 mm (4.13 x 5.8 - 8.5 x 14 inches) (only MB461+LP/
MB491+LP/MPS4700mb)

Scanning 
speed

Color Approx. 6 seconds/page (A4, 300 x 300 dpi, ADF simplex)

Mono Approx. 2 seconds/page (A4, 300 x 300 dpi, ADF simplex)

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Communication 
protocol

SMTP, POP3, MIME

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG (JFIF) (color/
grayscale only), XPS

Mail server 
authentication

SMTP-AUTH, POP3

Supported mail 
server application

Lotus Domino Mail Server 5.0, Microsoft Exchange 2000 Server, Microsoft Exchange 2003 
Server, Microsoft Exchange 2007 Server, Red Hat 7.0 Sendmail

Supported LDAP 
server

Windows Server 2008 Active Directory, Windows Server 2003 ActiveDirectory, Windows 
2000 Server Active Directory, Lotus Notes/Domino 7.0

Supported mail 
application

Microsoft Office Outlook 2000, Microsoft Outlook Express 5.0/6.0, Windows Mail 
(Windows Vista), Windows Live Mail, Mail (MAC built-in application), Lotus Notes/Domino 
R5

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Communication 
protocol

FTP, HTTP, CIFS
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Scan To USB Memory Specifications

Scan To Local PC Specifications

Printing Specifications

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG (JFIF) (color/
grayscale only), XPS

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Connectivity interface USB2.0 Host IF

Storage device USB memory (Up to 32 GB)
Not all USB memory products are guaranteed to work.

Supported file system FAT12, FAT (FAT16), FAT32

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG (JFIF) (color/
grayscale only), XPS

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Communication 
protocol

Windows TWAIN, WIA

Mac OS X TWAIN, ICA

File format PDF, TIFF, JPEG, BMP, PCX, GIF, TGA, PNG, WMF, EMF

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Printing method Dry electrophotographic recording method with LED (Light-emitting diode)

Emulation T PCL6 (PCLXL), PCL5e PCL6 (PCLXL), PCL5e, PostScript 3

Resident fonts PCL: 91 European 
fonts

PCL: 91 European fonts
PS: 136 European fonts

Resolution 600 x 600 dpi, 
600 x 1200 dpi, 
600 x 2400dpi 

600 x 600 dpi, 1200 x 1200 dpi 600 x 600 dpi, 
1200 x 1200 dpi

Color black

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb
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Print speed (A4)  600 x 600 dpi, 
600 x 1200 dpi
Simplex: 
Approx.33 ppm for 
MB461/ES4161 
MFP
Approx.45.5 ppm 
for MB461+LP
Duplex: 
Approx.17 ppm

 600 x 2400 dpi
Simplex: 
Approx.17 ppm
Duplex: 
Approx.9 ppm

 1200 x 1200 dpi, 600 x 600 dpi
Simplex: Approx.33 ppm
Duplex: Approx.17 ppm

 1200 x 1200 dpi, 
600 x 600 dpi
Simplex: 
Approx.40 ppm for 
MB491/ES4191 
MFP/MPS4200mb
Approx.45.5 ppm 
for MB491+/
MB491+LP/
MPS4700mb
Duplex: 
Approx.20 ppm

First print 
out time

Standby 5 seconds or less

Power 
save

30 seconds or less

Paper size Tray1 Legal 13/13.5/14, letter, executive, Statement, A4, A5, B5, A6, 16K (197 x 273 mm, 
195 x 270 mm, 184 x 260 mm), custom size

Tray2 
(Optional)

Legal 13/13.5/14, 
letter, executive, A4, 
A5, B5, 16K (197 x 
273 mm, 195 x 270 
mm, 184 x 260 
mm), custom size

Legal 13/13.5/14, letter, executive, A4, A5, 
B5, 16K (197 x 273 mm, 195 x 270 mm, 
184 x 260 mm), custom size

Legal 13/13.5/14, 
letter, executive, A4, 
A5, B5, 16K (197 x 
273 mm, 195 x 270 
mm, 184 x 260 
mm), custom size

MP Tray - Legal 13/13.5/14, letter, executive, Statement, A4, A5, B5, A6, 
C5, C6, DL, Com-9, Com-10, Monarch,  16K (197 x 273 mm, 
195 x 270mm, 184 x 260 mm), custom size

Manual 
Feeder

Legal 13/13.5/14, 
letter, executive, 
Statement, A4, A5, 
B5, A6, C5, C6, DL, 
Com-9, Com-10, 
Monarch, 16K 
(197 x 273 mm, 195 
x 270mm, 184 x 260 
mm), custom size

-

Duplex 
Printing

Legal 13/13.5/14, letter, executive, A4, B5, 16 K (197 x 273 mm, 195 x 270 mm, 
184 x 260 mm)

Custom 
size

 Tray 1
100 x 148-216 x 
355.6 mm (3.94 x 
5.83-8.5 x 14 inches)
 Tray 2 (optional) 
148 x 210-216 x 
355.6 mm (5.83 x 
8.27-8.5 x 14 
inches)
Manual Feeder
86 x 140-216 x 
1320.8 mm (3.4 x 
5.5-8.5 x 52 inches)

 Tray 1
100 x 148-216 x 355.6 mm (3.94 x 5.83-
8.5 x 14 inches)
 Tray 2 (optional) 
148 x 210-216 x 355.6 mm (5.8 x 8.27-8.5 
x 14 inches)
MP tray
86 x 140-216 x 1320.8 mm (3.4 x 5.5-8.5 
x 52 inches)

 Tray 1
100 x 148-216 x 
355.6 mm (3.94 x 
5.83-8.5 x 14 
inches)
 Tray 2 (optional)
148 x 210-216 x 
355.6 mm (5.8 x 
8.27-8.5 x 14 
inches)
MP tray
86 x 140-216 x 
1320.8 mm (3.4 x 
5.5-8.5 x 52 inches)

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb
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Media type Standard paper (60 g/m2 - 163 g/m2), envelopes, label.

Feeding method Automatic feeding 
from the tray 1 and 
tray 2 (optional), 
Manual feeding from 
Manual Feeder

Automatic feeding from the tray 1, MP tray 
and tray 2 (optional), Automatic feeding 
from MP tray

Automatic feeding 
from the tray 1, MP 
tray and tray 2 
(optional), Automatic 
feeding from MP tray

Paper loading 
capacity

 Tray 1
250 sheets of 
Standard paper /80 
g/m2, total thickness 
25mm or lower.
Manual Feeder
1 sheet.
 Tray 2 (optional) 
530 sheets of 
Standard paper /80 
g/m2, total thickness 
53 mm or lower.

 Tray 1
250 sheets of Standard paper /80 g/m2, 
total thickness 25mm or lower.
MP tray
100 sheets of Standard paper /80 g/m2 and 
total thickness 10mm or lower, 10 
envelopes/ weight of 85 g/m2.
 Tray 2 (optional) 
530 sheets of Standard paper /80 g/m2, 
total thickness 53 mm or lower.

 Tray 1
250 sheets of 
Standard paper /80 
g/m2, total thickness 
25mm or lower.
MP tray
100 sheets of 
Standard paper /80 
g/m2 and total 
thickness 10mm or 
lower, 10 envelopes/ 
weight of 85 g/m2.
 Tray 2 (optional)
530 sheets of 
Standard paper /80 
g/m2, total thickness 
53 mm or lower.

Output method Face down

Paper output capacity  Face down
150 sheets (less than 80 g/m2)

Print guaranteed area 6.35 mm or more from the paper edge (not applicable to special media such as 
envelopes)

Print precision Print beginning:± 2 mm, paper skew: ± 1 mm/100 mm, image expansion: ± 1 mm/100 
mm (80 g/m2)

Warm-up time  From power on
Less than 60 seconds
 From power save mode
Less than 25 seconds

Usage Environment 
Conditions

When in operation
10~32°C / Relative Humidity of 20~80% (maximum wet bulb temperature of 25°C, 
maximum dry bulb temperature of 2°C)
When not in operation
0~43°C / Relative Humidity of 10~90% (maximum wet bulb temperature of 26.8°C, 
maximum dry bulb temperature of 2°C)

Conditions for the 
guarantee of print 
quality

Temperature 10°C, humidity 30 to 78% RH/ temperature 32°C, humidity 30 to 54% RH/ 
humidity 30% RH, temperature 10 to 32°C/ humidity 80% RH, temperature 18 to 27°C

Consumables, 
Maintenance Unit

Toner cartridges, image drum

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb
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Print From USB Memory Specifications

Network Specifications

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Interface USB 2.0 (High Speed) Host IF

Storage device USB memory (Up to 32 GB)
Not all USB memory products are guaranteed to work.

Supported file system FAT12, FAT (FAT16), FAT32

File format TIFF (TIFF 6.0 
Baseline), PRN (PCL)

PDF (v1.7, Does not support encrypted PDF), JPEG, TIFF (TIFF 6.0 
Baseline), PRN (PS/PCL)

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Interface Ethernet 10BASE-T/100BASE-TX Ethernet 10BASE-T/
100BASE-TX, 
IEEE802.11 b/g/n 
Wireless LAN

Ethernet 10BASE-T/
100BASE-TX

Protocol TCP/IPv4, TCP/IPv6, NetBEUI, NetBIOS 
over TCP, EtherTalk, NetWare, LPR, 
Port9100, IPP, FTP, HTTP, TELNET, SMTP, 
POP3, SNMPv1/v3, DHCP, BOOTP, DNS, 
DDNS, UPnP, WINS, SLP, Bonjour 
(Rendezvous), SNTP, LLTD, Web Services 
Discovery (WSD), SSL/TLS, IPSec, CIFS, 
SMB (Version 1.0), LDAPv3, Kerberos

TCP/IPv4, TCP/IPv6, 
NetBEUI, NetBIOS 
over TCP, EtherTalk, 
NetWare, LPR, 
Port9100, IPP, FTP, 
HTTP, TELNET, SMTP, 
POP3, SNMPv1/v3, 
DHCP, BOOTP, DNS, 
DDNS, UPnP, WINS, 
SLP, Bonjour 
(Rendezvous), SNTP, 
LLTD, Web Services 
Discovery (WSD), 
SSL/TLS, IPSec, CIFS, 
SMB (Version 1.0), 
LDAPv3, Kerberos, 
IEEE802.11 b/g/n, 
Infrastructure Mode, 
WEP, WPA(TKIP/AES), 
WPS-PCB/WPS-PIN, 
Open system 
authentication, 
IEEE802.1x 
authentication

TCP/IPv4, TCP/IPv6, 
NetBEUI, NetBIOS 
over TCP, EtherTalk, 
NetWare, LPR, 
Port9100, IPP, FTP, 
HTTP, TELNET, SMTP, 
POP3, SNMPv1/v3, 
DHCP, BOOTP, DNS, 
DDNS, UPnP, WINS, 
SLP, Bonjour 
(Rendezvous), SNTP, 
LLTD, Web Services 
Discovery (WSD), 
SSL/TLS, IPSec, 
CIFS, SMB (Version 
1.0), LDAPv3, 
Kerberos

Supported browsers Microsoft IE 6.0 or later, Safari 2.0 or later, Firefox 3.0 or later
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Wireless LAN Specifications

Specifications (MB441/MB451/MB451w)

General Specifications

MB461/
MB461+LP/
 ES4161 MFP

MB471 MB471w

MB491/
MB491+/

MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb

Wireless LAN adapter - OkiLAN520w -

Wireless LAN 
standard

- IEEE802.11b/g/n 
conformity (2.4GHz)

-

Transfer rate - 11n technology: 
Max150Mbps
IEEE802.11g: 
Max54Mbps
IEEE802.11b: 
Max11Mbps

-

Antenna system - Built-in Antenna 
1T1R

-

LAN protocol - TCP/IP (IPv6/IPv4) -

Security - WEP(128/
64bit),WPA,WPA2,IE
EE802.1x wireless 
securities.

-

MFP Model Model Number

MB441 N22205B

MB451 N22206B

MB451w N22207B

MB441 MB451 MB451w

CPU  Printer controller
PowerPC405 , 330 MHz
Scanner controller
ARM9 max 266 MHz

Memory Resident  Printer controller
256 MB
Scanner controller
128 MB

Flash 
ROM 

Printer
Controller

SPI ROM : 16MB x 2

Scanner
Controller

NAND : 64 MB
SPI : 2 MB

Storage Device -

Weight 20 kg (including consumables)

Dimensions 427 (W) x 425 (D) x 455 (H)

Power supply N22205A, N22206A, N22207A: 120V AC ±10% , 50/60Hz ±2%
N22205B, N22206B, N22207B: 220V AC ±10%,  50/60Hz ±2%
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Copier Specifications

 Fax Specifications

Power consumption  Typical operation
540 W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
Less than 14 W
Off mode
Less than 0.5 W

 Typical operation
580 W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
Less than 14 W
Off mode
Less than 0.5 W

 Typical operation
580 W
 Idle
80 W
 Peak
950 W
Sleep mode
Less than 3 W
 Power save mode
18 W
Off mode
Less than 0.5 W

Operating condition Operating
Temperature : 10 to 32°C, humidity : 20 to 80% RH
 Idle
Temperature : 0 to 43°C, humidity : 10 to 90% RH

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX USB 2.0 (Hi-Speed), Ether-
net 10BASE-T/100BASE-TX, 
IEEE802.11 b/g/n Wireless 
LAN

Display Graphics panel 84.1(W) x 33.6(H) mm, 320 x 128 dots

Supported OS Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows Server 2008 
R2, Windows Server 2008, Windows XP, Windows Server 2003

Mac OS X 10.4.0-10.8
Please refer to "Product Requirements" (P.46)

MB441 MB451 MB451w

Document
size

ADF A6 , B5 , A5 , A4 , letter , legal 13/13.5/14, executive 

Document 
glass

A6 , B5 , A5 , A4 , letter , executive 

First copy 
Time

Mono 10 seconds or less (ADF, 
High Speed)

10 seconds or less (ADF, 
High Speed)

10 seconds or less (ADF, 
High Speed)

Copies Up to 99

MB441 MB451 MB451w

Compatibility - ITU-T G3/Super G3

Compression method - MH, MR, MMR, JBIG

Modem speed - Up to 33.6 Kbps

Lines - PSTN, PBX Line

Line interface - RJ11 x 2 (Line/TEL)

Document 
size

ADF - A4, letter, legal 13/13.5/14

Document 
glass

- A4, letter

Transmission speed - Approx. 3 seconds/page (ITU-T, MMR, Normal)

Stored document 
memory size

- 4 MB

Storage document 
capacity

- Up to 200 pages (ITU-T no.1, MMR, Normal)

MB441 MB451 MB451w
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PC Fax Specifications

 Internet Fax Specifications

Scanner Specifications

Scan To E-mail Specifications

Resolution - Normal
8 dots x 3.85 line/mm
 Fine
8 dots x 7.7 line/mm
 Photo
8 dots x 7.7 line/mm
 Extra-Fine
8 dots x 15.4 line/mm

MB441 MB451 MB451w

Interface - USB 2.0 (Hi-Speed), Ether-
net 10BASE-T/100BASE-TX

USB 2.0 (Hi-Speed), Ethernet 
10BASE-T/100BASE-TX, 
IEEE802.11 b/g/n Wireless LAN

Supported OS - Windows 8, Windows Server 2012, Windows 7, Windows 
Vista, Windows Server 2008 R2, Windows Server 2008, 
Windows XP, Windows Server 2003

MB441 MB451 MB451w

Communication 
protocol

- SMTP, POP3, MIME

File format TIFF - TIFF

MB441 MB451 MB451w

Scanner type Document Glass with ADF function

Image sensor Color CIS

Light source LED

Document 
thickness

ADF 60 to 105 g/m2 (16 to 28 lb)

Document 
glass

20 mm

ADF document 
capacity

50 sheets (80 g/m2)

Scanning 
area

ADF 105 x 148 - 215.9 x 355.6 mm (4.13 x 5.8 - 8.5 x 14 inches)

Document 
glass

105 x 148 - 215.9 x 296.9 mm (4.13 x 5.8 - 8.5 x 11.69 inches)

Scanning 
speed

Color Approx. 6 seconds/page (A4, 300 x 300 dpi, ADF simplex)

Mono Approx. 2 seconds/page (A4, 300 x 300 dpi, ADF simplex)

MB441 MB451 MB451w

Communication 
protocol

SMTP, POP3, MIME

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG (JFIF) (color/
grayscale only), XPS

Mail server 
authentication

SMTP-AUTH, POP3

MB441 MB451 MB451w
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Scan To Network PC Specifications

Scan To USB Memory Specifications

Scan To Local PC Specifications

Printing Specifications

Supported mail 
server application

Lotus Domino Mail Server 5.0, Microsoft Exchange 2000 Server, Microsoft Exchange 2003 
Server, Microsoft Exchange 2007 Server, Red Hat 7.0 Sendmail

Supported LDAP 
server

Windows Server 2008 Active Directory, Windows Server 2003 ActiveDirectory, Windows 
2000 Server Active Directory, Lotus Notes/Domino 7.0

Supported mail 
application

Microsoft Office Outlook 2000, Microsoft Outlook Express 5.0/6.0, Windows Mail 
(Windows Vista), Windows Live Mail, Mail (MAC built-in application), Lotus Notes/Domino 
R5

MB441 MB451 MB451w

Communication 
protocol

FTP, HTTP, CIFS

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG (JFIF) (color/
grayscale only), XPS

MB441 MB451 MB451w

Connectivity interface USB2.0 Host IF

Storage device USB memory (Up to 32 GB)
Not all USB memory products are guaranteed to work.

Supported file system FAT12, FAT (FAT16), FAT32

File format PDF (supported Encryption), M-TIFF (RAW/G3/G4 compressed), JPEG (JFIF) (color/
grayscale only), XPS

MB441 MB451 MB451w

Communication 
protocol

Windows TWAIN, WIA

Mac OS X TWAIN, ICA

File format PDF, TIFF, JPEG, BMP, PCX, GIF, TGA, PNG, WMF, EMF

MB441 MB451 MB451w

Printing method Dry electrophotographic recording method with LED (Light-emitting diode)

Emulation T PCL6 (PCLXL), PCL5e PCL6 (PCLXL), PCL5e, PostScript 3

Resident fonts PCL: 91 European fonts PCL: 91 European fonts
PS: 136 European fonts

Resolution 600 x 600 dpi, 
600 x 1200 dpi, 
600 x 2400dpi 

600 x 600 dpi

Color black

Print speed (A4)  600 x 600 dpi
Simplex: Approx.29 ppm
Duplex: Approx.17 ppm

 600 x 600 dpi
Simplex: Approx.29 ppm
Duplex: Approx.17 ppm

First print 
out time

Standby 5 seconds or less

Power 
save

30 seconds or less

MB441 MB451 MB451w
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Paper size Tray1 Legal 13/13.5/14, letter, executive, Statement, A4, A5, B5, A6, 16K (197 x 273 mm, 
195 x 270 mm, 184 x 260 mm), custom size

MP Tray - Legal 13/13.5/14, letter, executive, Statement, A4, A5, 
B5, A6, C5, C6, DL, Com-9, Com-10, Monarch,  16K (197 x 
273 mm, 
195 x 270mm, 184 x 260 mm), custom size

Manual 
Feeder

Legal 13/13.5/14, letter, 
executive, Statement, A4, 
A5, B5, A6, C5, C6, DL, 
Com-9, Com-10, Monarch, 
16K 
(197 x 273 mm, 195 x 
270mm, 184 x 260 mm), 
custom size

-

Duplex 
Printing

Legal 13/13.5/14, letter, executive, A4, B5, 16 K (197 x 273 mm, 195 x 270 mm, 
184 x 260 mm)

Custom 
size

 Tray 1
100 x 148-216 x 355.6 mm 
(3.94 x 5.83-8.5 x 14 inches)
Manual Feeder
86 x 140-216 x 1320.8 mm 
(3.4 x 5.5-8.5 x 52 inches)

 Tray 1
100 x 148-216 x 355.6 mm (3.94 x 5.83-8.5 x 14 inches)
MP tray
86 x 140-216 x 1320.8 mm (3.4 x 5.5-8.5 x 52 inches)

Media type Standard paper (60 g/m2 - 163 g/m2), envelopes, label.

Feeding method Automatic feeding from the 
tray 1, Manual feeding from 
Manual Feeder

Automatic feeding from the tray 1, MP tray

Paper loading 
capacity

 Tray 1
250 sheets of Standard 
paper /80 g/m2, total 
thickness 25mm or lower.
Manual Feeder
1 sheet.

 Tray 1
250 sheets of Standard paper /80 g/m2, total thickness 
25mm or lower.
MP tray
100 sheets of Standard paper /80 g/m2 and total thickness 
10mm or lower, 10 envelopes/ weight of 85 g/m2.

Output method Face down

Paper output capacity  Face down
150 sheets (less than 80 g/m2)

Print guaranteed area 6.35 mm or more from the paper edge (not applicable to special media such as 
envelopes)

Print precision Print beginning:± 2 mm, paper skew: ± 1 mm/100 mm, image expansion: ± 1 mm/100 
mm (80 g/m2)

Warm-up time  From power on
Less than 60 seconds
 From power save mode
Less than 25 seconds

Usage Environment 
Conditions

When in operation
10~32°C / Relative Humidity of 20~80% (maximum wet bulb temperature of 25°C, 
maximum dry bulb temperature of 2°C)
When not in operation
0~43°C / Relative Humidity of 10~90% (maximum wet bulb temperature of 26.8°C, 
maximum dry bulb temperature of 2°C)

Conditions for the 
guarantee of print 
quality

Temperature 10°C, humidity 30 to 78% RH/ temperature 32°C, humidity 30 to 54% RH/ 
humidity 30% RH, temperature 10 to 32°C/ humidity 80% RH, temperature 18 to 27°C

Consumables, 
Maintenance Unit

Toner cartridges, image drum

MB441 MB451 MB451w
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Print From USB Memory Specifications

Network Specifications

Wireless LAN Specifications

MB441 MB451 MB451w

Interface USB 2.0 (High Speed) Host IF

Storage device USB memory (Up to 32 GB)
Not all USB memory products are guaranteed to work.

Supported file system FAT12, FAT (FAT16), FAT32

File format TIFF (TIFF 6.0 Baseline), 
PRN (PCL)

PDF (v1.7, Does not support encrypted PDF), JPEG, TIFF 
(TIFF 6.0 Baseline), PRN (PS/PCL)

MB441 MB451 MB451w

Interface Ethernet 10BASE-T/100BASE-TX Ethernet 10BASE-T/
100BASE-TX, IEEE802.11 b/
g/n Wireless LAN

Protocol TCP/IPv4, TCP/IPv6, NetBEUI, NetBIOS over TCP, 
EtherTalk, NetWare, LPR, Port9100, IPP, FTP, HTTP, 
TELNET, SMTP, POP3, SNMPv1/v3, DHCP, BOOTP, DNS, 
DDNS, UPnP, WINS, SLP, Bonjour (Rendezvous), SNTP, 
LLTD, Web Services Discovery (WSD), SSL/TLS, IPSec, 
CIFS, SMB (Version 1.0), LDAPv3, Kerberos

TCP/IPv4, TCP/IPv6, NetBEUI, 
NetBIOS over TCP, EtherTalk, 
NetWare, LPR, Port9100, IPP, 
FTP, HTTP, TELNET, SMTP, 
POP3, SNMPv1/v3, DHCP, 
BOOTP, DNS, DDNS, UPnP, 
WINS, SLP, Bonjour 
(Rendezvous), SNTP, LLTD, 
Web Services Discovery 
(WSD), SSL/TLS, IPSec, CIFS, 
SMB (Version 1.0), LDAPv3, 
Kerberos, IEEE802.11 b/g/n, 
Infrastructure Mode, WEP, 
WPA(TKIP/AES), WPS-PCB/
WPS-PIN, Open system 
authentication, IEEE802.1x 
authentication

Supported browsers Microsoft IE 6.0 or later, Safari 2.0 or later, Firefox 3.0 or later

MB441 MB451 MB451w

Wireless LAN adapter - OkiLAN520w

Wireless LAN 
standard

- IEEE802.11b/g/n conformity 
(2.4GHz)

Transfer rate - 11n technology: 
Max150Mbps
IEEE802.11g: Max54Mbps
IEEE802.11b: Max11Mbps

Antenna system - Built-in Antenna 1T1R

LAN protocol - TCP/IP (IPv6/IPv4)

Security - WEP(128/
64bit),WPA,WPA2,IEEE802.
1x wireless securities.
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Regulatory wireless LAN statements

-FCC Statement

-Notice to users in Canada

-Europe-CE Declaration of conformity.

FCC statement

Notice to users in Canada

FCC WARNING
Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 
authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does 
cause hamful interference to radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or more of the following measures:
-Reorient or relocate the receiving antenna.
-Increase the separation between the equipment and receiver.
-Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
-Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS standard(s). Operation 
is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must 
accept any interference, including ingerference that may cause undesired operation of this device.

Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d’Ubdustrie Canada applicables aux 
appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions suivantes : (1) I’appareil ne 
doit pas produire de brouillage, et (2) I’utilisateur de I’appareil doit accepter tout brouillage radioélectrique subi, 
même si le brouillage est susceptible d’en compromettre le fonctionnement.

This Class [B] digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada.
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Europe - CE Declaration of Conformity

This equipment complies with the essential requirements of the European Union directive 1999/5/EC.

Wireless Operation Channel for Different Domains
N.America 2.412-2.462 GHz Ch01-CH11
Europe ETSI 2.412-2.472 GHz Ch01 - Ch13

France
Some areas of France have a restricted frequency band. The worst case maximum authorized power indoors is:
•10 mW for the entire 2.4 GHz band (2400 MHz-2483.5 MHz).
•100 mW for frequencies between 2446.5 MHz and 2483.5 MHz (NOTE—Channels 10 through 13 inclusive operate in the band 
2446.6 MHz to 2483.5 MHz).

There are few possibilities for outdoor use: On private property or on the private property of public persons, use is subject to a 
preliminary authorization procedure by the Ministry of Defence, with maximum authorized power of 100 mW in the 2446.5-2483.5 
MHz band. Use outdoors on public property is not permitted.

In the departments listed below, for the entire 2.4 GHz and: 
Maximum authorized power indoors is 100 mW.
Maximum authorized power outdoors is 10 mW.

Departments in which the use of the 2400-2483.5 MHz band is permitted with an EIRP of less than lOOmW indoors and less than 
10mW outdoors:
01 Ain 02 Aisne 03 Allier 05 Hautes Alpes 08 Ardennes 09 Ariège
11 Aude 12 Aveyron 16 Charente 24 Dordogne 25 Doubs 26 Drôme
32 Gers 36 Indre 37 Indre et Loire 41 Loir et Cher 42 Loire 45 Loiret
50 Manche 55 Meuse 58 Nièvre 59 Nord 60 Oise 61 Orne
63 Puy de Dôme 64 Pyrénées Atlantique 66 Pyrénées Orientales 67 Bas Rhin 68 Haut Rhin 70 Haute Saône
71 Saône et Loire 75 Paris 82 Tarn et Garonne 84 Vaucluse 88 Vosges 89 Yonne
90 Territoire de Belfort 94 Val de Marne

This requirement is likely to change over time, allowing you to use your wireless LAN card in more areas within France. Please 
check with ART for the latest Information (www.art-telecom.fr)

Italia
Approved for indoor use only. The outdoor use is subject to an official permission.

The telecommunications functionality of this product may be used in the following EU and EFTA countries: 
Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, 
Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, 
Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, Turkey and United Kingdom.
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Use Wireless Communications

This page explains the radio wave used by OkiLAN520w.
OkiLAN520w operates at 2.4GHz.
No radio license is required to use OkiLAN520w. Take note of the following points.

Do not use OkiLAN520w near the following equipments or places.
The following equipment may use the same band. If you use OkiLAN520w near this equipment, the radio waves from OkiLAN520w 
and the following devices may interfere with each other.
•Microwave, scientific instruments, pacemaker or other medical equipment.
•Licensed radio station in a factory.
•Small power radio station (a non-licensed radio station).

Do not use OkiLAN520w near a cellular phone, TV or Radio.
A cellular phone, TV, and radio use a different radio band than our product. Generally if they are used near OkiLAN520w, it will not 
cause a problem. However, when they approximate OkiLAN520w, sound or image noise can happen.

If there is reinforced concrete/metal between wireless devices, they may not connect.
OkiLAN520w can connect through wood or glass, but can have trouble communicating through reinforced concrete/metal.

Wireless Equipment for 2.4GHz band
This band of equipment is used by a microwave, industry, science, medical equipment and licensed in room or low power (non 
licensed) radio stations.
•Before you use this equipment, verify that it will not interfere with other broadcasting.
•If interference happens, stop using the equipment or change the band.
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Basic steps in Windows
These are the steps for displaying the driver setting window from [Printer] / [Printer and FAX] folder 
for Windows OS used for examples in this manual other than Windows 7.

Memo

 The steps for Windows Server 2008 R2 are the same as Windows 7.

 For Windows 8 and Windows Server 2012, follow the procedures below to display the device and printer. Select [Desktop], 
[Charm bar](displayed by moving the mouse cursor to the top-right corner of the screen or by clicking the right of the screen), 
[Setup], [Control Panel], and [Displaying Devices and Printers]. The steps from the device and printer are the same as 
Windows 7.

 If you have multiple drivers installed, the icons for each driver are displayed in the [Printer] / [Printer and FAX] folder. Please 
follow the below steps using the drivers you want to set/check. Please follow the below steps using the drivers you want to set/
check.

Displays the Property screen

 For Windows Vista/Windows Server 2008

1 Click [Start], and select [Control Panel] > [Printer].

2 Right-click on the OKI MB491 icon, and select [Properties].

 For Windows XP/Windows Server 2003

1 Click [Start], and select [Printers and Faxes] .

2 Right-click on the OKI MB491 icon, and select [Properties].

Displays the printer setting screen

 For Windows Vista/Windows Server 2008

1 Click [Start], and select [Control Panel] > [Printer].

2 Right-click on the OKI MB491 icon, and select [Printing Preferences].

 For Windows XP/Windows Server 2003

1 Click [Start], and select [Printers and Faxes].

2 Right-click on the OKI MB491 icon, and select [Printing Preferences].
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Symbols

-(Hyphen) ..................... 87

*(Asterisk) .................... 88

#(Hash Symbol) ............ 88

A

Access Control ............. 128

ActKey .........107, 112, 113

Address Book
 ............101, 109, 119

ADF ............................. 38

Administrator Password
 ............................ 66

ADSL ............................ 42

Advanced Search
 ................... 102, 110

AES .............................. 51

Ans/Fax Ready Mode ...... 92

Attached File Of An E-mail
 ............................ 66

Auto Reset .................... 85

B

BACK Key ..................... 26

Background Removal ...... 84

Binding ....................... 126

C

Cleaning Document Feeding 
Rollers in the ADF
 .......................... 176

Cleaning LED Head ....... 178

Cleaning Paper Feed Rollers
 .......................... 177

Cleaning the Document Glass
 .......................... 176

CLEAR Key ....26, 28, 79, 82

Color Paper ................... 30

Configuration Report ...... 78

Continuous Scan
 ...82, 86, 98, 100, 109

COPY Key ................25, 79

Copy Settings ................80

Copying ........................79

Country Code .................40

CS Tuner .......................42

Custom Size ..................36

D

DATA IN MEMORY Indicator
 ...................... 26, 92

Default Screen ...............26

Density ................... 83, 90

Dial Functions ................87

Dial Type ......................43

Digital Television ............42

Direction .......................81

Document Glass .............38

Document Jam ............. 140

Document Type ..............83

DRD ....................... 45, 93

Duplex Copies ................83

Duplex Printing
 ............... 32, 36, 126

Duplex Scanning ............38

E

E-mail History .............. 109

Entering Text .................27

Envelope .......................30

Error Code ............135, 141

Error Messages ............ 141

F

Face Down Skater ..........37

Face Up Skater ..............37

Fax Ready Mode .............45

FAX/HOOK Key
 ............... 25, 86, 100

Fit .............................. 126

Flash ............................87

Function Keys ................26

G

Group Dial .................... 96

Group List
 .......88, 101, 109, 120

H

HELP Key (for MB441/MB461/
MB461+LP/ES4161 MFP)
 ..................... 25, 141

I

ICA .............................104

Image Capture .............112

Image Drum ........ 173, 174

Index Card ................... 30

Install
Fax Driver ................ 53
Printer Driver (Mac OS X)

 ...............55, 62
Printer Driver (Windows)

 ...............53, 61
Scanner Driver ........104

Installation Requirements
 ............................ 14

Internet Faxing ............100

IP Address .................... 53

IP Telephone ................. 42

J

JOB MACRO Key ............ 26

L

Label ........................... 30

LDAP ................... 102, 110

Loading Documents ....... 37

Logging Into the Machine
 ...........................129

Logging Out the Machine
 ...........................129

M

Mac OS X ..................... 46

Manual Feeder ..........33, 35
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MP Tray
 .... 33, 34, 80, 94, 126

N

Network Configuration
 .......................... 104

Network Scan Destinations
 .......................... 121

O

One-Touch Key
 .... 26, 88, 97, 99, 109

P

Paper Feed .............80, 126

Paper Jams ................. 135

Paper Size ...29, 32, 36, 122

Paper Tray ...............32, 36

Paper Weight (Document)
 ............................ 38

Paper Weight (Print Paper)
 .......................29, 32

PaperPort .................... 113

Party-Printing Paper ....... 30

Password .................... 132

Pause ........................... 88

PBX .............................. 43

PIN ............................ 129

PIN (Wirelss LAN) .......... 48

Power Goes Out ........... 170

POWER SAVE Key .....20, 26

Power Save Mode ........... 20

Power Supply Conditions
 ............................ 19

PreFix ........................... 87

PRINT Key ......25, 124, 125

Printer Driver .............. 122

Printing From USB Memory
 .......................... 125

Product Requirements .... 46

Profile .....................76, 77

Public Line .................... 41

Q

QWERTY Keyboard ... 26, 28

R

Receiving Calls ...............92

Receiving Faxs ...............92

Reception History ..... 91, 95

Reception Mode .............45

REDIAL/HELP Key (for MB451/
MB451w/MB471/
MB471w/MB491/
MB491+/MB491+LP/
ES4191 MFP/
MPS4200mb/
MPS4700mb)
 .................... 25, 141

Register all E-mail addresses.
 .......................... 120

RESET/LOGOUT Key
 ........25, 85, 129, 132

Resolution (Fax) .............90

S

SCAN Key ...... 25, 109, 111, 
112, 115, 116

Scan Resolution .............84

Scan Size ...........38, 80, 90

Scan to E-mail ............. 109

Scan to Fax Server .........98

Scan to Local PC .......... 112

Scan to Network PC ...... 111

Scan to Remote PC ....... 113

Scan to USB Memory .... 111

Scannable Size ..............38

Scanning ..................... 109

Second Tray Unit (Tray2)
 .................... 22, 179

Secure Scan Mode ........ 116

Sender Name ........... 44, 90

Server Set Up ................65

SETTING Key .................25

Setting Paper Size ..........36

Simple Scan Mode ........ 114

Simple Search ......102, 110

Sleep Mode ................... 21

Specifying a Destination
 .............. 87, 101, 109

Speed Dial ...............88, 95

SSID ............................ 50

Standard Paper ............. 29

START (COLOR) Key
 ......25, 109, 111, 112, 
113, 116, 118

START (MONO) Key ...... 25, 
79, 86, 109, 111, 112, 
113, 116, 118

STATUS Key ...25, 135, 141, 
152

STOP Key ......... 25, 79, 91, 
103, 118, 127

Symbols ....................... 27

T

Tel Ready Mode ............. 92

Tel/Fax Ready Mode ....... 92

Ten-Key ........... 27, 37, 79, 
81, 87, 129

TKIP ............................ 51

Tone ............................ 88

Toner Cartridge ............172

Transmission History
 ... 88, 95, 99, 101, 119

TWAIN ......... 104, 112, 113

U

USB Memory ................125

User Authentication .......128
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Oki Systems (UK) Ltd
Blays House
Wick Road
Egham
Surrey
TW20 0HJ

Tel:+44 (0) 1784 274300
Fax:+44 (0) 1784 274301
http://www.oki.co.uk

Oki Systems Ireland Limited
The Square Industrial Complex
Tallaght
Dublin 24

Tel:+353 (0) 1 4049590
Fax:+353 (0)1 4049591
http://www.oki.ie

Oki Systems Ireland Limited -
Northern Ireland
19 Ferndale Avenue
Glengormley
BT36 5AL
Northern Ireland

Tel:+44 (0) 7767 271447
Fax:+44 (0) 1 404 9520
http://www.oki.ie

Technical Support for all Ireland:
Tel:+353 1 4049570
Fax:+353 1 4049555
E-mail: tech.support@oki.ie

OKI Systems (Czech and Slovak),
s.r.o.
IBC – Pobřežní 3
186 00 Praha 8
Czech Republic

Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk

Oki Systems (Deutschland) GmbH
Hansaallee 187
40549 Düsseldorf

Tel: 01805/6544357**
01805/OKIHELP**

Fax: +49 (0) 211 59 33 45
Website:
www.okiprintingsolutions.de
info@oki.de

**0,14€/Minute aus dem dt. Festnetz
der T-Com (Stand 11.2008)

CPI S.A1 Rafailidou str.
177 78 Tavros
Athens
Greece

Tel: +30 210 48 05 800
Fax:+30 210 48 05 801
EMail:sales@cpi.gr

Oki Systems (Iberica), S.A.U
C/Teide, 3
San Sebastian de los Reyes
28703, Madrid

Tel:+34 91 3431620
Fax: +34 91-3431624
Atención al cliente: 902 36 00 36
Website: www.oki.es

Oki Systèmes (France) S.A.
44-50 Av. du Général de Gaulle
94246 L'Hay les Roses
Paris

Tel:+33 01 46 15 80 00
Télécopie:+33 01 46 15 80 60
Website: www.oki.fr

OKI Systems (Magyarország) Kft.
Capital Square
Tower 2
7th Floor
H-1133 Budapest,
Váci út 76
Hungary

Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu

OKI Systems (Italia) S.p.A.
via Milano, 11,
20084 Lacchiarella (MI)

Tel:+39 (0) 2 900261
Fax:+39 (0) 2 90026344
Website: www.oki.it

OKI Printing Solutions
Platinium Business Park II, 3rd Floor
ul. Domaniewska 42
02-672 Warsaw
Poland

Tel:+48 22 448 65 00
Fax:+48 22 448 65 01
Website: www.oki.com.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl

Oki Systems (Ibérica) S.A.
Sucursal Portugal
Edifício Prime -
Av. Quinta Grande 53
7º C Alfragide
2614-521 Amadora
Portugal

Tel:+351 21 470 4200
Fax:+351 21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt

Oki Service
Serviço de apoio técnico ao
Cliente
Tel: 808 200 197
E-mail : okiserv@oki.pt

OKI Europe Ltd. (Russia)
Office 702, Bldg 1
Zagorodnoye shosse
117152, Moscow

Tel: +74 095 258 6065
Fax: +74 095 258 6070
e-mail: info@oki.ru
Website: www.oki.ru

Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru

Oki Systems (Österreich)
Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge

Tel: +43 223 6677 110
Drucker Support:
+43 (0) 2236 677110-501
Fax Support:
+43 (0) 2236 677110-502
Website: www.oki.at

OKI Europe Ltd. (Ukraine)
Raisy Opkinoy Street,8
Building B, 2nd Floor,
Kiev 02002
Ukraine

Tel: +380 44 537 5288
e-mail: info@oki.ua
Website: www.oki.ua

Harman sok Duran Is Merkezi,
No:4, Kat:6,
34394, Levent
İstanbul

Tel: +90 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr
www.okiprintingsolutions.com.tr

Oki Systems (Belgium)
Medialaan 24
1800 Vilvoorde

Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be

AlphaLink Bulgaria Ltd.
2 Kukush Str.
Building "Antim Tower", fl. 6
1463 Sofia, Bulgaria

tel: +359 2 821 1160
fax: +359 2 821 1193
Website: http://bulgaria.oki.com

Διανομέας των συστημάτων OKI

OKI Sistem ve Yazıcı Çözümleri
Tic. Ltd. Şti.

Oki contact details



OKI Printing Solutions
Herstedøstervej 27
2620 Albertslund
Danmark

Adm.: +45 43 66 65 00
Hotline: +45 43 66 65 40
Salg: +45 43 66 65 30
Fax: +45 43 66 65 90
Website: www.oki.dk

Oki Systems (Finland) Oy
Polaris Capella
Vänrikinkuja 3
02600 Espoo

Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809
Website: www.oki.fi

Oki Systems (Holland) b.v.
Neptunustraat 27-29
2132 JA Hoofddorp

Helpdesk: 0800 5667654
Tel:+31 (0) 23 55 63 740
Fax:+31 (0) 23 55 63 750
Website: www.oki.nl

Oki Systems (Norway) AS
Tevlingveien 23
N-1081 Oslo

Tel:+47 (0) 63 89 36 00
Telefax:+47 (0) 63 89 36 01
Ordrefax:+47 (0) 63 89 36 02
Website: www.oki.no

General Systems S.R.L. 
(Romania)
Sos. Bucuresti-Ploiesti Nr. 135.
Bucharest 1
Romania

Tel: +40 21 303 3138
Fax: +40 21303 3150
Website: http://romania.oki.com

Var vänlig kontakta din Återförsäljare
i första hand, för konsultation. I 
andra hand kontakta

Oki Systems (Sweden) AB
Borgafjordsgatan 7
Box 1191
164 26 Kista

Tel. +46 (0) 8 634 37 00
e-mail:
info@oki.se för allmänna frågor om 
Oki produkter

support@oki.se för teknisk support 
gällandes Oki produkter

Vardagar: 08.30 - 12.00,
13.00 - 16.00
Website: www.oki.se

Oki Systems (Schweiz)
Baslerstrasse 15
CH-4310 Rheinfelden

Support deutsch +41 61 827 94 81
Support français +41 61 827 94 82
Support italiano +41 061 827 9473
Tel: +41 61 827 9494
Website: www.oki.ch

Oki Data Americas Inc.(United 
States • États-Unis)
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel: 1-800-654-3282
Fax: 1-856-222-5247
http://WWW.OKIPRINTINGSOLUTIONS.COM
http://my.okidata.com

WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data Americas Inc.(América 
Latina (OTRO))
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel (Español): 1-856-222-7496
1-856-222-5276

Fax: 1-856-222-5260
Email: LASatisfaction@okidata.com

Oki Data Americas Inc.(Canada •  
Canadá)
4140B Sladeview Crescent Unit 7 & 8
Mississauga, Ontario
Canada L5L 6A1

Tél: 1-905-608-5000
Téléc: 1-905-608-5040 
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data de Mexico, S.A. de C.V.
Mariano Escobedo #748, Piso 8
Col. Nueva Anzures
C.P. 11590, México, D.F.

Tel: 52-555-263-8780
Fax: 52-555-250-3501
http://

Oki Data do Brasil, Ltda.
Rua Alexandre Dumas, 2220-80 
andar Chácara Santo Antonio
04717-004, São Paulo, SP Brasil

Tel: 55-11-3444-6747 (Grande São 
Paulo) 
0800-11-5577 (Demais 
localidades)

Fax: 5511-3444-3501
e-mail: okidata@okidata.com.br
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Systems (Thailand) Ltd.
1168/81-82 Lumpini Tower,
27th Floor Rama IV Road
Tungmahamek, Sathorn
Bangkok 10120

Tel:(662) 679 9235
Fax:(662) 679 9243/245
http://www.okisysthai.com

Oki Systems (Hong Kong) Ltd.
Suite 1908, 19/F, Tower 3,
China Hong Kong City
33 Canton Road, TsimShaTsui,
Kowloon, Hong Kong

Tel: (852) 3543 9288
Fax: (852) 3549 6040
http://

Comworth Systems Ltd.
8 Antares Place Mairangi Bay,
Auckland, New Zealand

Tel:(64) 9 477 0500
Fax:(64) 9 477 0549
http://www.comworth.co.nz

Oki Data(S) P Ltd. Malaysia Rep 
Office
Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia

Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166

www.okiprintingsolutions.com.hk

Oki Data(Australia) Pty Ltd.
Levwl1 67 Epping Road, Macquarie Park
NSW 2113, Australia

Tel: +61 2 8071 0000
(Support Tel: 1800 807 472)
Fax: +61 2 8071 0010
http://www.oki.com.au

Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)

Tel:(65) 6221 3722
Fax:(65) 6594 0609
http://www.okidata.com.sg
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Oki Data Corporation
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108-8551, Japan 
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